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1. PROGRAM DESCRIPTION 

1.1. General description of the program 
AutoCAD® Structural Detailing is used to prepare detailed drawings of  designed steel 
structures. After completing the stage of architectonic structure design and generating a 
structure calculation model (this stage comprises calculations and verification of structure 
elements), the stage of preparing project technical documentation with required final drawings 
takes place.  
AutoCAD® Structural Detailing - Steel is a program which allows generation of complete 
detailing documentation of steel structures (drawings + tables of materials). The process of 
creating drawings in AutoCAD® Structural Detailing - Steel is automatic. Drawings are 
generated based on a 3D structure model using the options available in AutoCAD® 
Structural Detailing - Steel with the possibility to apply options available in the AutoCAD® 
program. In case a structure model is modified, it is possible to update automatically the 
created documentation.   
AutoCAD® Structural Detailing - Steel is a program enabling generation of detailing 
drawings; it is divided into a few parts which are responsible for:  

1. link with the calculation program (Autodesk Robot Structural Analysis): data 
exchange, structure recalculation, if needed  

2. edition of a drawing or part of a drawing (projections, cuts, etc.) - including additional 
drawing elements, correction of existing structure elements, adding structure element 
dimensions  

3. generation of final drawings  
4. printout management.  

 
AutoCAD® Structural Detailing combined with Autodesk Robot Structural Analysis allows 
the user to make a complete structure project: 
• generation of a structure model and structure calculations   
• structure design   
• generation of final drawings allowing edition of prepared drawings.  

 
Basic tasks that are performed in AutoCAD® Structural Detailing - Steel after reading in a 
structure model from the calculation program, include:    
• possibility to define connections of structure elements 
• posibility of elements’ machining (fitting to a line or object, chamfering) 
• possibility to single out assemblies and groups in a structure model – according to the 

actual procedure of structure assembly    
• possibility to define user descriptions of parts  
• possibility to obtain a drawing of a whole structure as well as to prepare the overall bill of 

materials  
• generation of detailed drawings.  

 
The following objects have been distinguished in the program:  
• Structure model, structure model elements - real (3D) structure elements; for them final 

drawings are created  
• Position - an object concerned with organization of structure model elements; a (letter – 

digit) designation of identical parts or assemblies in a structure  
• Document - a set of views of a position in determined projections and views (any number 

of documents may be generated for each position); a document consists of views. NOTE: 
A document may be edited only in the edition layout; a document may be printed only 
after it is inserted to the printout layout  

• (Document) template - a predefined set of views composing a logical whole (e.g. 3 
projections of a given object); each document is created based on a template 
determining which drawings (projections, sections) should be included in the document  

 © 2010 Autodesk, Inc. All rights reserved          
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• View - a single drawing; it is always a document component - if it has been added to a 
printout, it is simultaneously a printout element. NOTE: only a view (drawing) contained 
in a printout may be printed  

• Printout - ready-to-use printout composed of views; its equivalent in the AutoCAD® 
program is a layout together with AutoCAD views provided on it; for each printout there is 
exactly one layout corresponding to it. 

The elements listed concern the stages of work on a project.  
 

1.2. Stages of work on structure project drawings 
Creating documentation of a designed structure (drawings) may be divided into the following 
stages: 
 
1. Defining or loading a structure model  
A structure model may be defined in AutoCAD® Structural Detailing – Steel. It is also possible 
to prepare it in another program and open in AutoCAD® Structural Detailing - Steel (see: 
AutoCAD Structural Detailing - Robot link). 
Drawings will be prepared for 3D elements of a real 3D structure. 
 

 
 
All operations are performed in the model layout, which is an AutoCAD® object used when 
working with a structure model. 
 
2. Assigning positions to structure elements 
A position is an object concerned with organization of structure model elements. A position is 
assigned to one or several structure elements, for which a common set of drawings may be 
generated.  
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Assigning positions is available on the Model and Parts Edition tabs of the Object inspector 
dialog. Positions defined are displayed on the Positions tab.  
 
3. Defining documents 
A document  is a set of drawings for a position (for each position, any number of documents 
may be generated). A document consists of views, but cannot be printed.  
Documents are generated based on templates, which are predefined sets of views composing 
a logical whole (for example, 3 projections of a given object). A template determines which 
drawings (projections or sections) should be included in a document. 
 

 
 
All operations are performed in edition layouts.   
The edition layout is an AutoCAD® object. Only one document may be active at a time and 
only this document may be edited in the edition layout. You should not print the contents of the 
edition layout.  
 
4. Defining (editing) views/projections 
A view is a single drawing that always constitutes a document component; if it has been added 
to a printout, it is simultaneously a printout element . Only a view (drawing) contained in a 
printout may be printed. 
 

 
 

 © 2010 Autodesk, Inc. All rights reserved          



page: 4 AutoCAD Structural Detailing - Steel - User Guide 

Projections of assemblies are prepared based on the coordinate system of the main part (by 
default  it is the longest part of an assembly). To modify projections, you can either rotate the 
view or, before drawings are generated, change the main part of the assembly (using the 
Change main part of group command on the Model tab of the Object Inspector).    
Edition is performed in the edition layout.  
 
5. Generating a printout  
A printout consists of views (for each Printout there is exactly one layout corresponding to it).   
 

 
 
All operations are performed in printout layouts.  
The printout layout is an AutoCAD® object. It is used for composition of a final printout. For 
each printout layout, there is one printout.  
 
See also: 
Example of creating documents and insertion of documents in a drawing  
 

1.3. Options available in the menu 
All menu options available in AutoCAD® Structural Detailing - Steel are displayed below. The 
list includes the menu path and the ribbon, toolbar icon, and command to activate each option, 
as well as a short description of the option. 
See also: Ribbon  
 
Workframes 
Create workframe   

 

Opens the Workframe dialog, where you can apply a workframe to simplify 
the definition of a structure model in 3D space.  
Menu: Steel > Workframes > Create workframe  
Ribbon:  ASD - Model > Elements > Workframes  
Toolbar: General > Workframes 
Command line: RBCS_WF 
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Add node  

 
 

Lets you create an additional node in the existing workframe.  
Menu: Steel > Workframes > Add node  
Ribbon:  ASD - Model > Elements > Add node 
Toolbar: General > Add node 
Command line: RBCS_ADDNODE 
 

Delete node 

 
 

Lets you delete a node in the existing workframe.  
Menu: Steel > Workframes > Delete node  
Ribbon:  ASD - Model > Elements > Delete node 
Toolbar: General > Delete node 
Command line: RBCS_WF_DELNODE 
 

Add line  

 
 

Lets you create an additional line in the existing workframe.  
Menu: Steel > Workframes > Add line  
Ribbon:  ASD - Model > Elements > Add line  
Toolbar: General > Add line 
Command line: RBCS_WF_ADDLINE 
 

Delete line 

 
 

Lets you delete a line in the existing workframe.  
Menu: Steel > Workframes > Delete line  
Ribbon:  ASD - Model > Elements > Delete line  
Toolbar: General > Delete line 
Command line: RBCS_WF_DELLINE 
 

Profiles  

 
 

Opens the Profile dialog, where you can define a bar of a selected section. 
Menu: Steel > Profile  
Ribbon:  ASD - Model > Elements > Profile  
Toolbar: General > Profile 
Command line: RBCS_PROFILE 
 

Plates   

 
 

Opens the Plate dialog, where you can define a plate.   
Menu: Steel > Plates  
Ribbon:  ASD - Model > Elements > Plates 
Toolbar: General > Plates  
Command line: RBCS_PLATE 
 

Bent profiles  

 

Opens the Bent profile dialog, where you can define a curvilinear bar of 
selected profile.  
Menu: Steel > Bent profiles  
Ribbon:  ASD - Model > Elements > Bent profiles  
Toolbar: General > Bent profiles 
Command line: RBCS_BENT 
 

User parts 

 

Opens the User parts dialog, where you can define (select) user objects.  
Menu: Steel > User parts  
Ribbon:  ASD - Model > Elements > User parts  
Toolbar: General > User parts 
Command line: RBCS_USERPART 
 

Grates 

 

Opens the Grates dialog, where you can define a grate of specified 
dimensions and weight. 
Menu: Steel > Grates  
Ribbon:  ASD - Model > Elements > Grates 
Toolbar: General > Grates 
Command line: RBCS_GRATE 
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Compound 
profiles 

 

Opens the Compound profiles dialog, where you can define a compound 
section bar.  
Menu: Steel > Compound profiles  
Ribbon:  ASD - Model > Elements > Compound profiles  
Toolbar: General > Compound files 
Command line: RBCT_MMACRO 
 

Castellated beam 

 

Opens the Special profiles - castellated beam dialog, where you can 
define a castellated beam.  
Menu: Steel > Castellated beam  
Ribbon:  ASD - Model > Elements > Castellated beam  
Toolbar: General > Castellated beam 
Command line: RBCT_MMACRO 
 

Connections The submenu, the panel and toolbar to automatically create different types 
of connections between selected elements of steel structures.   
Menu: Steel > Connections 
Ribbon:  ASD - Model > Connections 
Toolbar: All connections; Automatic connections I; Automatic connections 
II; Automatic connections III; Automatic connections IV 
 

Plate girders The submenu, the panel and toolbar to automatically create plate girders; 
using this software version you can define a column, beam and 
multisegment beam. 
Menu: Steel > Plate girders  
Ribbon:  ASD - Model > Elements 
Toolbar: General > Plate girders 
 

Machining  
Cut by line 

 
 

Lets you cut a part (profile or plate) so that it fits the plane determined by a 
line.  
Menu: Steel > Machining > Cut by line  
Ribbon:  ASD - Model > Machining > Cut by line 
Toolbar: Machining > Cut by line 
Command line: RBCS_CUTBYLINE 
 

Fit to line 

 

Lets you trim a given profile so that it fits the plane determined by a line, 
perpendicular to UCS.  
Menu: Steel > Machining > Fit to line  
Ribbon:  ASD - Model > Machining > Fit to line 
Toolbar: Machining > Fit to line  
Command line: RBCS_FITTOLINE 
 

Fit to polyline 

 
 

Lets you trim a given part so that it fits the broken plane determined by a 
polyline, perpendicular to UCS. 
Menu: Steel > Machining > Fit to polyline  
Ribbon:  ASD - Model > Machining > Fit to polyline 
Toolbar: Machining > Fit to polyline  
Command line: RBCS_FITTOPOLY 
 

Fit to object  

 

Opens the Fit to object dialog, where you can trim a given part so that it 
fits another steel part.   
Menu: Steel > Machining > Fit to object  
Ribbon:  ASD - Model > Machining > Fit to object  
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Toolbar: Machining Fit to object 
Command line: RBCS_FITOBJ 
 

Cut by bisector  

 

Opens the Cut by bisector dialog, where you can trim 2 intersecting 
profiles using a bisector of the angle between their axes so that they fit 
each other.  
Menu: Steel > Machining > Cut by bisector  
Ribbon:  ASD – Model / Machining / Cut by bisector 
Toolbar: Machining > Cut by bisector 
Command line: RBCS_CUTBISEC 
 

Lengthen  

 

Lets you lengthen an existing profile along its axis.  
Menu: Steel > Machining > Lengthen  
Ribbon:  ASD - Model > Machining > Lengthen  
Toolbar: Machining > Lengthen  
Command line: RBCS_LENGTHEN 
 

Shorten  

 
 

Lets you shorten an existing profile along its axis.   
Menu: Steel > Machining > Shorten  
Ribbon:  ASD - Model > Machining > Shorten  
Toolbar: Machining I > Shorten 
Command line: RBCS_SHORTEN 
 

Bent plate 

 

Lets you bend an indicated plate.  
Menu: Steel > Machining > Bent plate  
Ribbon:  ASD - Model > Machining > Bent plate  
Toolbar: Machining II > Bent plate 
Command line: RBCS_BENTPLATE 
See also: Bending of plates  
 

Remove bending 
from plate  

 

Lets you remove an existing bend from the indicated plate.  
Menu: Steel > Machining > Remove bending from plate  
Ribbon:  ASD - Model > Machining > Remove bending from plate 
Toolbar: Machining II > Remove bending from plate 
Command line: RBCS_UNBENTPLATE 
 

Split profile 

 
 

Lets you divide an existing profile into several independent parts.   
Menu: Steel > Machining > Split profile  
Ribbon:  ASD - Model > Machining > Split profile  
Toolbar: Machining > Split profile 
Command line: RBCS_SPLIT 
 

Merge profiles 

 
 

Lets you connect independent profiles into one profile.  
Menu: Steel > Machining > Merge profiles  
Ribbon:  ASD - Model > Machining > Merge profiles  
Toolbar: Machining > Merge profiles 
Command line: RBCS_MERGE 
 

Split plate  

 
 

Lets you divide an existing plate into several independent parts. Specify 
the plate and define a cutting line (the cutting line can be defined as a line, 
polyline, or arc). The spacing between parts of the split plate can be 
defined (the spacing is divided symmetrically on both sides of the cutting 
line).   
NOTE: If the cutting line intersects chamfers defined in the plate, these 
chamfers are removed from the plate. If the cutting line does not intersect 
chamfers, they remain in the split parts of the plate.   
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Menu: Steel > Machining > Split plate  
Ribbon:  ASD - Model > Machining > Split plate  
Toolbar: Machining > Split plate 
Command line: RBCS_SPLIT 
 

Merge plates 

 
 

Lets you connect 2 independent plates into 1 plate, as long as the plates 
lie in one plane and touch each other.  
The resulting plate (type: user) is made of the material of which the plate 
selected first is made. All machinings of merged plates are kept.  
Menu: Steel > Machining > Merge plates  
Ribbon:  ASD - Model > Machining > Merge plates 
Toolbar: Machining > Merge plates  
Command line: RBCS_MERGE 
 

Add plate vertex 

 

Lets you add a vertex (or vertexes) in a polyline that defines an indicated 
plate. Adding a new plate vertex changes the type of the plate (to a user-
defined plate).  
Menu: Steel > Machining > Add plate vertex  
Ribbon:  ASD - Model > Machining > Add plate vertex  
Toolbar: Machining > Add plate vertex 
Command line: RBCS_ADDVERTEX 
 

Remove plate 
vertex 

 

Lets you remove a vertex (or vertexes) belonging to a polyline that defines 
an indicated plate. Removing a plate vertex is possible only when the 
plate contour will be a closed polyline after removing the vertex (for 
example, it is impossible to remove a vertex from a triangular plate).    
Removing a plate vertex changes the type of the plate (to the user-defined 
plate).  
Menu: Steel > Machining > Remove plate vertex  
Ribbon:  ASD - Model > Machining > Remove plate vertex  
Toolbar: Machingng > Remove plate vertex 
Command line: RBCS_REMOVEVERTEX 
 

Chamfer plate 
corner 

 
 

Lets you chamfer a plate corner. There are a few types of chamfering 
available.  
Menu: Steel > Machining > Chamfer plate corner  
Ribbon:  ASD - Model > Machining > Chamfer plate corner 
Toolbar: Machining > Chamfer plate corner 
Command line: RBCS_CHAMFCORN 
 

Insert arc 

 
 

Lets you insert an arc (bent profile) between 2 indicated profiles.  
After you select 2 profiles, the following question appears in the command 
line: ’Do you want to join profiles?’ Depending on the answer to this 
question, the resultant profile may be:  
- NO: a composition of 3 profiles (2 initial profiles and a bent profile)  
- YES: 1 profile (3 component profiles will be joined into 1 profile) 
Menu: Steel > Machining > Insert arc  
Ribbon:  ASD - Model > Machining > Insert arc  
Toolbar: Machining > Insert arc 
Command line: RBCS_BENDCORNER 
 

Drill/Bolt 

 

Opens the Drilling dialog, where you can define openings and bolts.  
Menu: Steel > Machining > Drill/Bolt  
Ribbon:  ASD - Model / Bolts/Welds / Drill/Bolt  
Toolbar: Machining II > Drill/Bolt 
Command line: RBCS_DRILL 
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Weld 

 

Opens the Welds dialog, where you can define welded connections.  
Menu: Steel > Machining > Weld  
Ribbon:  ASD - Model > Bolts/Welds > Weld  
Toolbar: Machining > Weld 
Command line: RBCS_WELD 
 

Multi-weld 

 

Opens the Welds dialog, where you can define welded connections for 
several elements simultaneously. After several objects are selected 
(profiles or plates), the software performs an analysis of the contact area 
for the indicated elements. After you specify a weld type in the Welds 
dialog, welded connections of the indicated elements are generated.  
Menu: Steel > Machining > Multi-weld  
Ribbon:  ASD - Model > Bolts/Welds > Multi-weld  
Toolbar: Machining II > Multi-weld 
Command line: RBCS_MWELD 
 

Copy weld  

 

Lets you copy selected welds.  
Menu: Steel > Machining > Copy weld  
Ribbon:  ASD - Model > Bolts/Welds > Copy weld  
Toolbar: Machining II > Copy weld 
Command line: RBCS_COPYWELD 
 

Copy drills / bolts  

 

Lets you copy selected drills or bolts.  
Menu: Steel > Machining > Copy drills/bolts  
Ribbon:  ASD - Model > Bolts/Welds > Copy drills/bolts  
Toolbar: Machining II > Copy drills/bolts 
Command line: RBCS_COPYDRILL 
 

Adopt drills  

 

Lets you adopt all properties of a selected drill.   
Menu: Steel > Machining > Adopt drills  
Ribbon:  ASD - Model > Bolts/Welds > Adopt drills  
Toolbar: Machining II > Adopt drills 
Command line: RBCS_TAKEDRILL 
 

Insert bolts  

 

Lets you insert a bolt into a selected drill.   
Menu: Steel > Machining > Insert bolts  
Ribbon:  ASD - Model > Bolts/Welds > Insert bolts  
Toolbar: Machining II > Insert bolts 
Command line: RBCS_BOLTHOLES 
 

Explode group of 
holes/bolts 

 

Lets you explode a group of holes/bolts into basic AutoCAD®objects.   
Menu: Steel > Machining > Explode group of holes/bolts  
Ribbon:  ASD - Model > Bolts/Welds > Explode group of holes/bolts 
Toolbar: Machining II > Explode group of holes/bolts 
Command line: RBCS_EXPLDRILL 
 

Remove bolts  

 

Lets you remove bolts.   
Menu: Steel > Machining > Remove bolts  
Ribbon:  ASD - Model > Bolts/Welds > Remove bolts 
Toolbar: Machining > Remove bolts 
Command line: RBCS_REMBOLTS 
 

Copy connection  

 

Lets you copy a selected connection.    
Menu: Steel > Machining  > Copy connection  
Ribbon:  ASD - Model > Connections > Copy connection  
Toolbar: Machining II > Copy connection 
Command line: RBCS_CONNECTION 
See also: Copy connection 
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Update 
connections  

 

Lets you update selected connections after modifications in structure 
geometry. Connections are adjusted to new structure dimensions; the 
connection update mode depends on the option settings in the Project 
preferences dialog.    
Menu: Steel > Machining  > Update connections  
Ribbon:  ASD - Model > Connections > Update connections  
Toolbar: Machining II > Update connections 
Command line: RBCS_CONNUPDATE 
See also: Project preferences / General 

Tools  
Explode  

 

Lets you explode some complex elements (groups, connections) into 
single elements.  
Menu: Steel > Tools > Explode  
Ribbon:  ASD - Model > Tools > Explode 
Toolbar: General > Explode 
Command line: RBCS_EXPLODE 
 

Modify properties  

 

Lets you modify parameters of selected objects; a dialog displays, where 
you can change parameter values for a selected object.  
Menu: Steel > Tools > Modify properties  
Ribbon: ASD - Model > Tools > Modify properties 
Toolbar: General > Modify properties 
Command line: RBCS_PROPERTIES 
 

Family Manager  

  

Opens the Family Manager dialog; use this option to manage families of 
steel elements.  
Menu: Steel > Tools > Family Manager  
Ribbon:  ASD - Model > Tools > Family Manager 
Toolbar: General > Family Manager 
Command line: RBCS_FAMILIES 
 

Group 

 

Lets you create groups of selected objects.  
Menu: Steel > Tools > Group  
Ribbon:  ASD - Model > Groups > Group  
Toolbar: General > Group 
Command line: RBCS_GROUP 
 

Group assemblies 

 

Lets you group assemblies based on the defined connections.  
Menu: Steel > Tools > Group assemblies  
Ribbon:  ASD - Model > Groups > Group assemblies  
Toolbar: General > Group assemblies 
Command line: RBCS_ASSEMBLY 
 

User sections  

 

Lets you define a profile and save it to a profile database or locally, in a 
project.   
See also: Example of defining a user section  
Menu: Steel > Tools > User sections  
Ribbon:  ASD – Model / Tools / User sections  
Toolbar: General > User sections 
Command line: RBCS_USRPROFILE 
See also: Example of user profile definition  

Inquire  
Object info 

 
 

Opens the ACAD text window, where you can get information about the 
selected object.  
Menu: Steel > Tools > Inquire > Object info  
Ribbon:  ASD - Model > Tools > Object info  
Toolbar: General > Object info 
Command line: RBCS_INQ_ELEMENT 
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Group 

 
 

Opens the ACAD text window, where you can get information about the 
group to which the selected object belongs.  
Menu: Steel > Tools > Inquire > Group  
Ribbon:  ASD - Model > Tools > Group  
Toolbar: General > Group 
Command line: RBCS_INQ_GROUP 
 

Assembly 

 
 

Opens the ACAD text window, where you can get information about the 
assembly to which the selected object belongs. 
Menu: Steel > Tools > Inquire > Assembly  
Ribbon:  ASD - Model > Tools > Assembly  
Toolbar: General > Assembly 
Command line: RBCS_INQ_ASSEMBLY 
 

Center of gravity 

 
 

Opens the ACAD text window, where you can calculate coordinates of the 
gravity center for a structure or its selected part. 
Menu: Steel > Tools > Inquire > Center of gravity  
Ribbon:  ASD - Model > Tools > Center of gravity  
Toolbar: General > Center of gravity 
Command line: RBCS_INQ_COG 
 

Model size  

 
 

Opens the ACAD text window, where you can calculate dimensions and 
weight of a structure or its selected part. 
Menu: Steel > Tools > Inquire > Model size  
Ribbon:  ASD – Model / Tools / Model size 
Command line: RBCS_INQ_MSIZE 
 

Collision detection   

 

Lets you find a collision of structure components (profiles, plates, bolts, 
and so on).    
The command line displays a number of detected collisions between 
structure elements. It is possible to save collision tests in the 
RBCS_Collision_Detection layer and represented by AutoCAD® 3D Solid 
objects. 
Menu: Steel > Tools > Inquire > Collision detection  
Ribbon:  ASD – Model / Tools / Collision detection 
Command line: RBCS_INQ_COLISION 
See also: Collision detection 

Filters  
Show current 
selection 

 
 

Lets you filter objects in a drawing (only selected objects are displayed). 
The filter is also accessible from the Object Inspector dialog.  
Menu: Steel > Tools > Filters > Show current selection  
Ribbon:  ASD - Model > Tools > Show current selection  
Toolbar: Workspace > Show current selection 
Command line: RBCT_SHOWCURSEL 
 

Hide current 
selection 

 
 

Lets you filter objects in a drawing (only unselected objects are displayed). 
The filter is also accessible from the Object Inspector dialog. 
Menu: Steel > Tools > Filters > Hide current selection  
Ribbon:  ASD - Model > Tools > Hide current selection  
Toolbar: Workspace > Hide current selection 
Command line: RBCT_HIDECURSEL 
 

Show all 

 
 

Lets you filter objects in a drawing (all objects are displayed). The filter is 
also accessible from the Object Inspector dialog. 
Menu: Steel > Tools > Filters > Show all  
Ribbon:  ASD - Model > Tools > Show all  
Toolbar: Workspace > Show all 
Command line: RBCT_SHOWALLOBJ 
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Workspace  
Show / Hide 
Inspector  

 

Lets you show or hide the Object Inspector dialog which is by default 
displayed in the left part of the screen.   
Menu:  Steel > Tools > Workspace > Show / Hide Inspector    
Ribbon:  ASD - Model > Tools > Object inspector - Show / Hide  
Toolbar: Workspace > Object inspector - Show / Hide 
Command line: RBCTOI 
 

Object snap 
settings 

 

Opens the Snap Mode dialog; use this option to set active snap points for 
steel profiles.  
Menu:  Steel > Tools > Workspace > Object snap settings    
Ribbon:  ASD - Model > Tools > Object snap settings  
Toolbar: Workspace > Object snap settings 
Command line: RBCS_PSNAP 
 

Lock X direction  

 

Lets you select or deselect blocking the local X axis of the bar profile; if 
this option is selected, you can perform the operation of extending a bar 
only along the bar axis; if this option is deselected, a profile can be 
extended in any direction you selected.   
Menu: Steel > Tools > Workspace > Lock X direction    
Ribbon:  ASD - Model > Tools > Lock X direction 
Toolbar: Workspace > Lock X direction 
Command line: RBCS_LOCKX 
 

2D copying / 
moving 

Options for moving or copying selected elements in a specified direction 
(along the axis or in the plane). 
Menu: Steel > Tools > Workspace > 2D copying/moving 
Ribbon:  ASD - Model > Tools 
Toolbar: Workspace >  2D copying/moving  
 

Select assembly   

 

Lets you select a part of an assembly; it selects a whole assembly that this 
part belongs to.  
Menu: Steel > Tools > Workspace > Select assembly    
Ribbon:  ASD - Model > Tools > Select assembly  
Toolbar: Workspace > Select assembly 
Command line: RBCS_SELASSEMBLY 
 

Dynamic UCS 

 

Lets you fit the view plane and active UCS to the UCS of a selected 
object.  
Menu: Steel > Tools > Workspace > Dynamic UCS    
Ribbon:  ASD - Model > Tools > Dynamic UCS 
Toolbar: Workspace > Dynamic UCS 
Command line: RBCS_DYNUCS 
 

Elevation mark - 
model  

 

Lets you insert an elevation mark in a selected plane and in a selected 
location in the drawing   
Menu: Steel > Tools > Workspace > Elevation mark - model  
Ribbon:  ASD - Model > Tools > Elevation mark - model 
Toolbar: Workspace > Elevation mark - model 
Command line: RBCS_MELEV 
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Clipping plane on  

 

Lets you limit the model view with 2 planes  
Menu: Steel > Tools > Workspace > Clipping plane on   
Ribbon:  ASD - Model > Tools > Clipping plane on  
Toolbar: Workspace > Clipping plane on 
Command line: RBCS_CLIPON 
 

Clipping plane off  

 

Lets you deselect limiting the model view with 2 planes.  
Menu: Steel > Tools > Workspace > Clipping plane off    
Ribbon:  ASD - Model > Tools > Clipping plane off 
Toolbar: Workspace > Clipping plane off 
Command line: RBCS_CLIPOFF 

Positions  
Assign position  

 

Opens the Manual positioning dialog, where you can ascribe the position 
to a selected part.  
Menu: Steel > Positions > Assign position  
Ribbon:  ASD - Model > Positions > Assign position 
Toolbar: General > Assign position 
Command line: RBCS_MANUALPOS 
 

Automatic 
positioning 

 

Opens the Automatic positioning dialog, where you can ascribe positions 
to structure elements automatically.  
Menu: Steel > Positions > Automatic positioning  
Ribbon:  ASD - Model > Positions > Automatic positioning 
Toolbar: General > Automatic positioning   
Command line: RBCS_AUTOPOS 
 

Remove position  

 

Lets you remove the ascribed position from a selected part.  
Menu: Steel > Positions > Remove position  
Ribbon:  ASD - Model > Positions > Remove position  
Toolbar: General > Remove position 
Command line: RBCS_REMPOS 
 

Verify positions  

 

Opens the Position verification dialog, where you can run verification of 
selected positions.  
Menu:  Steel > Positions > Verify positions  
Ribbon:  ASD - Model > Positions > Verify positions  
Toolbar: General > Verify positions 
Command line: RBCS_VERIFYPOS 
 

Parametric 
structures  
 

A submenu and toolbar with options that enable definition of typical 
elements of steel structures.   
Menu: Steel > Parametric structures 
Ribbon:  ASD – Model / Parametric structures 
Toolbar: Parametric structures 
 

Multi-bay frame 

 
 

Lets you define a parametric multi-bay frame.  
Menu: Steel > Parametric structures > Multi-bay frame  
Ribbon:  ASD - Model > Parametric structures > Multi-bay frame 
Toolbar: Parametric structures > Multi-bay frame 
 

Roof truss 

 
 

Lets you define a parametric roof truss.  
Menu: Steel > Parametric structures > Roof truss  
Ribbon:  ASD - Model > Parametric structures > Roof truss 
Toolbar: Parametric structures > Roof truss 
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Bracing 

 
 

Lets you define a parametric bracing.  
Menu: Steel > Parametric structures > Bracing  
Ribbon:  ASD - Model > Parametric structures > Bracing 
Toolbar: Parametric structures > Bracing 
 

Brace 

 
 

Lets you define a parametric brace.  
Menu: Steel > Parametric structures > Brace  
Ribbon:  ASD - Model > Parametric structures > Brace 
Toolbar: Parametric structures / Brace 
 

Stairs 

 
 

Lets you define parametric stairs.  
Menu: Steel > Parametric structures > Stairs  
Ribbon:  ASD - Model > Parametric structures > Stairs 
Toolbar: Parametric structures > Stairs 
 

Stairs spiral 

 
 

Lets you define parametric spiral stairs.  
Menu: Steel > Parametric structures > Stairs spiral  
Ribbon:  ASD - Model > Parametric structures > Stairs spiral 
Toolbar: Parametric structures > Stairs spiral 
 

Staircase 

 
 

Lets you define a parametric staircase.  
Menu: Steel > Parametric structures > Staircase  
Ribbon:  ASD - Model > Parametric structures > Staircase 
Toolbar: Parametric structures > Staircase 
 

Railing 

 
 

Lets you define a parametric railing.  
Menu:  Steel > Parametric structures > Railing  
Ribbon:  ASD - Model > Parametric structures > Railing 
Toolbar: Parametric structures > Railing 
 

Ladder 

 
 

Lets you define a parametric ladder.  
Menu:  Steel > Parametric structures > Ladder  
Ribbon:  ASD - Model > Parametric structures > Ladder 
Toolbar: Parametric structures > Ladder 
 

Cage 

 
 

Lets you define a parametric cage.  
Menu:  Steel > Parametric structures > Cage  
Ribbon:  ASD - Model > Parametric structures > Cage 
Toolbar: Parametric structures > Cage 
 

Purlin spreading 

 
 

Lets you define a distribution of purlins.  
Menu: Steel > Parametric structures > Purlin spreading  
Ribbon:  ASD - Model > Parametric structures > Purlin spreading 
Toolbar: Parametric structures / Purlin spreading 
 

Grate spreading 

 
 

Lets you define a distribution of grates.  
Menu: Steel > Parametric structures > Grate spreading 
Ribbon:  ASD - Model > Parametric structures > Grate spreading 
Toolbar:  Parametric structures > Grate spreading 
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Drawings edition  
Change style  

 

Opens the Design styles dialog, where you can change a design style for 
a selected drawing.  
Menu: Steel > Edit drawings > Change style  
Ribbon: ASD - Drawings > Edit drawings > Change style 
Toolbar: Edit drawings > Change style 
Command line: RBCS_CNGSTYLE 
 

Adjust style   

 

Opens the Design styles dialog, where you can change a design style for 
a selected drawing.   
Menu: Steel > Edit drawings > Adjust style  
Ribbon:  ASD - Drawings > Edit drawings > Adjust style 
Toolbar: Edit drawings > Adjust style 
Command line: RBCS_ADJSTYLE 
 

Lock dimensions  

 

Lets you freeze generated drawings with existing dimensions or 
descriptions. This is the option to protect existing drawings (changed 
manually by the user) from losing the changes while the drawing is 
updated. Automatically generated drawings are quite often changed by 
adding, deleting or moving dimensions or descriptions. To avoid losing 
changes while the drawing is updated, select this option and lock 
dimensions in the drawing.  
After executing this command, the command line displays a message 
about dimensions in the drawing (locked dimensions and dimensions that 
are not locked); in addition, an icon displays in the Object Inspector 
pane.  
Menu: Steel > Drawings Edition > Lock dimensions  
Ribbon:  ASD - Drawings > Edit drawings > Lock dimensions 
Toolbar: Edit drawings > Lock dimensions  
Command line: RBCS_DIMLOCK 
 

Edit view in full 
screen 

 

Select this in order to edit a created drawing on the full monitor screen.    
Menu:  Steel > Drawings Edition > Edit view in full screen  
Ribbon:  ASD - Drawings > Edit drawings > Edit view in full screen  
Toolbar: Edit drawings > Edit view in full screen 
Command line: RBCT_FULLSCREEN_ON 
 

Full screen off  

 

Select this to turn off the ability to edit a drawing on the full monitor screen. 
Menu: Steel > Drawings Edition > Full screen off  
Ribbon:  ASD - Drawings > Edit drawings > Full screen off  
Toolbar: Edit drawings > Full screen off 
Command line: RBCT_ FULLSCREEN_OFF 
 

Insert weld symbol 

 

Lets you insert a weld symbol in a drawing. 
Menu: Steel > Drawings Edition > Insert weld symbol  
Ribbon:  ASD - Drawings > Edit drawings > Insert weld symbol 
Toolbar: Edit drawings > Insert weld symbol 
Command line: RBCS_ADDWELD 
 

Insert elevation 
mark  

 

Lets you insert an elevation mark in a drawing.  
Menu: Steel > Drawings Edition > Insert elevation mark  
Ribbon:  ASD - Drawings > Edit drawings > Insert elevation mark  
Toolbar: Edit drawings > Insert elevation mark 
Command line: RBCS_ADDELEV 
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Insert part label  

 

Lets you insert description of parts in a drawing.  
Menu: Steel > Drawings Edition > Insert part label  
Ribbon:  ASD - Drawings > Edit drawings > Insert part label  
Toolbar: Edit drawings > Insert part label 
Command line: RBCS_PARTLBL 
 

Insert assembly 
label  

 

Lets you insert an assembly description in a drawing.  
Menu: Steel > Drawings Edition  > Insert assembly label  
Ribbon:  ASD - Drawings > Edit drawings > Insert assembly label  
Toolbar: Edit drawings > Insert assembly label 
Command line: RBCS_ASLBL 
 

Add view (detail)  

 

Lets you create a new view (view of a section detail) in a drawing.  
Menu: Steel > Drawings Edition > Add view (detail)  
Ribbon:  ASD - Drawings > Edit drawings > Add view (detail) 
Toolbar: Edit drawings > Add view (detail) 
Command line: RBCS_ADDDETAILVIEW 
 

Add cut  

 

Lets you create a new view (view of a section) in a drawing. To create a 
cut: 
1. specify points defining the cut  
2. specify a range  
3. specify a cut name  
4. select a drawing template.  
Menu: Steel > Drawings Edition > Add cut  
Ribbon:  ASD - Drawings > Edit drawings > Add cut 
Toolbar: Edit drawings > Add cut 
Command line: RBCS_ADDCUT 
 

Automatic cuts  

 

Lets you automatically create new views (cuts) in the drawing.  
Menu: Steel > Drawings Edition > Automatic cuts  
Ribbon:  ASD - Drawings > Edit drawings > Automatic cuts  
Toolbar: Edit drawings > Automatic cuts 
Command line: RBCS_AUTOCUT 
 

Move cut  

 

Lets you change a cut in the drawing. You can change a position or range 
of the cut, and a symbol description.   
Menu: Steel > Drawings Edition > Move cut  
Ribbon:  ASD - Drawings > Edit drawings > Move cut  
Toolbar: Edit drawings > Move cut 
Command line: RBCS_MOVCUT 
 

Change view scale 

 

Lets you change scale of a view (projection) in a drawing.  
Menu: Steel > Drawings Edition > Change view scale  
Ribbon:  ASD - Drawings > Edit drawings > Change view scale  
Toolbar: Edit drawings > Change view scale 
Command line: RBCS_CNGSCALE 
 

Rotate view  

 

Lets you rotate a view (projection) in a drawing.  
Menu: Steel > Drawings Edition > Rotate view   
Ribbon:  ASD - Drawings > Edit drawings > Rotate view  
Toolbar: Edit drawings > Rotate view 
Command line: RBCS_ROTATEVIEWPORT 
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Shorten drawing 

 

Lets you shorten a selected element in a drawing. The option is useful for 
long elements (in particular, for these element segments that do not 
contain any snap points); the element shortening is displayed as a gap in 
the element subjected to shortening.  
Menu: Steel > Drawings Edition > Shorten drawing  
Ribbon:  ASD - Drawings > Edit drawings > Shorten drawing  
Toolbar: Edit drawings > Shorten drawing 
Command line: RBCS_SHORTDRAW 
 

Delete all 
shortenings 

 

Lets you delete all the defined element shortenings in a drawing.     
Menu: Steel > Edit drawings > Delete all shortenings   
Ribbon:  ASD - Drawings > Edit drawings > Delete all shortenings  
Toolbar: Edit drawings > Delete all shortenings 
Command line: RBCS_DELSHORTDRAW 
 

Dimensioning 
General / Detailed 

Lets you refresh the view (including the dimensioning of elements) based 
on the settings of styles that are associated with details. You can select 
the following dimensioning style: standard, detailed or schematic.    
Menu: Steel > Drawings Edition > Dimensioning General > Detailed   
Ribbon:  ASD - Drawings > Edit drawings > Dimensioning General > 
Detailed  
Toolbar: Edit drawings > Dimensioning General > Detailed 
Command line: RBCS_CNGDET 
 

Explode drawing  

 

Lets you explode drawings into basic AutoCAD®objects.  
Menu: Steel > Drawings Edition > Explode drawing  
Ribbon:  ASD - Drawings > Edit drawings > Explode drawing  
Toolbar: Edit drawings > Explode drawing 
Command line: RBCS_EXPLODE 
 

Drawing template 
designer  

 
 

Lets you create and modify drawing templates.  
Menu: Steel > Drawings Edition > Drawing template designer  
Ribbon:  ASD - Drawings > Generate drawings > Drawing template 
designer  
Toolbar: Edit drawings > Drawing template designer 
Command line: RBCS_ADDTEMPLATE 
 

Automatic 
printouts   

 

Lets you create automatic printouts (one part in one drawing). NOTE: This 
option is not available for schemes of elements disposition.  
Menu: Steel > Automatic printouts   
Ribbon:  ASD - Drawings > Generate drawings > Automatic printouts  
Toolbar: Printout > Automatic printouts 
Command line: RBCS_AUTOPRINT 
 

Automatic printing 

 

Lets you generate workshop drawings automatically to plotter.   
Ribbon:  ASD - Drawings > Generate drawings > Automatic printing 
Toolbar: Printout > Automatic printout 
Command line: _AUTOPLOT 

Engineering 
drawings  

 

Engineering 
drawings   

 
 

Lets you define a group of structure elements to make a scheme drawing 
of a structure model. Drawings presenting structure elements in a 
simplified way are created for a defined scheme.    
Menu: Steel > Engineering drawings > Engineering drawings    
Ribbon:  ASD - Model > Groups > Engineering drawings   
Toolbar: Engineering drawings > Engineering drawings   
Command line: RBCS_SCHEME 

 © 2010 Autodesk, Inc. All rights reserved          



page: 18 AutoCAD Structural Detailing - Steel - User Guide 

Create mark 

 

Lets you create a mark, that is an object consisting of selected structure 
elements. It is usually an element (composed of parts such as plates, 
profiles, user parts or connectors) which has a different function in 
structure calculations, such as column, beam, frame or bracing.  
Marks that have the same function in the structure and that have the same 
geometry can be labeled with the same name (referred to as a mark). The 
degree of similarity of elements (and of names of marks) is user-defined.  
The basic functionality of a mark is that you can draw and describe it as a 
single element in the drawing.  
To define a mark:  
1. select elements that should belong to the mark 
2. specify a mark name  
3. define values of forces.  
 
Menu: Steel > Engineering drawings > Create mark    
Ribbon:  ASD - Model > Groups > Create mark 
Toolbar: Engineering drawings > Create mark    
Command line: RBCS_MARK 
 

Create mark from 
assembly   

 

Lets you create marks form all assemblies in the selection. If single 
elements are also selected, they are ignored while creating a mark.  
To create a mark:  
1. select assemblies 
2. specify a mark name  
3. define values of forces.  
 
Menu: Steel > Engineering drawings > Create mark from assembly    
Ribbon:  ASD - Model > Groups > Create mark from assembly   
Toolbar: Engineering drawings > Create mark from assembly    
Command line: RBCS_ASMARK 
 

Create mark from 
single part 

 
 

Lets you create marks with the same names, that are entirely included in 
the selection of elements. Marks created using this option consist of a 
single element set. 
To create a mark:  
1. select parts  
2. specify a mark name  
3. define values of forces.  
 
Menu: Steel > Engineering drawings > Create mark from single part   
Ribbon:  ASD - Model > Groups > Create mark from single part   
Toolbar: Engineering drawings > Create mark from single part   
Command line: RBCS_SPMARK 
 

Tube development 

 
 

Lets you create a drawing of a developed tube profile.  
Menu: Steel > Tube development  
Ribbon:  ASD - Drawings > Printout  > Tube development  
Toolbar: Printout  > Tube development 

Styles  
Dimensioning 
style   

Opens the Dimensioning styles dialog, where you can determining the 
styles of dimensioning for elements provided in a drawing.   
Menu: Steel > Styles > Dimensioning styles  
Ribbon:  ASD - Drawings  Styles > Dimensioning styles  
Command line: RBCS_DIM 
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Description styles Opens the Styles of descriptions dialog , where you can determine styles 

of descriptions for elements provided in a drawing.  
Menu: Steel > Styles > Description styles  
Ribbon:  ASD - Drawings > Styles > Dimensioning styles 
Command line: RBCS_DESCRIPTION 
 

Tables  
Bill of materials  

 

Lets you prepare tables of all structure elements.  
Menu: Steel > Tables > Bill of materials  
Ribbon:  ASD - Drawings > Tables > Bill of materials 
Toolbar: General > Bill of materials 
Command line: RBCS_BILL 
 

List of profiles  

 

Lets you prepare tables of profiles.  
Menu: Steel > Tables > List of profiles  
Ribbon:  ASD - Drawings > Tables > List of profiles 
Toolbar: General > List of profiles 
Command line: RBCS_PROFILELIST 
 

List of profiles (by 
section types)  

 

Lets you create tables of profiles by profile cross-sections.  
Menu: Steel > Tables > List of profiles by section types  
Ribbon:  ASD - Drawings > Tables > List of profiles by section types 
Toolbar: General > List of profiles by section types 
Command line: RBCS_PROFILELISTSUM 
 

List of plates  

 

Lets you prepare tables of plates.  
Menu: Steel > Tables > List of plates  
Ribbon:  ASD - Drawings > Tables > List of plates  
Toolbar: General > List of plates 
Command line: RBCS_PLATELIST 
 

List of user parts  

 

Lets you prepare tables of user parts.  
Menu: Steel > Tables > List of user parts  
Ribbon:  ASD - Drawings > Tables > List of user parts 
Toolbar: General > List of user parts  
Command line: _RBCS_USEROBJLIST 
 

List of assemblies  

 

Lets you prepare assembly tables.  
Menu: Steel > Tables > List of assemblies  
Ribbon:  ASD - Drawings > Tables > List of assemblies  
Toolbar: General > List of assemblies 
Command line: RBCS_ALIST 
 

Mounting list  

 

Lets you prepare mounting tables.  
Menu: Steel > Tables > Mounting list  
Ribbon:  ASD - Drawings > Tables > Mounting list  
Toolbar: General > Mounting list 
Command line: RBCS_MONTLIST 
 

Bolt list 

 

Lets you prepare connector tables.  
Menu: Steel > Tables > Bolt list  
Ribbon:  ASD - Drawings > Tables > Bolt list 
Toolbar: General > Bolt list 
Command line: RBCS_BLIST 
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Update table  

 
 

Lets you update a table presented in a drawing.   
Menu: Steel > Tables > Update table  
Ribbon:  ASD - Drawings > Tables > Update table  
Toolbar: General > Update table 
Command line: RBCS_ACTTABLE 
 

Tables manager  

 

Opens the Table printout manager dialog, where you can define/modify 
the appearance of the printout of tables used to prepare steel summary 
tables. 
Menu: Steel > Tables > Tables manager   
Ribbon:  ASD - Drawings > Tables > Tables manager 
Toolbar: General > Tables manager 
Command line: RBCS_LISTPRINT 
 

Styles 
 

Opens the Steel summary tables - style manager dialog, where you can 
define/modify tables used to prepare steel summary tables. 
Menu: Steel > Tables > Styles  
Ribbon:  ASD - Drawings > Settings > Table styles 
Command line: RBCS_LISTTEMPL 
 

Static analysis - 
Autodesk Robot 
Structural Analysis 

 
 
 

Lets you export a structure model to the calculation program Autodesk 
Robot Structural Analysis.  
Menu: Steel > Static analysis - Robot  
Ribbon:  ASD - Model > Tools > Static analysis - ARSA  
Toolbar: General > Static analysis - ARSA 
Command line: RBCS_R2R 
 

DSTV data export 

 

Lets you read / save a DSTV format file.   
Menu: Steel > DSTV data export  
Ribbon:  ASD - Model > Tools > DSTV data export  
Toolbar: General > DSTV data export 
Command line: RBCS_DSTV 
 

Save model as 
ACIS solids 

 
 

Lets you save a structure model to a DWG format file (ACIS format). You 
can select the full (complete description of solid details) or simplified save 
option. If the simplified save option is selected, profiles are saved without 
fillets and openings (except anchor openings), bolts, washers, nuts and 
anchors are ignored.    
Menu: Steel > Save model as ACIS solids  
Ribbon:  ASD - Model > Tools > Save model as ACIS solids  
Toolbar: General > Save model as ACIS solids 
Command line: RBCS_EXPORTMODEL 
 

Preferences 

 

Opens the Options dialog, where you can specify parameters of the work 
environment for AutoCAD® Structural Detailing.  
Menu: Steel > Preferences  
Ribbon:  ASD - Model > Settings > Preferences  
Toolbar: General > Preferences 
Command line: RBCS_PREF 
 

Project 
preferences  

 

Opens the Project preferences dialog, where you can adopt basic 
parameters of the current project in AutoCAD® Structural Detailing.  
Menu: Steel > Project preferences  
Ribbon:  ASD - Model > Settings > Project preferences  
Toolbar: General > Project preferences 
Command line: RBCS_PRJPREF 
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Divide project 

 

Lets you divide a project into several parts (distributed work on a 
document); it allows decreasing the size of a file with project data.         
Menu: Steel > Divide project  
Toolbar: General > Divide project 
Command line: RBCT_DISTRIBUTE 
 

 

1.4. Ribbon 
The ribbon is an element of the user interface which replaces the traditional menu and 
toolbars and allows easy managing and adjusting the workspace.  
 

  
 
The ribbon consists of several panels, grouped on tabs that are named by task or subject.  
The ribbon panels include many commands that have been on toolbars and in dialogs so far, 
such as icons, drop-down lists, sliders, text fields and other elements characteristic of a given 
tab. Using the ribbon, you do not have to display many toolbars; thus the application displays 
fewer functions and increases the allowable workspace placing the whole interface on a small 
area that can be anytime shown or hidden.  
The ribbon displays automatically when a drawing is created or opened using the ASD steel 
workspace. You can display the ribbon manually using either of the following methods: 
• select the main menu Tools > Palettes > Ribbon  
• type RIBBON in the command line to show the ribbon or RIBBONCLOSE to hide it.  

You can customize the ribbon, that is you can add, delete and modify positions of panel 
elements, in the Customize User Interface (CUI) editor window. Open this editor using either 
of the following methods: 

• click on the Manage tab > Customization > User Interface 
• type CUI in the command line. 

 

  NOTE:  
You can display the ribbon horizontally, vertically or as a floating palette. 
 
Using the editor you can also switch between workspaces (such as the classic workspace 
without the ribbon). To do it, select the Customize tab > Workspaces and select Set current 
from the context menu. 

To change between workspaces, you can also use the  Workspace Switching icon at the 
bottom right corner of the screen. 
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1.5. Divide project (distributed work) 
Use this option to divide a file with a structure model into smaller files. 
 
Access the option from: 

• Menu: Steel / Divide project 

• Toolbar: General Divide project  
• Command line: RBCT_DISTRIBUTE 
• When running automatic drawings,  select Start distributed work.     

 
The option creates a subfolder where, in separate DWG files, information about positions is 
saved. The main DWG file is therefore smaller, and loading such a file takes up much less 
time than loading one file that contains information about all structure elements.  
 

 NOTE: 
If you  have already divided a DWG file (has started distributed work on the project), there is 
no possibility to return to one large DWG file that contains information about all structure 
elements.    
 
To start distributed work:  

1. Open a model that has defined positions. 

2. Click the Divide project option . 
3. Select positions to be saved to external files. 
4. Press Enter.  

 
After a project is divided, successive positions / drawings added to a project are saved in 
separate files (Divide project works for new positions / drawings). 
 

 NOTE: 
To copy a created project in which distributed work has begun, copy the subfolder with 
separate DWG files that contain descriptions of individual positions / drawings.   
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2. CONFIGURATION 

2.1. Project preferences 

2.1.1. Project preferences 
Use this option to adopt basic parameters applied in AutoCAD® Structural Detailing (these 
parameters are saved in a DWG file).  
To begin working with project preferences, open the Project preferences dialog from:   

• Menu: Steel / Project preferences 
• Ribbon: ASD - Model / Settings / Project preferences 

• Toolbar: General / Project preferences   
• Command line: RBCS_PRJPREF. 

 
To specify project preferences:  

• In the left panel, use the selection tree (shown below) to specify a project preference 
option 

  

  
 

• In the right panel, specify parameters for the option selected on the left.   
 
Use the buttons on the right of the dialog:  

• Default - click this to save values of the project preference parameters as default 
values. 

• Save – if you click this, the current project preference parameters are saved under the 
name specified in the General dialog. 

• Delete - if you click this, you delete a set of project preferences saved under the name 
currently displayed in the General dialog.  

 
See also: 
Preferences  
 

2.1.2. General 
After you click General from the left pane of the Project Preferences dialog, the parameter 
options are as shown.  
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Define parameters:  

• Under Tolerances:   
o Parts identifying during positioning - an admissible deviation in dimensions of 2 

parts which are to be treated as identical during positioning 
o Contact of welded parts - an admissible distance between edges of the parts 

during detection of a contact line (used while welding the parts)  
o Arc display accuracy – a number of straight segments (with respect to a round 

angle - 360 degrees) into which a created arc is divided   
• Automatically create groups for the assemblies - if this is selected, the elements joined 

by means of workshop connectors (bolts or welds) are grouped automatically while 
these connectors are being inserted  

• Automatically update connections – if this is selected, then after the structure 
geometry is modified, the existing connections are adjusted to new structure 
dimensions. Selecting the option is recommended for small structures (and fast 
computers); for a large structure model, the operation of updating the structure may be 
very time-consuming  

• Create assemblies from loose parts - if this is selected, all parts that do not belong to 
any assembly will be ascribed a new position type called Assembly (during automatic 
generation of assemblies). If this is not selected, the position type of parts not 
belonging to any assembly will not be changed 

• Simplified modeling of connectors – if this is selected, all connectors are displayed in a 
simplified way; it decreases computer memory use, particularly for large structures.  

• Under Nomenclature of assemblies, you can select names of assemblies created 
automatically in the software  
o Text - an assembly name will consist of any user-defined text  
o Main part name – an assembly name will consist of a name of main element (for 

example, HP14x102)  
o Family + main part name - an assembly name will consist of a family name and a 

main element name (for example, Beam_HP14x102)  
• Nomenclature of plates   

o Overwrite prefix - if this is selected, a name defined in the field overwrites the 
default prefix for plates (the name created automatically when defining a plate)  

• Families settings - click this to open the Family manager dialog.  
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2.1.3. Units 
After selecting the Units option from the selection tree in the Project Preferences dialog, the 
following options display in the right part of this dialog.  
 

 
 

Use this tab to define AutoCAD® Structural Detailing work units. You can select one of the 
following unit systems: 
• imperial  

type:  
o architectural (0’-0)  
o engineering (0’-0’’) 

• metric.  
The unit system settings can be selected for the description format and table styles.  
You can also change the displayed number format. Use the selection lists to select a number 
of decimal places for each quantity. To change a number of decimal places, select an 
appropriate symbol from the selection list.    
 

2.1.4. Materials 
After you click Materials from the left pane of the Project Preferences dialog, the parameter 
options are as shown.  
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Specify parameters:  
• Under List of materials is a list of materials available in the current project. The same 

material list is included on the lists accessible under Default materials (profiles, plates, 
user parts).  

• Click Database to open the Material database dialog, where you can select materials 
to add to the list.  

• Under Default materials, you can select a material from lists of profiles, plates, user 
parts, and bolts. The selected materials will be adopted by default in the dialogs for 
definition of profiles, plates, user parts,or bolts.    

 

 NOTE: 
A default bolt grade chosen in the above dialog is taken into account in the AutoCAD® 
Structural Detailing macros (connections, typical structures) when bolts are inserted 
automatically. If you insert bolts ‘manually’, the most recently selected bolt grade is 
remembered in the dialog.   
 
Under Finishing of surface, you can define and/or select types of finishing of steel element 
surfaces (hot-dip galvanized, electrogalvanized, anticorrosive paint, fireproof coat, and none). 
The surface finishing type is an additional attribute of structure objects (profiles, plates, 
assemblies).  
This section includes the following buttons: 

• Add new – opens the Add new dialog for defining a name of a new type of surface 
finishing  

• Remove – removes a selected surface finishing type from the selection list 
 

 NOTE: 
A type of surface finishing is saved in the current project, in a list of types that is saved in a 
DWG file.  
 

 NOTE: 
An assembly adopts a surface finishing type from the type selected for the main part of that 
assembly.   
 

2.1.5. Material database 
The Material database dialog displays after you click Database on the Materials tab of the 
Project preferences dialog.    
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In the dialog, you can add materials from databases accessible in the program to the list of 
available materials. To add a material to the list:    
• Choose a material database from the selection list provided in the top part of the dialog 

(for example, 001, an American material database). 
• Select a material type in the left pane 
• Click Add >.  

Clicking Add all >> adds all the materials included in the left pane.    

Clicking  deletes a selected material from the list of available materials.   
 

2.1.6. Profiles 
After you click Profiles from the left pane of the Project Preferences dialog, the parameter 
options are as shown.  
 

 
 
The Profile database list displays profile folders (databases) available in the current project. 
Click List of profiles to open the dialog in which profiles applied in a given project are 
displayed.  
 
The following icons are at the top of the dialog:  

 – click this to open the dialog where you can select a database to be added to the list of 
available profile databases   

 – click this to delete a selected profile database    

,  – click these to move a database one position up or down on the list. The order is 
significant while searching through available profile databases. 
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2.1.7. Styles 
After you click Syles from the left pane of the Project Preferences dialog, the parameter 
options are as shown.  
 

 
 
Use these parameters to define table styles for the table types available in the software (Bills 
of materials, Profile summary, Plate summary, and so on). The selection lists include all the 
styles defined in a project.  
Click More… to open the Steel summary tables – style manager dialog.  
At the bottom of the dialog are 2 buttons: Dimensioning styles and Description styles, which, 
when clicked, will open the dialogs Dimensioning styles and Styles of descriptions, 
respectively. 
 

2.1.8. Connectors 
After you click Connectors from the left pane of the Project Preferences dialog, the parameter 
options are as shown.  
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Define parameters of bolts and welds:  
• For Default type, select a default weld/bolt type (workshop or site) 
• Under Bolts, you can select a standard (database) of bolts used in the software  
• Under Colors, you can specify the color of the following types of connectors displayed in 

drawings: workshop, site, or out-of-date (these are no longer current connectors after 
changes have been made in a structure model)   

 
Specify bolt parameters: 
• Select a method of assigning colors to bolts: by type, by grade, or by diameter. 
• Determine a rounding up length of bolts - in the software, the bolt length is automatically 

calculated for connections of elements. The default value for rounding up length is 5 mm, 
which you can modify. A value of this parameter is saved with the project in a DWG file.  

 

2.1.9. Standards 
After you click Standards from the left pane of the Project Preferences dialog, the parameter 
options are as shown.  
 

  
 
Use these options to select standards used in AutoCAD® Structural Detailing: a standard of 
the steel structure design and a drawing standard (drawings of steel structure elements). A 
selected drawing standard imposes designations (such as hatching symbols) that are valid in 
the country from which the standard originates. 
 
 Available standards: 

• Structural standard 
o Eurocode 3 
o Polish code PN-90/B-03200 
o French code CM66  
o Russian code SNiP II-23-81 

• Drawing standard (corresponding to a structural standard) 
o ISO 129 
o Russian code GOST 21.101-97 

 

2.1.10. Project Info 
After you click Project Info from the left pane of the Project Preferences dialog, the parameter 
options are as shown.  
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Use the edit fields to enter general information about the project. These fields correspond to 
the variables used in cells of tables included in drawings and in printout headers:   
Office - VAR_OFFICE 
Investor - VAR_INVESTOR 
Project name - VAR_PROJ_NAME 
Project No. - VAR_PROJ_NUM 
Address - VAR_ADDRESS 
Designed - VAR_DESIGNER 
Verified - VAR_VERIF 
Revision - VAR_REV 
Date - VAR_DATE 
 
Additional variables:  
Scale - VAR_SCALE 
Page No. - VAR_PAGENO 
 
See also: 
Parameters - variables  
 

2.2. Preferences 

2.2.1. Preferences 
Use this option to adopt basic parameters used in AutoCAD® Structural Detailing. 
 
To begin working with preferences, open the Options dialog from:   
• Menu: Steel / Preferences 
• Ribbon: ASD - Model / Settings / Preferences  

• Toolbar: General / Preferences  
• Command line  : RBCS_PREF. 

 
Click the Steel tab:  
• In the left pane, use the selection tree (shown below) from to specify a program 

preference option  
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• In the right pane, specify parameters for the option selected on the left.   

 
See also: 
Project preferences  
 

2.2.2. General settings 
After you click General settings from the left pane of the Structural Detailing tab (the 
AutoCAD® Options dialog), you can select a drawing template and a workspace name (such 
as ASD, ASD Classic) for AutoCAD® Structural Detailing modules.   
 

 
 
Available countries for which the working language may be selected: 

 Great Britain  Poland 

 USA  France 

 Italy  Spain 

 Russia  Germany. 
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2.2.3. Display settings 
After you click Display settings from the left pane of the Steel tab, the parameter options are 
as shown.  
 

 
 
Under Display, specify which elements to display in the drawing area:  
• Workframes  
• Matching marks 
• Connection marks  
• Symbols of assemblies  
• Symbols of groups 
• Symbols of schemes  
• Bolts  
• Welds. 

If Redraw acceleration is selected, then when an entire structure is displayed, a part of 
structure elements will not be shown (for example, connection details or connection symbols) 
due to an acceleration of model display on the screen. It is recommended to activate this 
option in the case of large structures.   
Under Clipping presets, specify values for distances between clipping planes and UCS.   
For Marking of machinings, select a color of machinings made in elements of a structure 
model.  
 

2.2.4. Profiles 
After you click Profiles from the left pane of the Steel tab, the parameter options are as shown.  
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Define display parameters for bar profiles:  
• For Profile display:  

o Axis only - if this is selected, a profile (bar) will be displayed as a line connecting 
the beginning point and end point of the profile. 

o Without roundings - if this is selected, a simplified view of a profile (without 
roundings) will be displayed. 

o Detailed - if this is selected, a profile (bar) will be displayed with all the details. 
• Local coordinate system - if this is selected, the local coordinate system will be displayed 

for all profiles defined in the project. 
• Bounding boxes - if this is selected, bounding boxes will be displayed for all profiles 

defined in the project. 
• Centerline - if this is selected, the bar axis will be displayed for all profiles defined in the 

project (regardless of which option has been chosen in the Profile display field).   
• Insertion line - if this is selected, the line of profile insertion will be displayed for all 

profiles defined in the project. This may be applied to present profile offsets.   
 

2.2.5. Plates 
After you click Plates from the left pane of the Steel tab, the parameter options are as shown.  
 

 
 
Specify display parameters for the defined plates:  

• Local coordinate system - if this is selected, the local coordinate system will be 
displayed for all plates defined in the project. 

• Bounding boxes - if this is selected, plate bounding boxes will be displayed for all 
plates defined in the project. 

• Middle surface - if this is selected, the middle surface will be displayed for all plates 
defined in the project. 

• Insertion plane - if this is selected, the insertion plane will be displayed for all plates 
defined in the project. This option may be applied in offset presentation.     
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2.2.6. Workframes 
After you click Workframes from the left pane of the Steel tab, the parameter options are as 
shown.  
 

 
 
Specify display parameters for the defined workframes:  

• The Line type list contains all line types available in the AutoCAD® project. Select a 
line type applied to lines of the workframes displayed in a structure model. 

• Under Labels: 
o Show labels - lets you switch the description of workframe lines on or off. 
o Frame shape - specify the shape of descriptions of workframe lines (round, 

rectangular, or without frame).  
o Text style - from the list of all text styles available in the AutoCAD®project, select 

a text style applied to descriptions of lines belonging to the workframes presented 
in a structure model. 

• Show workframe only in UCS plane - if this is selected, only these workframe lines 
which are positioned in the active local coordinate system are presented in the model.  

 

2.2.7. Connections 
After you click Connections from the left pane of the Steel tab, the parameter options are as 
shown.  
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Specify display parameters for labels of defined connections (spheres), assemblies, and 
groups:   

• Under Connections:  
o Size - define the size of the connection symbol  
o Relative to the screen - if this is selected, the size is expressed as a percentage  
o In absolute drawing units - if this is selected, the size is expressed in units used in 

AutoCAD®  
• Under Assemblies:  

o Color - select a color for the assembly symbol  
o Size - define the size of the assembly symbol  
o Relative to the screen - if this is selected, the size is expressed as a percentage  
o In absolute drawing units - if this is selected, the size is expressed in units used in 

AutoCAD® 
• Under Groups:  

o Color - select a color for the group symbol  
o Size - define the size of the group symbol  
o Relative to the screen - if this is selected, the size is expressed as a percentage 
o In absolute drawing units - if this is selected, the size is expressed in units used in 

AutoCAD® 
• Under Schemes:  

o Color - select a color for the scheme symbol   
o Size - define the size of the scheme symbol 
o Relative to the screen - if this is selected, the size is expressed as a percentage 
o In absolute drawing units - if this is selected, the size is expressed in units used in 

AutoCAD® 
 

2.2.8. Bolts and welds 
After you click Bolts and welds from the left pane of the Steel tab, the parameter options are 
as shown.  
 

 
 
Specify display parameters for the defined bolts and welds:   

• Under Bolt display: 
o Simplified - if this is selected, bolts will be displayed as a line fragment (segment)    
o Exact - if this is selected, bolts will be displayed with all shape details  

• Under Weld display: 
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o Simplified - line - if this is selected, welds will be displayed as a line fragment 
(segment)  

o Full body - if this is selected, welds will be displayed with shape details displayed 
• Under Mark: 

o Show marks - use this to switch on/off the display of a weld mark. A mark shape 
also determines a weld type (see the drawing below which presents marks of 
several weld types).An extension line on which a weld mark is positioned is 
always perpendicular to the weld. 

 

  
 

o Size - define the size of a weld mark  
o Relative to the screen - if this is selected, the size is expressed as a percentage 
o In absolute drawing units - if this is selected, the size is expressed in units used in 

AutoCAD® 
Indicating a weld mark results in selecting a weld in a drawing.  

3. OBJECT INSPECTOR 

3.1. Description of Object Inspector 
The Object Inspector is a tool that manages elements (objects) included in a project created in 
AutoCAD® Structural Detailing. By standard, the Inspector dialog displays in the program 
window, next to the graphical model definition field.  
Important tasks carried out by the Object Inspector include:  
• Presenting the project contents in the appropriate order (sequence).  
• Selecting elements subjected to actions of a selected command.  
• Presenting and modifying project element properties (these may be single elements or 

whole objects). 
• Activating the commands applied to a particular selection (it depends on the inspector 

mode).  
• Defining, verifying and modifying groups.  
• Verifying and modifying positions.  
• Filtering model elements (objects).  
• Creating and managing drawing documentation of a project.  

 

3.2. Object Inspector 
The Object Inspector dialog is located to the left of the graphical model definition. The width 
of the dialog is adjustable to allow as much space as possible for the area of graphical model 
definition.  
The Object Inspector dialog (shown below) is divided into three parts:  
• Options that enable filtering model elements.  
• Six tabs containing lists (set) of project elements depending on the stage of the design 

process (modeling / positions / printouts). 
• A table presenting properties of selected objects.  
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At the top of the dialog there are options for filtering the number of elements displayed on the 
tabs. Filters enable the user to decrease the number of model elements shown in the 
graphical editor viewer.   
The selection list contains the list of filters defined by the user in the current project.  

Open the filter by clicking . 
The filter list (defined in the Filter definition dialog) contains three default filters (which cannot 
be deleted):  
• All objects - cancels any filter and displays all objects defined in the current project on the 

list.  
• Current selection - an element list is limited to the elements that are currently selected in 

a model presented in the field of graphical model definition. 
• Hide current selection - hides elements currently selected in a model presented in the 

field of graphical model definition (if there are no objects selected, then none of them can 
be hidden).  

Click the Apply button to activate the filter. All objects defined by the filter are displayed on the 
list (even if they do not satisfy a filtering condition) until the next filtering operation.  
Once the Filter definition dialog is closed, the list of filters defined is available in the Object 
Inspector dialog.  
If the Use filtering on screen option is selected, the model graphical editor will display only the 
elements that are shown on the list in the Inspector dialog.  
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The dialog also includes the following tabs:   
• Model   
• Parts edition   
• Positions  
• Printouts  
• Templates 
• Structural Detailing Center. 

The current list of objects defined in the project in AutoCAD® Structural Detailing – Steel 
display on successive tabs. Each of the tabs presents elements in different stages of a design 
process; therefore, each comprises different types of objects organized in a slightly different 
manner.  
 
The bottom part of the dialog contains a table that displays properties of elements selected 
from the list. Table characteristics include:  
• If one of the elements is selected, then the table presents all properties of a selected 

element   
• If several objects of the same type are selected, then the table presents all the fields with 

properties relevant to the selected element type, however, only the values that are 
common for all the elements are presented; the remaining fields are empty (yet they may 
be changed)  

• If several objects of different types are selected, the table presents only the fields with 
properties that are common for all object types.  

 
The first table column displays the name of a property (information), while the second table 
displays its current value.  
The table with object properties designed to present these object properties that are important 
from the engineering viewpoint. It usually shows only basic information (properties). Not all the 
pieces of information displayed in the table can be changed.  
 
See also: 
Object list  
 

3.3. Model 
Use this tab of the Object Inspector dialog to manage  elements of a project model.  
 

 
 
The following model objects defined in a structure are available on this tab:   
• Profiles  
• Plates  
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• Subparts  
• User parts 
• Connections  
• Groups  
• Workframes.  

 
The following icons are located on the dialog box. The object types are presented on a list or 
may be excluded from presentation of objects. 

  - Profiles  

  - Plates  

  - Subparts (plates) 

  - Subparts (profiles)  

  - User parts 

  - Connections 

  - Groups  

  - Workframes.  
 

 NOTE: 
The listed types of objects are filtered while being presented/hidden; the currently selected 
filter is applied. 
 
When elements are selected from the list, they are highlighted in the graphical editor (the 
selection operation is interactive, all the elements chosen in the Inspector dialog are 
highlighted in the graphic editor: if an element is selected in the graphic editor, then the 
selection is also presented in the Inspector dialog).  
An object list may be sorted by applying one of the following two methods: 
• Double-clicking the table column header (the list can be sorted in ascending or 

descending order)  
• Right-clicking the appropriate option in the context menu.  

 

 NOTE: 
Sorting is always carried out separately for each element type.  
 
The context menu (accessed by right-clicking the Model tab), includes several options used to 
perform operations on selected objects:  
• Select all - select this command to select all elements presented on the list  
• Deselect all – select this command to cancel the selection of all elements on the list  
• Remove – select this command to remove selected elements from a project  
• Zoom selection – select this command to zoom-in on the selected elements in a structure 

view.   
• Modify properties  - select this command to open the properties dialog (the dialog 

contents depend on a selected object type); this command is available only when 
selected elements are of the same type  

• Group - select this command to create a group that consists of selected elements; this 
command is available when several elements are selected  

• Add to group - select this command to add a selected element to an existing group  
• Remove from group - select this command to remove an indicated element from a 

selected group  
• Change main part of group - select this command to change the main part (main 

element) in a group; it is necessary to indicate an element that should be the main part of 
the group  
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• Ungroup - select this command to split the group into single elements (objects); this 
command is available only when a group (or several groups) has been selected on the 
list   

• Assign position - select this command to assign a position to selected elements; when 
this command is activated, the Manual Positioning dialog opens 

• Remove position - select this command to remove positions from selected elements 
• Auto positioning - select this command to assign positions to selected elements; the 

Automatic positioning dialog displays.    
 

3.4. Parts edition 
This table presents edit operations performed on an element (e.g. cuttings, drills) as well as 
the contents of assemblies and groups. An element (or several elements) currently selected is 
presented in the form of a tree.  
 

  
 
NOTE: The list of filter selections and the buttons allowing filter definitions are inaccessible on 
this tab. The Current selection filter is adopted by default.  
Once the Apply button is clicked, selected objects are shown on the list. If a group is selected, 
then the group structure is displayed. If a single element is selected, then edit operations 
carried out on this element are presented.  
The manner of presentation are changed by applying the following context menu options: 
Show hierarchy of: Groups or Connections.  
The following object types can be presented in the tree:   
• Groups  
• Connections  
• Profiles  
• Plates  
• Subparts  
• Drills  
• Connectors (bolts, welds) 
• Cuttings (fits) 
• Notches.  

 
The object types are presented on a list or excluded from the presented objects; the following 
icons located in the dialog serve this purpose: 

 - drills   
 - cuttings (fits)  

 - bent profiles  

 ,  - connectors (welds, bolts).  
All the listed icons are selected by default.  
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When elements are selected from the list, they are highlighted in the graphical editor (the 
selection operation is interactive, all the elements chosen in the Inspector dialog are 
highlighted in the graphic editor: if an element is selected in the graphic editor, then the 
selection is also presented in the Inspector dialog).  
 
The hierarchy applied to present individual elements is illustrated in the figure below. There is 
a separate hierarchy for each connection.  
 

  
 
The context menu (accessed by right-clicking the Parts Edition tab), includes several options 
used to perform operations on selected elements:  
• Remove – select this command to remove selected elements from a project  
• Zoom selection – select this command to zoom-in on the selected elements in a structure 

view.   
• Modify properties - select this command to open the properties dialog (the dialog 

contents depend on a selected object type); this command is available only when one 
element is selected on the list 

• Assign position - select this command to assign positions to selected elements; activating 
this command opens the Manual Positioning dialog. 

• Remove position – select this command to remove positions from selected elements. 
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3.5. Positions 
This tab presents a list of defined positions; the list is sorted by prefixes and numbers.  
 

  
 
The position types shown below are  presented on the list or may be excluded from 
presentation; the following icons, located in dialog, are used for this purpose: 

  - Profiles  

  - Plates  

  - Assemblies  

  - Groups 

  - User parts 

 - Schemes.  
Below are three selection options (Parts, Families, Groups) used to activate a mode of 
presentation (sorting) of positions.  
With the Parts option selected  
In this mode elements are shown in one level, grouped by position types in the order as 
follows (the first order criterion for individual parts is a prefix, the next one is a number), in the 
alphabetical order of position designations :  
1. Profiles  
2. Plates  
3. Assemblies  
4. Groups  
5. User parts  
6. Schemes  
 
With the Families option selected   
In this mode elements are presented in the form of a tree with the following levels: 
1. Position type; the order of the items: assemblies, profiles, plates, user parts 
2. Family (in the alphabetical order) 
3. Within a family positions are presented in the alphabetical order of designations 

 © 2010 Autodesk, Inc. All rights reserved          



AutoCAD Structural Detailing - Steel - User Guide  page: 43 

 
With the Groups option selected   
This mode offers multi-level presentation of elements; it is reflected in this mode which parts 
are assigned to which assemblies and groups. Positions are presented in the form of a tree 
with the following levels:  
1. Position types; the order of the items: groups, assemblies, profiles, plates, user parts, 
schemes 
For the types Groups and Assemblies successive sub-levels are created:  
for groups: elements included in a given group 
for assemblies: single parts included in a given assembly. 
 
This tab presents a list of all user-defined positions; the structure of positions and documents 
is shown in a form of a tree (see the drawing below).  
 

  
 
The icon of a document included on the list is presented as follows:  
•   in yellow - the document is active on the edition layout  
•   as a red slash - the element of a structure model for which the document has 

been prepared, has changed 
•   in gray - the document has been exported to a separate dwg file.  

If the icon of a view provided on the list is shown in bold, it is an active view.  
 
The context menu (accessed by right-clicking the Positions tab), includes several options used 
to perform operations on selected positions:  
• Delete - select this command to remove the selected positions from a project  
• Select positions – use this command to select all positions  
• Attach document - use this command to select a printout template; the template is saved 

on the Templates tab  
• Update documents - select this command to update the documents available for a 

position   
• Delete documents - select this command to delete documents available for a position  
• Automatic drawings - select this command to automatically generate drawings for a 

selected position; after running this command, the Automatic drawing generation 
dialog displays.   

 

3.6. Printouts 
This tab enables management of printouts in AutoCAD® Structural Detailing; it presents the 
list of all printouts defined in the AutoCAD® Structural Detailing project.   
Printouts are presented together with a set of views. The printout list contains all the printouts, 
even those which do not include any views. The structure of user-defined printouts and views 
is shown in a form of a tree. Due to logical reasons, views are placed in a printout, however, 
the tree also includes an intermediate level, so that it is obvious to which document given 
views belong. If the printout layout is active, then the icon of a printout corresponding to the 
active printout layout displays in red. 
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When printouts provided on the list are selected, only elements of one printout may be 
selected at a time - it is impossible to select elements of two different printouts. Selection of 
the printout in the dialog is synchronized with the graphic editor - an appropriate drawing 
displays.    
The top part of the dialog contains two icons that enable presentation of the existing positions 
in the tree in the following modes: 

-  model mode  

-  drawing mode.  
 
The context menu (accessed by right-clicking the Printouts tab), includes several options used 
to perform operations on selected printouts:  
 
• Delete - select this command to remove selected printouts from a project  
• Change name - choose this command to change the name of a highlighted printout (the 

name is entered to the command line)  
• Add printout - select this command to add an empty printout to the project (the name is 

entered to the command line)    
• Activate - select this command to activate a selected printout 
• Unload printout – select this command, to make a selected printout no longer active 
• Save printout - select this command to save a selected printout in a *.DWG format file  
• Update - select this command to update a selected printout after making modifications in 

positions  
• Update all printouts - select this command to update all printouts after making 

modifications in positions. 
 

3.7. Templates 
This tab enables management of printout templates in AutoCAD® Structural Detailing; it 
presents the list of all printout templates defined in the AutoCAD® Structural Detailing 
project; the template structure is presented in a form of a tree. The icon of an active template 
(in the template layout) displays  in yellow. 
The context menu (accessed by right-clicking the Templates tab), includes several options 
used to perform operations on selected templates:  
• Delete - select this command to remove selected templates from a project  
• Change name – choose this command to change the name of a highlighted template (the 

name is entered to the command line)  
• Activate - choose this command to activate the highlighted template  
• Add view  - select this command to add a view to an existing template  
• Change style - choose this command to change the style in a selected template  
• Add document template - select this command to add a template to a selected view.  
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3.8. Structural Detailing Center 
This tab enables copying settings (styles) between user’s projects.   
 

  
 
After clicking File and selecting a file with an earlier-saved project, the Inspector dialog 
displays all the styles defined in the selected project, which may be used in the current project.    
After highlighting a selected style, right-click the Copy command;  the selected style is 
available in the current project.   
 

3.9. Add template 
The dialog is used to define a printout template for drawings of positions. There are three 
ways to access this option from:  
• Menu: Steel / Edit Drawings / Drawing Template Designer  
• Ribbon: ASD - Drawings / Generate Drawings / Drawing Template Designer 

• Toolbar: Edit Drawings / Drawing Template Designer  
• Command line: RBCS_ADDTEMPLATE. 
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The following dialog displays: 
 

  
 
The dialog defines a template for created drawings. For steel, select one of the allowable 
document types concerned with the position type: assembly, disposition scheme, group, single 
part, single plate or single profile.  
After providing the name of a template and clicking  OK, the template is added to the list of 
available templates located on the Templates tab.  
 
In the bottom of the dialog, the following tabs are included:  

• Description (this tab presents description of a selected position type), 
• Dimension style (this tab presents available dimension styles for a selected position 

type).     
 

3.10. Add view 
Once the template name and type are specified, you define views included in a given 
template. The Add viewport dialog is available after right-clicking the Add view option on the 
Templates tab in the Object inspector dialog.  
The following dialog displays:  
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To place a single view: 

1. Name of a created view (a name of the currently-applied template is specified)  
2. Select a view (projection) of a structure element  
3. Specify the scale for a selected view.  

 
After clicking OK within the template layout,  the placement of a view in a template (not yet in 
a final drawing) should be indicated.  
Repeat these steps to place successive views in a template.  
 

3.11. Select template 
Once a position is defined, you  select a drawing template for it. The Select template dialog is 
available after right-clicking the Attach document option on the Positions tab in the Object 
inspector dialog.   
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The following dialog displays:  
 

  
 
In the dialog, choose a template to be applied for generating a drawing from the list of 
available (defined) templates. Click OK to assign the template to a selected position.  
After selecting the Add to current Printout option (context menu on the Positions tab), a 
created  document is placed in a final drawing (on the Layout tab).  
 

3.12. Templates/views - steps to be followed while 
creating a printout 

To make a final drawing (in the case of steel structure elements):  
 

1. Define a template: 
• In the Add template dialog, specify the name and select the type of structure element 

(single part).  
• Determine views (projections) that are to be included in a template  

2. In the Positioning (manual or automatic) dialog, define positions for structure elements.   
3. In the Select template dialog, assign a template to a selected position. 
4. Place documents in a final drawing (printout).  
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3.13. Definition of filters 
You define filters in the Filter definition dialog.  Access the dialog by clicking   , in the 
Object inspector dialog. The following dialog displays:  
 

  
 
Filter definition are based on types of model elements and their properties. A defined filter is 
identified by a name displayed on the filter selection list located in the Object Inspector dialog.  
The Filter definition dialog allows you to define a new filter or modify an existing filter (except 
for the two default filters). User-defined filters are deleted from the list by clicking the Delete 
button.   
The top part of the dialog contains the list of all the filters defined by the user in a project. A 
selected (highlighted) filter is an active filter (i.e. a filter selected when the dialog was opened).  
The bottom part of the dialog includes the field for defining the selected filter. The steps taken 
while defining and modifying a filter are similar.  
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To define a new filter: 
1. Click the New button in the top part of the dialog. The New filter name dialog 

displays. 
2. Enter a name for the filter in the edit field.  

Note: If the Inherit definition option is on, then a new filter will inherit a definition from 
the recently-selected filter (which means that the expression of the recently-selected 
filter will be entered on the list located in the bottom part of the Filter definition 
dialog); if the Inherit definition option is off, then a new filter will be created without 
any definition of expression (the list located in the bottom part of the Filter definition 
dialog box will be empty).  

3. Close the New filter name dialog, the defined filter displays on the list contained in 
the Filter definition dialog box.  

After providing a filter name, the user may determine the expression defining a filter.  
From the Type drop-down list, select a type of element that is to be included in the defined 
filter. The contents of the Properties list (see also List of available elements, properties and 
values) will change depending on the element type selected.  
Select a filtering criterion from the Properties list. Criterion depends on the selected element 
type.  
Depending on the selected type of property, determine the list of selected property values in 
the Value edit field. This field allows entering values that appear in the expression defining a 
filter.  
If the Properties and Value field are left blank, all the elements of the selected type (all values) 
will be included in the filter defined.   
For some of the properties (e.g. length), define a range of values in the Value field; the 
following syntax is applied:  
• Single values separated with a semicolon e.g. 1; 2; 3; 10; - only the elements listed will 

be included in a filter.  
• Range of values defined as follows: 1-100.  
• Values greater than and less than: -100; 10-; (respectively).  

 
Apart from definition of values, it is also possible to define graphically the elements that are 
included in a filter; once the Selection option is selected. Once the Select objects button 
becomes accessible; clicking this button closes the dialog, whereas the cursor is in the 
selection mode. Right-click the structure elements (or click the ENTER key) to display the 
elements in the dialog.  
To include an expression or selection in a filter, it is necessary to use one of the buttons 
shown below:  

•  - Clicking this button replaces all the expressions defined by the expression 
currently determined.  

•  - Clicking this button adds the current expression to expressions already defined in 
a filter (the AND operator is added in front of the current expression).  

•  - Clicking this button adds the current expression to expressions already defined in 
a filter (the OR operator is added in front of the current expression).    

•  - Clicking this button adds the current expression to expressions already defined in 
a filter (the AND NOT operator is added in front of the current expression).  

All expressions added to a defined/modified filter are displayed in the bottom part of the dialog 
with appropriate operators. Each expression is entered into a separate line; lines are 
separated with logical operators referring to expressions below.   
You cannot modify the contents of a single expression in a filter; however, it is possible to 
delete lines from definitions of expressions in a filter. Delete lines by right-clicking on one of 
the following commands within the bottom part of the Filter definition dialog. 
• Delete line - once this command is selected, a highlighted line is deleted.   
• Delete all - once this command is selected, a whole filter definition is deleted.  
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Each of the filters can be modified at any moment while working in a project. The list of filters 
defined can be seen in the top part of the Filter definition dialog. A filter defined in the project 
is deleted from the list of available filters by highlighting a line with a filter name and clicking 
Delete. The order of filters defined in a project can be changed on the filter list by applying the 
buttons: Move up or Move down. The highlighted filter is moved one position up or down on 
the list of defined filters.  
 

3.14. How to define a filter 
Example of how to define a filter allowing a selection of columns made of RSJ 102 x 102 x 
23.07 and RSJ 76 x 76 x 12.65 sections:  
• Click the New button; in the New filter name dialog, enter the name of a defined filter.  
• Close the New filter name dialog (the Inherit definition option is switched off); a new filter 

displays in the Filter definition dialog.  
• Select Section as Type, Section type as Properties; on the Values list select lines with 

sections RSJ 76 x 76 x 12.65 and RSJ 102 x 102 x 23.07 (the lines are highlighted).  
• Add an expression by pressing the  button; the following expression displays: 

Sections (type) = RSJ 76 x 76 x 12.65; RSJ 102 x 102 x 23.07. 
• Select Section as Type; Family as Properties; on the Values list select the Column 

family.  
• Add an expression by pressing the AND button; the following expression displays: 

Sections (type) = RSJ 76 x 76 x 12.65; RSJ 102 x 102 x 23.07 and Sections (family) = 
Column.  

 
The operation above completes the filter definition.  
 

3.15. Objects and their properties 
The Object Inspector includes:   
Model elements (physical elements)  
• Profiles 
• Plates (single plates) 
• User parts   
• Subparts (such as plates, profiles, ribs, shear plates) 
• Welds  
• Bolts  
• Connections 
• Groups 
• Assemblies – a set of parts (profiles or plates) grouped automatically based on the 

connectors with the ‘workshop’ attribute existing between them; in practice, these are 
elements sent as a whole from a workshop to a construction site   

• Workframes.  
 
Model elements (nonphysical elements)  
• Drills  
• Openings  
• Cuttings/fits  
• Notches.   

 
Drawing elements  
• Positions 
• Documents (sets of views)   
• Views  
• Printouts.  
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Below, the table of available elements, properties and values display.  
 
Objects Properties  Values  
 All properties for 

objects  
Values appropriate for object properties  

   
Profiles   
 Profile type Profiles available in the current project  
 Family Families intended for the "profiles" type available in 

the current project 
 Material Materials set in preferences 
 Length  Real positive value  
 Position prefix Position prefixes used in the current project 
 Position number Integral positive number 
 Subpart Yes / No depending on that whether a selected 

profile is a subpart 
   
Plates   
 Plate thickness Thickness of a project or any real positive value  
 Family Families available in the current project intended for 

the "plate" type  
 Material Materials set in preferences 
 Type Rectangular, circular, user-defined  
 Position prefix Position prefixes used in the current project 
 Position number Integral positive number 
 Subpart Yes / No depending on that whether a selected 

plate is a subpart 
   
Subparts   
  Properties as for a profile or plate depending on the 

subpart type  
   
Connections   
 Connection type  Available connection types: (e.g. endplate)  
   
Groups Name Text 
 Position prefix Position prefixes used in the current project  
 Position number  Integral positive number  
 Subpart Yes / No depending on that whether a selected 

profile is a subpart 
   
Workframes Workframe name Workframe names available in the current project  
 Workframe type  Box, wedge, prism  
   
Positions  Prefix  Position prefixes used in a project  
 Number Position numbers defined in the edit field  
 Level of 

positioning 
Single part, assembly, group 

   
Printouts  Number Numbers defined in the edit field  
 Name Drawing names available in the current project  
 Format Formats used in the current project  
 Positions Positions defined in the current project  
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4. TYPICAL STRUCTURES 

4.1. Typical structures 
Use this option to define typical (parametric) structures. 
 
To begin defining typical structures, go to:  
• Menu: Steel / Parametric structures 
• Ribbon: ASD - Model / Parametric structures 
• Toolbar: Parametric structures. 

 
Typical structures available in the current version of AutoCAD® Structural Detailing: 
 
Parametric structures (Steel menu > Parametric structures), ribbon (ASD - Model > Parametric 
Structures) or Parametric structures toolbar 
• Multi-bay frame  
• Roof truss  
• Stairs  
• Stairs spiral  
• Staircase  
• Bracing  
• Ladder  
• Railing  
• Cage  
• Brace  
• Grate spreading  
• Purlin spreading .    

 
Plate girders (Steel menu > Plate girders, ASD - Model > Elements ribbon or Plate girder; 
General toolbar) 
• Castellated beam  
• Column (plate girder)  
• Beam (plate girder)  
• Multisegment beam (plate girder) . 

 
After you select a structure, an additional dialog displays in which you can define parameters 
of a selected steel structure. The contents of this dialog depend on a selected structure type or 
tructure element.  s

 
See also: 
Description of the macros for generation of steel structure elements  
Description of the macros for generation of connections of steel structure elements  
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5. WORKFRAME 

5.1. Workframe 
Use this option to determine a workframe that facilitates definition of a structure model in 3D 
space. 
 
To begin working with workframes, open the Workframe dialog from:  

• Menu:  Steel / Workframes / Create workframe 
• Ribbon: ASD - Model / Elements / Workframes 

• Toolbar: General / Workframes  
• Command line: RBCS_WF. 

 

 
 
The Workframe dialog has 3 main parts:  

• On the left, define basic information for a workframe 
o Name  
o Type 

 box  
 wedge  
 prism  

• Use the options at the  bottom of the dialog:  
o Surface only - if this is selected, only external lines of a workframe are created. If 

this is not selected, all workframe lines are created. 
o Left diagonal - if this is selected, additional lines (diagonals of a quadrangle area 

inclined to the left) are also created. 
o Right diagonal - if this is selected, additional lines (diagonals of a quadrangle area 

inclined to the right) are also created.  
o Without description - if this is selected, descriptions of axes are not provided. If 

this is not selected, workframe axes will be described. 
o Show axes in drawings - if this is selected, axes of a defined workframe are 

displayed in drawings. If this is not selected, workframe axes play only an auxiliary 
role in modeling and are not shown in any drawing. 

• Select a tab at the middle of the dialog - Size/Division or Axis descriptions; their 
contents depend on a selected type of a workframe. 

• Use the icons on the right 
  - creates a workframe based on parameters determined in the dialog. 
  - is used to adopt (inherit) parameters from a workframe that is already defined.  
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When the Workframe dialog displays, it displays the workframe type most recently defined and 
the associated parameters.   
 
See also: 
Example of definition of a workframe  
 

5.2. Box 
After you select Box as a workframe type, the Workframe dialog contains 2 tabs: Size/Division 
and Axis descriptions.  
 

 
 
Options on the Size/Division tab:   

• Width (X) – define the width of a workframe, and the number of divisions along the 
workframe width  

• Length (Y) - define the length of a workframe, and the number of divisions along the 
workframe length  

• Height (Z) - define the height of a workframe, and the number of divisions along the 
workframe height  

If the Non-uniform option next to the options is not selected, a workframe will be generated 
automatically based on the parameter values defined in the edit fields. If Non-uniform is 
selected, the edit fields become inaccessible. The (…) button becomes available; click it to 
open the Lines distribution dialog where you can define the position of successive workframe 
axes.  
 

 
 
Options on the Axis descriptions tab: 

• Width (X) - define an axis description along the workframe width. If this is selected, the 
description will be generated; if it is not selected, the axis description will not be 
generated. 

• Length (Y) - define an axis description along the workframe length. If this is selected, 
the description will be generated; if it is not selected, the axis description will not be 
generated. 

• Height (Z) - define an axis description along the workframe height. If this is selected, 
the description will be generated; if it is not selected, the axis description will not be 
generated.  
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For each of the options, there are 3 fields: 
• Prefix - define a prefix of workframe axes for the automatic description of workframe 

axes  
• Start value - define a start value for workframe axes for the automatic description of 

workframe axes   
• Step - define a value of increment for successive workframe axes for the automatic 

description of workframe axes 
For width (X) and length (Y), you can choose to locate the description on the right or on the left 
of a workframe line.   
If the User-defined option next to the options is not selected, a workframe description will be 
generated automatically based on the parameter values defined in the edit fields. If User-
defined is selected for any of the options, the edit fields for that option become inaccessible. 
The (…) button becomes available; click it to open the Lines description dialog where you can 
define the description of successive workframe axes. 
 

5.3. Wedge 
After you select Wedge as a workframe type, the Workframe dialog contains 2 tabs: 
Size/Division and Axis descriptions.  
 

 
 
Options on the Size/Division tab: 

• Width (X) – define the width of a workframe, and the number of divisions along the 
workframe width  

• Length (Y) - define the length of a workframe, and the number of divisions along the 
workframe length  

• Height (Z) - define the height of a workframe, and the number of divisions along the 
workframe height  

• Vertex – define a coordinate of the vertex position 
If the Non-uniform option next to the options is not selected, a workframe will be generated 
automatically based on the parameter values defined in the edit fields. If Non-uniform is 
selected, the edit fields become inaccessible. The (…) button becomes available; click it to 
open the Lines distribution dialog where you can define the position of successive workframe 
axes.  
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Options on the Axis descriptions tab: 

• Width (X) - define an axis description along the workframe width. If this is selected, the 
description will be generated; if it is not selected, the axis description will not be 
generated. 

• Length (Y) - define an axis description along the workframe length. If this is selected, 
the description will be generated; if it is not selected, the axis description will not be 
generated. 

• Height (Z) - define an axis description along the workframe height. If this is selected, 
the description will be generated; if it is not selected, the axis description will not be 
generated.  

For each of the options, there are 3 fields: 
• Prefix - define a prefix of workframe axes for the automatic description of workframe 

axes  
• Start value - define a start value for workframe axes for the automatic description of 

workframe axes   
• Step - define a value of increment for successive workframe axes for the automatic 

description of workframe axes 
For width (X) and length (Y), you can choose to locate the description on the right or on the left 
of a workframe line.   
If the User-defined option next to the options is not selected, a workframe description will be 
generated automatically based on the parameter values defined in the edit fields. If User-
defined is selected for any of the options, the edit fields for that option become inaccessible. 
The (…) button becomes available; click it to open the Lines description dialog where you can 
define the description of successive workframe axes. 

5.4. Prism 
After you select Prism as a workframe type, the Workframe dialog contains 2 tabs: 
Size/Division and Axis descriptions.  
 

 
 
Options on the Size/Division tab: 

• Base radius - define a radius of the circle circumscribed on the prism base, and the 
number of radial divisions  

• Top radius - define a radius of the circle circumscribed on the prism top  
• Height - define the height of a workframe, and the number of divisions along the 

workframe height 
If the Non-uniform option next to Height is not selected, a workframe will be generated 
automatically based on the parameter values defined in the edit fields. If Non-uniform is 
selected, the edit fields become inaccessible. The (…) button becomes available; click it to 
open the Lines distribution dialog where you can define the position of successive workframe 
axes.  
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Options on the Axis descriptions tab: 

• Radius - define an axis description along the workframe radius. If this is selected, the 
description will be generated; if it is not selected, the axis description will not be 
generated. 

• Width - not available   
• Height - define an axis description along the workframe height. If this is selected, the 

description will be generated; if it is not selected, the axis description will not be 
generated.  

For each of the options, there are 3 fields: 
• Prefix - define a prefix of workframe axes for the automatic description of workframe 

axes  
• Start value - define a start value for workframe axes for the automatic description of 

workframe axes   
• Step - define a value of increment for successive workframe axes for the automatic 

description of workframe axes 
If the User-defined option next to the options is not selected, a workframe description will be 
generated automatically based on the parameter values defined in the edit fields. If User-
defined is selected for any of the options, the edit fields for that option become inaccessible. 
The (…) button becomes available; click it to open the Lines description dialog where you can 
define the description of successive workframe axes. 
  

5.5. Lines distribution 
If the Non-uniform option is selected for any of the options on the Size/Division tab of the 
Workframe dialog, the edit fields become inaccessible. Click the (…) button to open the Lines 
distribution dialog, which provides the table that lets you determine the position of the 
successive workframe axes.  
 
To define the position of workframe axes:  

1. Define spacing between successive workframe axes, or define the coordinate of the 
workframe axis (calculated from the workframe beginning). 

2. Perform the above operation for the successive workframe axes. 
3. Click OK.  

 

5.6. Lines description 
If the User-defined option is selected for any of the options on the Axis descriptions tab of the 
Workframe dialog, the edit fields become inaccessible. Click the (…) button to open the Lines 
description dialog, which provides the table that lets you determine descriptions of the 
successive workframe axes.  
 
To define descriptions of workframe axes:  

1. Define the description of the first axis.    
2. Move to the next table line and define the description of the second axis. 
3. For some descriptions (such as width - X and length - Y), select the location of the 

axis description, either on the right or on the left of the workframe line. 
4. Perform the above operation for the defined workframe axes. 
5. Click OK.  
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5.7. Example of definition of a workframe 
To start definition of a workframe, do as follows:  

1. Click the Workframes option . 
2. In the Workframe dialog:  

• For Name, enter Workframe - 3D Workshop. 
• For workframe type, select Box. 
• Verify that Surface only, Left diagonal, Right diagonal, and Without description are 

cleared. 
• Select Show axes in drawings. 

3. On the Size/Division tab, define workframe dimensions with respect to the system 
axes: 
• Width (X): 12000 / 2  
• Length (Y): 30000 / 6 
• Height (Z): select Non-uniform and click the (...) button. 
• In the Line distribution (length) dialog, in the Coordinate column, enter 5000, 7500, 

9000, and then click OK.  
4. On the Axis descriptions tab, select descriptions for all the dimensions, and choose 

the following descriptions for individual workframe axes:  
• Width (X): Prefix: wid_, Start value: A, Step: 1, left 
• Length (Y): Prefix: len_, Start value: 1, Step: 1, left 
• Height (Z): Prefix: pos_, Start value: 0, Step: 1 

5. Click Create  (located on the right of the Workframe dialog). 
6. Specify the workframe origin and determine the direction of the workframe X axis: 

direction of the X axis of the global coordinate system (NOTE: the direction of the X 
axis of the workframe does not need to be compatible with the X axis of the global 
coordinate system).   

 
The generated workframe is illustrated in the drawing below.   
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6. PROFILES 

6.1. Profiles 
Use this option to define a member with a selected profile. 
 
To begin working with profiles, open the Profile dialog from:  

• Menu: Steel / Profiles 
• Ribbon: ASD - Model / Elements / Profiles 

• Toolbar: General / Profiles   
• Command line: RBCS_PROFILE. 

 

 
 
The Profile dialog has 3 main parts:   

• On the left, you can specify basic information for a profile of a defined member:  
o Profile - select a profile for a defined member (the most recently defined member 

profile is displayed). Click the (…) button to open the Profile List dialog, in which 
profiles from the available databases may be added to the list of available profiles.  

o Material - select the type of a material assigned to a defined member 
o Family - select a family (group) of members to which a defined member will be 

assigned  
o Insertion point - define coordinates of the member shift (Dx and Dy offsets) and 

the rotation of a member profile about the member longitudinal axis (select a value 
from the list or enter one into the Rotation field). The offset denotes the shift of a 
profile center with respect to the insertion line  

• In the middle is a graphical field that displays a selected profile of a defined member 
positioned in relation to the insertion line (under the graphical field, characteristic 
distances of the profile fibers from the profile axis are displayed). You can define 
offsets graphically, by using the cursor to shift a profile with respect to the axis or by 
specifying characteristic points of a profile.  
You can also define relative offsets (with respect to values related to the cross-section 
and characteristic points of a profile). Location of section characteristic points (their 
number depends on the section type and shape) may be determined by specifying 
certain values connected directly with the cross-section (these do not have to be 
absolute values). Characteristic points include: 
o (0;0) center of gravity of a section  
o Points presented in the drawing below whose coordinates are determined by the 

values Vy, Vpy, Vz, Vpz, Mid (they define a relative location of a point in the cross 
section)   
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Profile characteristic points are marked in red in the dialog (in the drawing of a 
selected profile).  
After you click on a characteristic point of a profile, the profile is translated and the edit 
fields Dx and Dy in the Insertion point field are populated automatically.     
Under the schematic drawing, there is the More >> (or Less <<) button, which opens 
(closes) an additional field where you can specify: 
o a surface finishing type for a profile (for example, hot-dip galvanized, 

electrogalvanized, anticorrosive paint, fireproof coat). A default type of surface 
finishing can be selected in the Project preferences dialog on the Materials tab; 
this dialog also allows adding a new surface finishing type or deleting a selected 
type from the list of available surface finishing types. 

o profile properties (area, moments of inertia, and so on) – see the description of the 
Profile list dialog. After you right-click in this field, the context menu displays:  
 Select All – selects the contents of the edit field  
 Copy – copies the contents of the edit field to the Clipboard  
 Paste – pastes the Clipboard contents to the edit field   

The following icons are also available in this part of the dialog: 
 - blocks the position of axes in the graphical field and lets you shift a profile  

  - blocks the position of a profile in the graphical field and lets you shift profile axes   
• Use the icons on the right to define the profile insertion:  

 - 2 points  
 - line  
 - 1 point (a member will be defined as perpendicular to UCS)  
 Match properties - used to adopt (inherit) parameters from a defined member profile.  

 
When the Profile dialog displays, it displays the member profile parameters defined most 
recently.   
 
See also: Example of definition of a user-defined section  
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6.2. Bent profiles 
Use this option to define a bent bar of a selected profile. 
 
To begin defining a bent profile, open the Bent profile dialog from:  

• Menu: Steel / Bent profiles 
• Ribbon: ASD - Model / Elements / Bent profiles 

• Toolbar: General / Bent profiles  
• Command line: RBCS_BENT. 

 

  
 
The Bent profile dialog has 3 main parts:    

• On the left, you can specify basic information for the profile of a defined bar:  
o Profile - select a profile of a defined bar (the most recently defined bar profile 

displays). Click the (…) button to open the Profile List dialog, where profiles from 
the databases accessible in the software may be added to the list of available 
profiles. 

o Material - select the type of material assigned to a defined bar  
o Family - select a bar family (group), to which a defined bar will be assigned  
o Insertion point - define coordinates of the bar offset (Dx and Dy), and the rotation 

of the bar profile about the bar longitudinal axis (select a value from the list or 
enter a value in the Rotation field). The offset denotes translation of the profile 
center with respect to the insertion line. 

• In the middle is a graphical field that displays a selected profile of a defined bar 
positioned in relation to the insertion line (under the graphical field, characteristic 
distances of the profile fibers from the profile axis are displayed). You can define 
offsets graphically, by using the cursor to translate a profile with respect to the axis or 
by specifying characteristic points of a profile.   
Under the schematic drawing, there is the More >> (or Less <<) button, which opens 
(closes) an additional field where you can specify: 
o a surface finishing type for a profile (for example, hot-dip galvanized, 

electrogalvanized, anticorrosive paint, fireproof coat). A default type of surface 
finishing can be selected in the Project preferences dialog on the Materials tab; 
this dialog also allows adding a new surface finishing type or deleting a selected 
type from the list of available surface finishing types. 

o profile properties (area, moments of inertia, and so on) – see the description of the 
Profile List dialog. After you right-click in this field, the context menu displays:  
 Select All – selects the contents of the edit field  
 Copy – copies the contents of the edit field to the Clipboard  
 Paste – pastes the Clipboard contents to the edit field   

The following icons are also available in this part of the dialog: 
 - blocks the position of axes in the graphical field and lets you translate a profile  
 - blocks the position of a profile in the graphical field and lets you translate profile 

axes   
• Use the icons on the right to define the bar insertion:  
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 - 3 arc points 

 - arc: start, end, and radius  

 - polyline   

 - select object  
 Match properties - used to adopt (inherit) parameters from a defined bar profile.  

 
Below the icons is the Divide segments option - if this is not selected, a bent profile is 
defined as one object (despite that it may consist of several elements, such as a 
polyline composed of arc, segment, and arc). If this is selected, the bent profile is 
divided into separate objects when the type of profile parts changes (a polyline 
composed of arc, segment, and arc is divided into 3 separate parts: 2 arcs and a 
segment). The drawing below illustrates schematically how this option works.  

  
When the Bent profile dialog displays, it displays parameters of the most recently defined bar 
profile.    
 

6.3. Example of definition of a user-defined section 
The example below presents the definition of a section of a steel flat bar that may be used in 
definition of a structure model. To define a user-defined section (bar section):  

• Applying AutoCAD® options:  
o Draw a rectangle (Draw menu > Rectangle) with the dimensions 590x4050 (see the 

drawing below). 
o Select a region (Draw menu > Region) and indicate the rectangle drawn. 

  
• Applying AutoCAD® Structural Detailing - Steel options: 

o Click the User sections . 
o Specify the defined region (rectangle). 
o Select to save the section in the current project (the Locally option in the 

command line). 
o Specify a section name (4 letters and designations describing profile dimensions, 

such as FLAT 590x4050). 
o Define a profile shape code.  
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 NOTE: 
Section codes are adopted according to designations used in Robot; code descriptions are 
provided in Robot help.   
 
Thus-defined section of a profile will be added to the list of available profiles (in the Profile 
dialog, a part of which is shown in the drawing below). The section will be available only in the 
current project.   
 

  
 
If Database is selected, use the Saving section to database dialog to save a profile to a 
database: 

• Specify a name, a maximum of 4 letters (digits are not allowed). 
• Define dimensions of the profile (real numbers defining information about the profile) 

o If 1 dimension is given, specify Dimension 1 
o If 2 dimensions are given, specify Dimension 1 and Dimension 3 

 
See also: 
List of profile shape codes  
 

6.4. Profile list 
The Profile list dialog displays after you click the (…) button in the Profile dialog.  
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Using this dialog, you can add profiles from databases accessible in the program to the list of 
profiles available in AutoCAD® Structural Detailing - Steel. To add a profile to the list of 
available profiles: 

• Select a profile folder in the Database field, such as AISC (American Hot Rolled 
Shapes). 

• Select a profile type. 
• Select a profile in the left panel.   
• Click Add >.  

 
Clicking Add all >> results in adding all the profiles included in the left panel.  
Clicking < Remove deletes a selected profile from the list of available profiles. Clicking << 
Remove all results in deleting all the profiles provided on the list of available profiles (in the 
right panel) except for the profiles that have been used in the project.   
The Remove option is unavailable for profiles that have already been applied in a project.   
The bottom right corner of the dialog contains the More >> (or Less <<) button, which opens 
an additional part of the dialog with information on basic section properties (dimensions of the 
cross-section, area, moments of inertia, section modulus for calculation of torsion stresses, 
elastic section moduli (bending), mass). This additional part of the dialog is closed when you 
click Less >>.  
 

7. PLATES 

7.1. Plates 
Use this option to define a plate. 
 
To begin defining a plate, open the Plate dialog from:  

• Menu: Steel / Plates 
• Ribbon: ASD - Model / Elements / Plates  

• Toolbar: General / Plates  
• Command line: RBCS_PLATE. 

 

 
 
The Plate dialog has 3 main parts:  

• On the left, you can specify basic information for a defined plate:  
o Plate thickness - select a value of plate thickness from the values on the list or 

enter a value into the edit field   
o Material - select the type of material assigned to a defined plate  
o Family - select a family (group) of plates to which a defined plate will be assigned   

Use the icons to define the plate shape: 
 - rectangular plate   
 - circular plate  
 - user-defined plate shape (a closed polyline)  
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o Insertion plane - define the plane of plate insertion as upper, lower, middle, or 
free. You can also specify an offset value denoting the distance to the insertion 
plane relative to UCS  

• In the middle is a graphical field that displays a defined plate positioned in relation to 
the insertion point. You can define offsets graphically, by using the cursor to shift the 
plate with respect to the point or by entering dimension values in the edit fields (not 
available for user-defined shape).  
o Circular plate - radius (R) and offset (Dr) that determines the distance of the 

insertion point from the center of a circular plate  
o Rectangular plate - width and length (W and L) of the sides and offsets (Dx and 

Dy) that determine distances between the insertion point and center of a 
rectangular plate  

Under the schematic drawing, there is the More >> (or Less <<) button, which opens 
(closes) an additional field where a surface finishing type for a plate (for example, hot-
dip galvanized, electrogalvanized, anticorrosive paint, fireproof coat) can be selected. 
A default type of surface finishing can be selected in the Project preferences dialog on 
the Materials tab; this dialog also allows adding a new surface finishing type or 
deleting a selected type from the list of available surface finishing types. 

• Use the icons on the right to define the plate insertion: 
 - point  
 - polyline  
 – Pick contour –available for user-defined plates  
 – Pick internal point - available for user-defined plates  
 Match properties - used to adopt (inherit) parameters from a defined plate  

 
When the Plate dialog displays, it displays the plate parameters defined most recently.   
 

7.2. Plate definition 
To define a plate: 

1. Select the plate shape type (rectangular, circular, or user-defined). 
2. Define plate dimensions (number of dimensions depends on selected plate shape). 
3. Define plate thickness. 
4. Specify the plate material.  
5. Determine a family to which a plate will belong. 
6. If needed, select a surface finishing type (after you click More >>). 
7. Determine a plane of plate insertion and a desired offset value, denoting the distance 

to the insertion plane relative to UCS.  
 
After you have defined the plate, specify its method of insertion:  
 

  Specify the insertion point and direction  
 Define a polyline, rectangle, or circle depending on the selected type of plate   
  Select an existing contour (polyline) - available for user-defined plates  
  Specify an internal point of the existing contour (polyline) - available for user-defined 

plates  
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8. USER PARTS 

8.1. User parts 
Use this option to define user parts (non-standard structure elements, such as prefabricated 
elements, user-defined elements, and so on). User parts have properties of a standard 
element (weight, position symbol, and so on); these parts are presented in documentation. 
To begin defining user parts, open the User parts dialog from:    

• Menu: Steel / User parts 
• Ribbon: ASD - Model / Elements / User parts 

• Toolbar: General / User parts  
• Command line: RBCS_USERPART. 

 

  
 
Objects that are user parts are defined in the model layout, and are displayed on printouts. 
Their display on printouts is determined by blocks linked with user parts. Blocks may consist of 
any AutoCAD® objects.   
 
User parts are saved to databases which, in turn, are grouped into categories (one category 
may include any number of databases). Databases are separate XML format files, and each 
database has a description displayed in the dialog. You can add categories and add 
databases in selected categories.   
 

 NOTE: 
A database may belong only to one category.   
 
User parts that belong to one or several databases may be linked with the same blocks. A 
block must exist and be saved on the hard disk. User parts included in databases are linked 
with blocks (DWG format files), which determine the way they are displayed (symbol) in a 
model and on printouts.  
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User parts belong to families, which determine their properties such as color, layer, and so on. 
User parts may be assigned positions, but the software does not check geometry of user parts 
during positioning. The criteria for identification of user parts are name, category, and 
properties saved in the database.    
A user part weight defined in the User parts dialog is taken into account while calculating the 
weight of a selected structure part and the center of gravity of a structure.  
 
For a chosen part, the block may be scaled independently in the directions of the local 
coordinate system of an object. Scale factors refer to the directions determined by the local 
coordinate system of a 3D block. The same scale factors are applied both to a 3D block in the 
model layout and to 2D blocks presenting user parts in drawings.  
 
After user parts are positioned, they can be drawn as single parts or be displayed in drawings 
of assemblies or groups. Drawings of user parts are generated automatically, considering the 
location and orientation (the local coordinate system) of a part defined in the model layout. In 
drawings, user parts are shown as blocks linked with them.   
 
The following drawing illustrates which scale factors are used for views and directions.    

  
User parts are displayed in drawings only in orthogonal projections.  
User parts shown in drawings of assemblies or groups may be displayed using the line type 
and the line color chosen in a dimensioning style.   
User parts cannot be dimensioned; descriptions for them are generated in the same way as 
for single parts (with the possibility to use variables).   
 
User parts defined in the model layout are modifiable, but not all parameters of user parts can 
be changed.   
It is possible to execute basic AutoCAD® edit commands (such as copying and translation) on 
user parts.    
User parts may be components of assemblies, groups, or schemes.  
 

 NOTE: 
It is not possible to perform the machining operations using the AutoCAD® Structural Detailing 
options on user parts.    
 
See also: 
Definition of a new user part  
User part database  
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8.2. User part database 
Using the User parts database dialog, you can perform operations in databases and 
categories. It also lets you view the contents of individual databases.    
The dialog displays when you click the (…) button in the User parts dialog.  
 

  
 
Perform basic operations:  
 
Add a new category 
 

  
 

After clicking Add new, you can specify the category name and the category description and 
file for the new category.   
 
Create a new database 
Lets you create a new database (file) in the default folder; the database will belong to a 
category chosen from the selection list.   
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In the dialog, specify a name and a description of the database. 
 

8.3. Definition of a new user part 
To define a new user part: 
 
Click the (…) button in the top part of the User parts dialog to add a new user part to the 
current database belonging to a selected category.   
 
A part may be added: 

• By blocks – using this option, you add an object by linking parts with blocks saved in 
external DWG files.    
After you click Define new, specify a part name in the Name field. Values in the 
remaining edit fields for the newly defined user part are inherited from the previous 
user part.   
In the central part of the dialog, specify access paths to external DWG files. The 
insertion point and the local coordinate system of an object are defined in DWG files. 
In the lower part of the dialog determine parameters of the user part (a weight, a scale 
and dimensions for individual directions). 

• By selection of parts – using this option, you add an object by indicating on the screen 
objects that will make up blocks linked to the user part.     
After you click Define new, the User parts dialog closes; specify a name of the user 
part in the command line. Next, the command line shows commands that enable: 
o Selection of objects that will make up the blocks linked with the 3D projection   
o Selection of objects that will make up the blocks linked with the projections: XY, 

XZ, and YZ 
For all objects, it is necessary to determine the base point and a point positioned on 
the positive side of the axis. Blocks for projections are saved in DWG files.   
After you have selected objects for the mentioned projections, the User parts dialog 
displays. Edit fields in the upper and central parts of the dialog are filled out with 
names given while defining the projections.  

In the lower part of the dialog, specify parameters of the user part (weight, scale, and 
dimensions for individual directions). By default, values of the weight and dimensions equal 0, 
whereas scale factor values equal 1.0. 
 
Insertion of a user part 
Click Insert to insert the selected user part into the model layout at a point you specify 
indicated.   
 
Saving of modifications 
Click Insert to accept changes made in the existing databases (the button is inactive until 
changes are made).   
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9. GRATES 

9.1. Grates 
Use this option to define grates.  
 
To begin defining a grate, open the Grates dialog from:  

• Menu: Steel > Grates 
• Ribbon: ASD - Model / Elements / Grates 

• Toolbar: General / Grates   
• Command line: RBCS_GRATE. 

 

  
 
The Grates dialog has 3 main parts:   

• On the left, you can specify basic information for a defined grate:  
o Type – specify a name of the defined grate 
o Material - select a material type assigned to the defined grate  
o Family - select a family (group) of grates to which the defined grate will be 

assigned  
o Self-weight – based on this value the program calculates a grate weight   
o Thickness – select a value of grate thickness or enter a value into the edit field  
o Level offset – a value of the distance between the grate insertion point and the 

bottom left corner of the grate; an offset equals 0, if the bottom left corner of the 
grate coincides with the grate insertion point   

• In the middle is a graphical field that displays the defined grate, and where you can 
specify a grate shape: 
o Rectangular – when this is selected, you can define side dimensions W and L 
o Polyline - any shape defined by means of a polyline 

You can define a load-carrying direction for the grate (an angle in the XY plane); the direction 
is displayed in the model layout and drawings using the symbol . The longer axis of the 
symbol is parallel to the load-carrying direction of the grate. The symbol of the load-carrying 
direction is displayed (in the same color and the same style as the grate edges) only in a top 
view and a 3D view of the grate in the plane parallel to the grate plane. The grate with its basic 
elements is illustrated below: 
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• Use the icon on the right to define the grate insertion: 
 - point (not available for a shape defined by polyline) 
 - polyline  
 - Pick contour – available for user-defined grates, but not available for rectangular 

grates 
 - Pick internal point - available for user-defined grates, but not available for 

rectangular    grates 
 Match properties –used to adopt parameters from a defined grate 

 
When the Grates dialog displays, it displays the grate parameters most recently defined.  
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10. MACHINING 

10.1. Fit to line 
Use this option to fit a profile to a defined line.  
To begin fitting a profile to a line, follow :  

• Menu: Steel / Machining / Fit to line 
• Ribbon: ASD - Model / Machining / Fit to line  

• Toolbar: Machining I / Fit to line  
• Command line: RBCS_FITTOLINE. 

 
The operation of fitting a profile may be performed using either a line defined using AutoCAD© 
tools or a line defined by specifying 2 points. You can fit several profiles positioned on the 
cutting line (see the drawing below).  
 
 

 
 
The Cut by line option operates in a similar manner to Fit to line. The direction is indicated by 
specifying a point on one side of the cutting line, and the operation determines the part of an 
object that remains after the cutting operation is performed. The difference between Fit to line 
and Cut by line is displayed below: the drawings show an object before performing the fitting 
and cutting operations (together with a defined line), and an object generated after performing 
the fitting and cutting operations.   
 
Cut by line 
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Fit to line 

 
 
 

10.2. Fit to polyline 
Use this option to fit an object to a defined broken line (polyline). 
To begin fitting an object to a polyline:  

• Menu: Steel / Machining / Fit to polyline 
• Ribbon: ASD - Model / Machining / Fit to polyline 

• Toolbar: Machining I / Fit to polyline  
• Command line: RBCS_FITTOPOLY. 

 
The plane of fitting (cutting off) consists of a few segments, as shown in the drawing below.   
 

 
 

10.3. Fit to object 
Use this option to fit 2 structural elements to each other. 
To begin fitting objects, open the Fit by object dialog from:  

• Menu: Steel / Machining / Fit to object 
• Ribbon: ASD - Model / Machining / Fit to object 

• Toolbar: Machining I / Fit to object  
• Command line: RBCS_FITOBJ. 

 
In the drawing area, select 2 structure elements that are to be fitted to each other: object that 
is being adjusted and object to which the first object should be adjusted. 
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Under Type of fitting, specify the mode of object fitting:  

• Passive – if this is selected, fitting of objects is not updated after each modification of 
the fitted object and the object to which it is being fitted.  

• Active - if this is selected, the software remembers the object to which the selected 
part is being fitted. Fitting of objects is updated after each modification of the fitted 
object and the object to which it is being fitted (after modifying a position of any of the 
objects, the parts will be automatically fitted, applying all the parameters defined in the 
dialog). If the object to which the selected part is being fitted is deleted, fitting of 
objects is deleted, as well. 

 

 NOTE: 
After the fitting of objects operation is completed, the mode of object fitting can be changed in 
the Properties dialog.   
 
Specify the type of object fitting: 

• External - one of the selected objects is fitted to the external contour of another object. 
• Internal - one of the selected objects is fitted to the internal contour of another object.  

For Internal, there are 4 options:  
 

 

Free - use this method to perform a quick fitting operation. 
In this case, determining parameter values is not required.  
If more exact parameter determination is required, apply 
one of the remaining methods.  
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1 Type - a distance value may vary for flanges and web of 
the element undergoing fitting.  
 

 

2 Type - for this type of fitting, you can switch on/off 
chamfering. An angle applied during the chamfering 
operation always equals 45 degrees.   
 

3 Type - using this type of fitting, you can adjust objects 
with additionally defined openings. Opening parameters 
include: position of the opening center, translations of the 
opening center position, and radius value. It is also 
possible to perform the chamfer operation on some 
elements of the parts that undergo fitting.   
 

 
In the bottom part of the dialog are the following options:  

• Consider roundings - if this is not selected, roundings of rolled profiles will not be 
considered while generating a cutting plane. 

• Cut protrusions to face - if this is selected, additional planes that form a contour of a 
part (profile, plate) are accounted for in a cut shape (shown in red in the drawings 
below). Out of these planes, the software selects the one for which the value of the 
inclination angle between the plane and the cut object is closest to 90 degrees.    

 © 2010 Autodesk, Inc. All rights reserved          



AutoCAD Structural Detailing - Steel - User Guide  page: 77 

  
The operation of the Cut protrusions to face option is illustrated in the drawings below.  

Cut protrusions to face is not selected  Cut protrusions to face is selected 

   
Clicking Apply changes parameters of the selected objects. Click OK to perform the defined 
operation of object fitting based on the adopted parameters, and close the dialog.  
Click Close to conduct the defined operation without saving the changes made recently.  
Click Next to start fitting of successive objects.  
 
See also: 
Example of fitting two I-sections to each other 
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10.4. Example of the fit to object operation 
To begin fitting two I-sections, as illustrated in the drawing below:  
 

  
 

• Select the Fit to object option . 
• In the drawing area, select the profile to which the other profile should be fitted (profile 

1) and the profile which should be fitted to profile 1 (profile 2). 
• In the Fit by object dialog:   

o For Type of fitting, select Passive and Internal. 
o For Type, select 1 Type. 
o Clear Consider roundings. 
o Specify the fitting dimensions as displayed in the drawing below. 

 

  
 

• Click Apply.  
The I-sections fitted are displayed in the following drawing.  
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10.5. Object snap settings 
While making a drawing, you can position the cursor at snap points of objects (profiles or 
plates).  
 
To begin specifying snap settings, open the Snap Mode dialog from:  

• Menu: Steel / Tools / Workspace / Object snap settings 
• Ribbon: ASD - Model / Tools / Object snap settings 

• Toolbar: Workspace / Object snap settings  
• Command line: RBCS_PSNAP. 
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Specify snap points: 

 
 

axis - snap point: 
plate - plate center 
profile - 3 snap points on the bar axis: 
beginning, middle, and end 

 

outer corners - snap points are the 
corners of the outer contour 
circumscribed on a cross-section  

 
 

inner corners - snap points are the 
inner corners of a section as shown in 
the drawing  
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outer midpoints - snap points are the 
midpoints of outer contour sides of a 
section 
 

inner midpoints - snap points are the 
midpoints of section inner sides 
 

composite sections - snap points are 
specified for each part of a composite 
section 

 
If Auto is selected, snap points are positioned on the axis.  
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10.6. Cut by bisector 
Use this option to fit 2 profiles to each other using a bisector. 
To begin the fitting operation, open the Cut by bisector dialog from:  

• Menu: Steel / Machining / Cut by bisector 
• Ribbon: ASD - Model / Machining / Cut by bisector 

• Toolbar: Machining / Cut by bisector    
• Command line: RBCS_CUTBISEC. 

 

  
 
The cutting operation may be performed as cutting with:  

• A bisector, the result of which is a cut as shown in the drawing below.  
 

  
 

• Alignment of profile edges (the cutting line goes from point A to point B), the result of 
which is a cut as shown in the drawing below. 
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For the both types of cutting, it is possible to define a distance between the cut profiles.  
 
When you click Apply, parameters in selected objects are modified. Clicking OK performs the 
defined operation of cutting the profiles based on the adopted parameters and closes the 
dialog.  
After you click Close, the defined operation is performed without saving the changes made 
recently. Cutting of successive profiles starts when you click Next.  
 

10.7. Chamfering of corners - plates 
Use this option to chamfer plate corners.  
 
To begin chamfering plates, open the Chamfering of corners dialog from:    

• Menu: Steel / Machining / Chamfer plate corner 
• Ribbon: ASD - Model / Machining / Chamfer plate corner 

• Toolbar: Chamfer plate corner  
• Command line: RBCS_CHAMFCORN 
• In the drawing area, select a plate and the plate corner. 
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After you select the chamfer type, define chamfer dimensions (the number of available 
dimensions depends on the selected chamfer type). The chamfer is an active object, which 
means that it may be edited later (change of chamfer type, modification of parameter values). 
It is also possible to delete a plate chamfer.      
Click Apply to modify chamfer parameters. Click OK to run the defined chamfer operation 
based on the parameters adopted and close the dialog.  
After you click Close, the software carries out the defined operation without saving the 
changes made recently. Clicking Next starts chamfering of the next plate corner.  
 
See also: 
Example of chamfering a plate corner  
 

10.8. Example of chamfering plate corners 
To begin chamfering corners of the plate, as shown in the drawing below:  
 

  
 

• Click the Chamfer plate corner option . 
• In the drawing area, select the plate whose corners will be chamfered. 
• Select the corners of the plate that should be chamfered (in the drawing above, these 

are corner 1 and corner 2). 
• In the Chamfering of corners dialog:  

o For chamfering type, select . 
o Specify the chamfer dimensions as shown in the drawing below.   

 

   
 

• Click Apply. 
The chamfered plate is illustrated in the drawing below.   
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10.9. Bending of plates 
A bent plate is an element made by bending a standard plate defined in a model. Bending of 
plates is a reversible operation.  
After you perform the bending operation, a plate becomes a bent plate in the software.  
 
A bend in a plate may be defined by specifying (see the drawing below):  

• Bending line 
• Angle of bending  
• Reference surface - this determines whether a radius is defined on the internal surface 

of the plate (the r radius) or on the middle surface of the plate (the ra radius) 
• Side of the plate to be bent 

 

  
 

 NOTE: 
Areas of bending may not overlap.  
 
While you define a bend in a plate, the following commands will display in the command line: 

Choose method [by2Points/byLine]: 
Specify start point: 
Specify end point: 
or  
Select line: 

Location of bending line [Center/Edge] 
Specify internal radius or [Axial]:  
Specify angle: 
Pick side to be wrapped: 

 

10.10. Insert arc - profiles 
Use this option to connect (by means of an arc element) 2 profiles not touching each other, 
lying in the same plane. 
The option is available from: 
• Menu: Steel / Machining / Insert arc  
• Ribbon: ASD - Model / Machining / Insert arc 

• Toolbar: Machining / Insert arc  
• Command line  : RBCS_BENDCORNER. 
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To insert an arc between 2 profiles, see the drawing below:  

1. Click the Insert arc option . 
2. In the drawing area, select 2 profiles to be connected by an arc. 
3. Specify a radius of the inserted arc. 
4. Press Enter. 

 
before inserting an arc after inserting an arc  

 

10.11. Copy connection 
Using this option, you can copy all types of connections defined in AutoCAD® Structural 
Detailing. Copying comprises all the elements of a connection. 
 
To define a connection:  

1. Click the Copy connection option . 
2. In the drawing area, select the connection to be copied. 
3. Select the profiles to which the selected connection will be ascribed. If all profiles in 

the structure model are selected, the software will find all the profiles that can be 
ascribed the selected connection.  

4. Press Enter.  
 
A connection will be copied if the following conditions (for profiles in the copied connection and 
profiles where the connection will be copied) are satisfied:  

• Target profiles are identical to those in the indicated connection 
• Mutual orientation of profiles is identical to that in the indicated connection 

 

 NOTE: 
If a connection involves machining operations that you have defined manually, they are 
deleted from the elements of this connection when regenerating this connection.    
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10.12. Collision detection 
Using this option, you can find structure elements that overlap. 
 
To detect a collision of elements in the structure model: 

1. Click the Collision detection option  
2. In the drawing area, select elements of the structure model to be verified. If all 

elements in the structure model are selected, the software will find all the collisions of 
structure component elements.   

3. Press Enter.  
 
After you have completed the verification of the structure model, the number of collisions 
found between structure elements (profiles, plates, bolts, and so on) displays in the command 
line. Collision sites are marked in the structure model.      
It is possible to save collision tests; they are saved in the RBCS_Collision_Detection layer and 
represented by AutoCAD® 3D Solid objects. 
 

11. DRILLS/BOLTS/WELDS 

11.1. Drills 
Use this option to define bolt openings. 
To begin defining bolt openings, display the Drilling dialog from:  

• Menu: Steel / Machining / Drill/Bolt 
• Ribbon: ASD - Model / Bolts/Welds / Drill/Bolt 

• Toolbar: Machining II / Drill/Bolt  
• Command line: RBCS_DRILL. 

 

 
 
Specify parameters:   

• Under Properties, define basic information for bolt openings 
After you select Depth, an edit field becomes accessible in which you can define the 
drilling depth. If Depth is not selected, an opening is drilled through a whole element. 
After you select Slotted, the defined opening will be slot-shaped, and you can specify 
length of the opening rectilinear part and opening rotation angle, in respective edit 
fields. If Slotted is not selected, the opening will be circular. 
Under Drillings in flanges, you can select Bottom flange or Top flange in order to 
position drillings in the bottom/top flange of a member section. 

• In the middle part of the dialog, select a mode of defining bolt openings / drillings (the 
selected mode is displayed in the preview area)  
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 - single bolt opening  
 - rectangular arrangement of openings / drillings with a regular spacing of openings 

in both directions. When this opening type is selected, the following parameters need 
to be defined: 
o Number of rows and columns of openings / drillings (direction X and direction Y) 
o Distances between rows and columns of openings / drillings (dx and dy) 

 - polar arrangement of openings / drillings (openings will be defined on an arc of a 
circle). When this opening type is selected, the following parameters need to be 
defined:  
o Number of openings / drillings  
o Radius of a circle on which the centers of openings / drillings will be positioned  
o Angle between the successive openings/bolts. If Auto fill is selected, openings will 

be arranged along the entire circumference length and the angle will be 
determined automatically. 

 - rectangular arrangement of openings / drillings with an irregular spacing of 
openings. When this opening type is selected, the following parameters need to be 
defined:  
o Number of rows and columns of openings / drillings (direction X and direction Y)  
o Distances between successive openings in rows and columns of openings / 

drillings (dx and dy) (for example, 50 75 50 100)  
• If Bolts is not selected, bolts will not be placed in the openings (all the edit fields are 

inaccessible). If the option is selected, bolts will be placed in the openings and the 
fields for defining bolt parameters (Diameter and Grade), are accessible. Click Setting 
to open the Bolt Settings dialog. 

•  (Drill) – click this in order to select objects in which the openings are to be made 
and drill bolt openings based on parameters defined in the dialog.  

 
The dialog opens showing the opening/bolt parameters defined recently.   
 

11.2. Bolt settings 
The Bolt settings dialog displays after you click Setting in the Drilling dialog.  
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On the left, specify basic information for applied bolts:  
• Bolt type (Workshop or Site)  
• Washer thickness - in AutoCAD® Structural Detailing, bolts are generated with 

washers, and the washer thickness is taken into account during calculation of bolt 
length 

• Length 
o Auto - determined automatically   
o Exact - user-specified  
o Database - selected or calculated based on data in a chosen bolt database (see: 

Principles of calculation of the bolt length)  
• Diameter  
• Grade  
• Description  

If you select an option under Include parts, in the selected part is added:  
• Nuts (1 or 2) 
• Washers - head washers or nut washers 

When you click Database, the bottom panel of the Bolt settings dialog displays. It contains a 
table with data regarding bolts, nuts, and washers available in the selected bolt folder.  
 

11.3. Principles of calculation of the bolt length 
If you select Database in the Bolt settings dialog, a bolt of the appropriate length is 
automatically selected from an available bolt database.   
 
Data needed to determine a bolt length:  

• Sum of thicknesses of all the elements connected with each other  
• Bolt parameters: 

o  Diameter 
o Type connected with a selected bolt database  

• Washer parameters: 
o Number  
o Type connected with a selected washer database 

• Nut parameters: 
o Number  
o Type connected with a selected nut database  

 
The bolt list displayed in the lower part of the Bolt settings dialog includes all bolts of a given 
diameter from a database. The bolt found is highlighted on this list.  

  

11.4. Weld definition 
Use the Weld definition dialog to define weld parameters.   
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After you have selected the weld type of marking (workshop or site), you can determine 
parameters of the defined weld: 

• Weld type   
• Weld thickness (calculated automatically) 
• Dimension(s) for edge preparation are shown in a schematic drawing - the number of 

parameters depends on a weld type 
If you select Intermittent weld, you can define an intermittent fillet weld (composed of many 
segments of single welds). The drawings below include the following designations: 

PE - beginning of a weld 
PS - end of a weld 
l - length of weld segments 
e - spacing between weld segments 
All segments of a weld are of the same length (l); spacings between segments of welds 
are also of the same length.  

 
The following types of intermittent welds are available: 
Intermittent weld - one-sided 
 

  
 
Intermittent weld – double-sided - chain  
 

  
 
Intermittent weld - double-sided - staggered 
 

  
 
See also: 
Weld description styles  
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12. POSITIONING 

12.1. Position - definition and description 
The design process in AutoCAD® Structural Detailing may be divided into 2 primary stages: 
model definition and preparation of drawing documentation. The intermediate stage involves 
positioning (assigning) to structure elements the position designations, which are used to 
identify elements in the documentation. Assigning a position is necessary in order to prepare a 
drawing of a given element. 
An additional objective of positioning is to limit a number of drawings in such a manner that 
identical structure parts are displayed in a single drawing. There are 3 types of objects that 
may be positioned in AutoCAD® Structural Detailing: 
 

• Single parts  
• Assemblies (only automatic positioning) 
• Groups 

 
The position is displayed in the form of an element (element group) label. The position syntax 
consists of a Prefix + number, where:  
 

• Prefix is short, editable text (for example, pos) that may be linked to the element’s 
family (single part, groups, and so on.). This part of a name may be disregarded. 

• Number is saved in the numeric or alphanumeric format (it may be ascribed 
automatically or manually). As a result of adopting a position number, the classification 
is set properly on the list.  

 
Positions may be assigned independently on 2 positioning levels (positioning is carried out 
separately for each of the levels listed): 

• Single part 
• Assemblies 

 
The program allows 2 methods of assigning a position:  
• Manual positioning - manual definition or modification of positions for selected elements - 

single parts or groups. 
• Automatic positioning - automatic definition of a position for the entire model or its 

selected part. 
  
Each of the positioning levels listed is connected with the type of drawings (the template used 
for automatic drawing generation): single part drawing, workshop drawing, and site drawing. 
Elements that may be chosen for individual positioning levels:   
 

Single part  Single parts: profiles, plates, connectors  
 

Assembly   Single parts, groups 
 

Group Groups 
 

 
To access the Remove position option, go to: 

• Menu: Steel / Positions / Remove position 
• Ribbon: ASD - Model / Positioning / Remove position 

• Toolbar: General / Remove position  
• Command line: RBCS_REMPOS.  

To remove the positions assigned to elements, select the elements and activate the Remove 
position option. Positions will be removed from all selected elements.  
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12.2. Manual positioning 
Use this option to assign a position manually.  
 
To begin assigning positions manually, open the Manual positioning dialog from:  

• Menu: Steel / Positions / Assign position 
• Ribbon: ASD - Model / Positioning / Assign position 

• Toolbar: General / Assign position  
• Command line: RBCS_MANUALPOS. 

 

 
 
To assign a position manually:  

1. Select an element or several identical elements  
2. In the Manual positioning dialog, specify: 

• Positioning level 
• Position label (prefix, number, and comment - see the position description)   

3. Click Apply.  
 

 NOTE: 
When you assign a position manually, only basic criteria of element recognition are 
considered. User-defined criteria are available only during automatic positioning.  
 
You can also assign (modify) a position at any time while working in AutoCAD® Structural 
Detailing by means of the Object properties option on the Inspector dialog.  
 
See also: 
Position verification  
 

12.3. Automatic positioning 
Use this option to assign positions automatically.  
To begin assigning positions, open the Automatic positioning dialog from: 

• Menu: Steel / Positions / Run Automatic positioning 
• Ribbon: ASD - Model / Positioning / Automatic positioning 

• Toolbar: General / Automatic positioning   
• Command line: RBCS_AUTOPOS.  

 
You can assign positions automatically for a whole structure model or for its selected part. 
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After you select structure elements, use the tabs on the Automatic positioning dialog to specify 
parameters:  

• General  
• Additional 
• Numbering.  

 
Click Run to begin the automatic positioning operation for all selected structure elements. All 
positions assigned during the positioning operation are given an identical prefix and comment.  
 
See also: 

• Position verification  
• Example of automatic positioning  

 

12.4. Additional 
On the Additional tab of the Automatic positioning dialog, you can specify parameters to be 
considered during the positioning operation.  
 

 
 
Available options:   

• Identify parts   
If you select this (it is selected by default), the software checks the identity of a 
structure part. If 2 identical parts are found, they are assigned the same position. If 
you clear this option, each structure part is assigned a successive position.  

• Family  
If you select this, the software considers families while checking the identity of a 
structure part. If structure elements belong to different families, these structure 
elements will be ascribed different positions.   

• Material   
If you select this, the software considers materials while checking the identity of a 
structure part. If structure elements are assigned different materials, these structure 
elements will be ascribed different positions. 

• Overwrite existing positions without confirmation  
 

 © 2010 Autodesk, Inc. All rights reserved          



page: 94 AutoCAD Structural Detailing - Steel - User Guide 

If you select this, the structure elements that have been selected and assigned positions are 
automatically ascribed new positions (previous positions are overwritten).  
If you clear this option and the software finds an element with a position already assigned, the 
command line prompts you about overwriting the position:   
No - the position will not be changed  
Yes - the position will be changed to a new one  
Yes for all - the position will be changed for all the successive elements that have already 
been assigned positions.  
 
If the Identify parts option is selected and several identical parts have been found during 
positioning, the number ascribed to the element is the number of the first identical part found 
during positioning. All the parts identical to a previously positioned element are ascribed the 
same position as the first element found.  

12.5. General 
 
On the General tab of the Automatic positioning dialog, you can specify parameters for level, 
prefix, and number.  
 

 
 
Available options under Settings:  

• Positioning level - the selected positioning level will be assigned to all elements 
chosen for the positioning operation  
Single part - groups are not considered in the positioning process  
Assembly - positions are assigned both to single elements and to groups   
Both types - single parts are not considered in the positioning process  

• Prefix – from the list, you can select a character string that will be ascribed as a prefix 
to all positions. You can also select By family to take a prefix from a family  

• Number  - specify the format of position numbering  
o Format - Alpha or Numerical  
o Start from - specify the beginning value for the position numbering; successive 

positions will be numbered based on the value specified for Step 
When the entire alphabet has been used, position numbering will use the following 
form: AA, AB, AC, and so on.  

o Step - define the increment value for position numbering.   
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12.6. Numbering 
Use the Numbering tab on the Automatic positioning dialog to specify sorting criteria for 
position numbering. The available options depend on the selection for Sort by.     
 
Sort by element shape    
 

 
 
In this mode, the numbering order is determined based on selected properties of the element 
shape.   
Specify additional sorting parameters:    

• Sorting criteria (Family, Length, Size, Type, Weight, and Material) - highlight a 
parameter and click the  buttons to move the selected parameter up or down the 
list, thus defining the required sorting order. 

• Sorting order (ascending) of quantities defined in the software for a selected sorting 
parameter (for example, all profile types) - highlight a parameter and click  buttons 
to move the selected property up or down the list, thus defining the required sorting 
order.  

 
Sort by element location    
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In this mode, successive numbers are ascribed based on the position of the element reference 
point in the coordinate system. 
Specify additional sorting parameters:  

• Sort according to axes - choose whether the location of positioned elements is to be 
verified with respect to the global coordinate system (WCS) or with respect to the 
current user local coordinate system (UCS). 

• Reference point - determine the point that identifies the point position in space.  
• Axes order - select the method of searching the parts in the selected coordinate 

system.  
• Axis sense - determine if the numbering increases according to the axis sense (+) or if 

the numbering increases in the direction opposite to the axis sense (-).  
 

12.7. Position verification 
Use this option to control designations of positions ascribed to elements in the process of 
manual or automatic positioning.   
Positioning is verified through searching for positions that either fulfill or do not fulfill selected 
conditions of positioning.  
 
To begin verifying positioning for the entire structure model, open the Positions verification 
dialog from: 

• Menu: Steel / Positions / Verify positions 
• Ribbon: ASD - Model / Positioning / Verify positions 

• Toolbar: General / Verify positions  
• Command line: RBCS_VERIFYPOS  

Verification of positions is performed for the entire structure model. 
 

  
 
Under Actions, select an operation to perform on elements found during position verification 
(Hide, Change color, Select, or Change color and select). The effect of an action is 
remembered until you click Restore or until the dialog is closed and regeneration is carried 
out.   
Under Check, you can choose elements (single parts or assemblies) to be taken into account 
during structure verification.   
Under Check criteria, indicate the elements to be searched in the process of verification:   

• Elements without positions - select this in order to search for all elements to which no 
position has been assigned.  

• Elements belonging to position - select this in order to search for elements that contain 
the specified prefix and position number. 
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• Find identical - select this in order to search for elements that conform with the pattern 
object you select (group or single part). You can select the pattern object on the 
screen after you click Select pattern.  

 
Click Apply in order to run the verification (the options in the Check criteria field). After 
verification is carried out on all objects that satisfy the selected criterion, the operation 
specified under Actions will be performed. In addition, the command line provides information 
about the number of elements found that fulfill the defined criterion:   
Position verification 
Identical elements: 10 found. 
 
If you have specified Select for Actions, you can use the buttons at the top right of the dialog 
to run positioning of elements found and selected during verification:    

• Auto positioning - click this to perform automatic positioning for elements found in the 
verification process.  

• Manual positioning – click this to perform manual positioning for elements found in the 
verification process. 

 

12.8. Example of positioning and automatic printout 
Positioning will be illustrated using a simple 3D frame generated with the Multi-span frame 
macro available in AutoCAD® Structural Detailing - Steel. To define a multi-span frame:  

1. Click the Multispan frame  option. 
2. In the drawing area, click to specify the frame insertion point. 
3. On the Geometry tab of the Parametric Structures – 3D Frame - Multispan hall dialog: 

• For Number of spans, enter 2.  
• For Number of frames, enter 2. 
• For Frame spacing, enter 8000 mm.  
• Select Rafters and External spandrel beams.  

4. Accept any user-defined dimensions of the frame that display in the dialog. 
5. Click the Profiles tab, and specify the attributes for component elements of the frame:  

For Columns – select profile C 10x15.3 and select family Column. 
For Rafters - select profile C 10x15.3 and select family Beam. 
For Spandrel beams - select profile C 10x15.3 and select family Beam. 

6. Click OK. The software will generate a model of the 3D frame.  
 
The profiles generated in the 3D frame have been added on the Model tab of the Object 
inspector dialog. To assign positions to the elements of the created frame:  

1. On the Model tab of the Object inspector dialog, select all the profiles, right-click, and 
click Auto positioning.  

2. In the Automatic positioning dialog:   
• On the General tab, for Positioning level, select single part. 
• For Prefix, select By family. 
• Under Number, for Format, select Numerical, for Start from, enter 1, and for Step, 

enter 1.  
• On the Additional tab, select all the options.   
• On the Numbering tab, for Sort by, select Element shape. 
• For Sorting criteria, select Family. 
• For Sorting order, select Column and Beam.  

3. Click Run.  
All elements of the 3D frame will be assigned positions according to the parameters 
specified in the Automatic positioning dialog. Because some frame elements are 
identical, 3 positions will be created on the Positions tab of the Object inspector dialog:  
columns c1, beams b1, and beams b2. The drawing below illustrates the created 
positions and location of the structure elements that make up individual positions.  
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4. On the Positions tab of the Object inspector dialog, select all the created positions, 

right-click, and click Automatic Drawings.  
5. On the Automatic drawing generation dialog:  

• On the Templates tab, for Column, select Profile 1:10.  
• For Beam, select Profile 1:10. 
• On the Formats and scales tab, for Part type, select single profiles 
• Select Automatic scale. 
• For Format, select A4 ASD. 
• For Arrange views, accept the default values. 
• On the Options tab, for Names of printouts, select Names consistent with position 

name. 
• For Start printout numbers, select 1.  
• Clear all remaining options. 
• On the Bill of materials tab, select Add table. 
• For Description, select Standard. 
• Select Top – Left. 

 
6. Click Generate. 

Detailed drawings will be generated for all positions (b1, b2, and c1). The software will 
create additional layouts (b1, b2, and c1), which will display drawings of selected 
positions. Also, on the Positions tab of the Object Inspector dialog, documents 
(projections of positions: views and sections) for each position will be added.    
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13. FAMILY MANAGER 

13.1. Family manager 
Use this option to add (remove) families to a project, and to modify family properties.  
 
To begin working with families, open the Family Manager dialog from:  

• Menu: Steel / Tools / Family Manager 
• Ribbon: ASD - Model / Tools / Family Manager 

• Toolbar: General / Family Manager  
• Command line: RBCS_FAMILY. 

 

 
 
Basic rules that apply while defining/modifying families in AutoCAD® Structural Detailing:  

• The family is an attribute that may be assigned to a profile, bent profile, plate, or user 
part defined in a structure model. Thus, it is a tool that facilitates management of 
structure model parts. 

• The main goal of defining families is to collect structure elements into certain sets and 
put them in order so that they are recognizable during filtering, positioning, and so on.   

• Any number of families may be defined in a project; a set of families may be saved in 
a project template (a DWT file). 

• The family may be assigned to each of structure parts (profile, bent profile, plate, or 
user part) during definition of the structure element (dialogs contain the lists that 
enable selection of a family) or may be applied as an element property after defining 
the structure elements listed.    

 

 NOTE: 
The family may be assigned only to a single part (for groups or assemblies, the family is 
assigned to the main part).   
 
In the Family Manager dialog, define family parameters:    

• Name - specify the name that identifies a family; a family name cannot repeat in a 
project. 

• Layer – this is the default layer on which family elements will be positioned during 
definition. The connection of the family and layer is not permanent: after definition, an 
element may be transferred to another layer without losing the family attribute. 
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• Part Type - specify the type of structure element for which the group will be defined. 
The family may be defined for profiles (with bent profiles included), plates, or subparts, 
but a family defined for profiles cannot be assigned to plates (and vice versa). 
Subparts created automatically during operations such as a connection definition are 
ascribed to a default family (based on the option selected in Preferences). 

• Color – specify the color that will be assigned to parts in the defined family. 
• Default single part position prefix - enter a prefix (text) to be used during automatic 

positioning of single parts of the defined family. 
• Default main part position prefix - enter a prefix (text) to be used during automatic 

positioning of main parts of the defined family.  
 
Defined families are available in: 

• the appropriate selection lists provided in the Profile, Bent profile and Plate dialogs. 
• profile or plate properties (families may be modified in the Properties or Inspector 

dialogs).  
 
Use the buttons at the right of the dialog to work further with families:  

• New - click this to add a new family to the list of available families. An added family is 
assigned a default name, which you can change. All properties for the new family are 
inherited from the family highlighted on the list. If none of the families has been 
highlighted, the properties are inherited from the first family on the list. 

• Delete - click this to remove a selected family from the list. All structure elements that 
were ascribed in the removed family remain in a structure model without the family 
assigned. 

• Details - click this to show (or hide) the bottom part of the dialog displayed under the 
list of available families. The options available under Details enable defining 
parameters for a selected family or families. When several families are selected, the 
properties are identical for all selected families.   

 
See also: 
Example of definition of a profile family  
 

13.2. Example of definition of a profile family 
To define a new profile family:   

• Click the Family Manager option  
• In the Family Manager dialog, click New. 

The software creates a new family with the properties of the most recently selected 
(highlighted) family. 

• Under Details: 
o For Name, enter Bracings. 
o For Layer, select RbCS_Profile. 
o For Part type, select Profile. 
o For Color, select ByLayer. 
o For Default single part position prefix, enter br. 
o For Default main part position prefix, enter Br. 
The new profile family has been added to the list (see the drawing below). 

• Click OK.  
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In the Family Manager dialog, you can also edit parameters of a selected family.  
 

14. DIMENSIONING STYLES 

14.1. Dimensioning styles 
Use this option to define styles of element dimensioning. 
To begin defining styles, open the Dimensioning styles dialog from:  

• Menu: Steel / Styles / Dimensioning styles 
• Ribbon: ASD - Drawings / Styles / Dimensioning styles 
• Command line: RBCS_DIM. 

 

 
 
Dimensioning consists of positioning elements in a 2D projection of a position:  

• Geometrical dimensions: linear dimensions of individual elements or elements joined 
together to create an element chain, arc dimensions, angle dimensions, diameters, 
and radial dimensions 

• Symbols and names: weld symbols, bolt (opening) symbols, elevation marks, 
designations of assemblies and groups (profile types, positions), and so on  

• Comments (additional text): variables describing created views and presented objects 
(name, scale, and so on), user-defined text  

Dimensioning is performed automatically based on user-defined settings; it is also possible to 
modify created dimension lines and their descriptions. Dimensioning may be conducted within 
the edition contour. All dimensional elements (such as dimension lines, text style, and ends of 
dimension lines) are set in the dimension styles available in AutoCAD®.   
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You can define any number of dimensioning styles. Each defined style belongs to one of the 
categories concerning the type of a drawing position (single part, assembly, group, scheme – 
a group of elements constituting a structure model).  
The dimensioning style defines: 

• Dimension style from AutoCAD® to be applied  
• Elements and the element projections in which the individual elements should be 

included  
• Manner of arranging elements in the drawing 

A set of defined styles is saved in a DWG format file or in a template (a DWT file).  
In the Dimensioning styles dialog, when a drawing position type is selected for Style, all 
defined styles for the selected category are displayed. A preview of a selected style is shown 
in the Preview field. For each style, there are different settings defined for each of available 
element views (top view, front view, side view, 3D view).   
One of the styles defined for each drawing position type is a default style, and will be 
suggested as a default as you define a drawing template. The default type may be changed by 
highlighting a style within a given category and clicking Default.  
Use the buttons on the right of the dialog:  

• New - click this to open the Dimensioning style settings dialog, where you can define a 
new style for a selected category. The name of a new style and all its settings are 
inherited from the style currently selected. 

• Modify - click this to open the Dimensioning style settings dialog, where you can 
change settings of a selected style.   

• Delete - click this to delete the style currently selected from the list of available styles 
for a given category.  

 
See also: 
Orientation of element views and dimensions in a drawing  

14.2. Definition/modification of a dimensioning style  
Use the Dimensioning style settings dialog to define a new style or modify an existing 
dimensioning style. The dialog opens after you click New or Modify in the Dimensioning styles 
dialog.  
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The contents of the dialog depend on the category selected in the Dimensioning styles dialog; 
there are considerable differences in the part concerned with geometrical dimensions. The 
dialog also differs considerably if a dimensioning style of disposition scheme has been 
chosen.  
  
The dialog is divided into the following parts (beginning at the top of the dialog):  

• general - parameters defined in this part (including a style name) are used in all 
generated views   

• parameters of dimensioned curved parts 
• section to define geometrical elements that are to be dimensioned – if you select an 

option on any of the tabs (Front view, Top view, Side view, 3D view), an element 
selected in the drawing will undergo dimensioning. In the selection fields, you can 
determine dimensioning parameters. 

• a preview of the style currently defined  
• a comments section where you can specify additional texts generated automatically 

for views 
• a place to define description styles and symbols - you can indicate a symbol that is to 

be created automatically in the selected style; clicking one of the (…) buttons opens 
the dialog used for defining description styles ,which determine the manner of 
displaying a description/symbol in a drawing. 

 

14.3. Definition/modification of a dimensioning style 
- disposition scheme 

Use the Disposition scheme dialog to define a new style or to modify an existing dimensioning 
style for the disposition scheme (a group of elements constituting a structure model).  This 
dialog opens after you click New or Modify in the Dimensioning styles dialog (the scheme has 
to be selected as a style category).    
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Define parameters using the options at the top of the dialog:   
• ACAD Dimension style - select an AutoCAD® dimensioning style that will be applied 

in the dimensioning style currently selected. The list contains all the dimensioning 
styles defined in a DWG format file  

• Distance to the first dimension line – specify the distance between the edge of a 
dimensioned part and the first dimension line generated automatically  

• Distance between dimension lines – specify the distance between successive 
dimension lines  

• Extension of axis beyond edge – specify the length of lines that extend outside the 
element edges on both sides of the element  

• Invisible edges - if this is not selected, invisible edges of an element are hidden in a 
final drawing. If this is selected, invisible edges are displayed in a drawing (specify 
their line color, line type, and line thickness parameters at the right of the option)  

• Profile axes - if this is not selected, profile axes are hidden in a final drawing. If this is 
selected, profile axes are displayed in a drawing (specify their line color, line type, and 
line thickness parameters at the right of the option). Profile axes are displayed in all 
projections; in final drawings, axes are extended by 5 mm outside the edge of a 
dimensioned object   

 
Click the Cuts parameters button in the upper part of the dialog to open the Cut parameters 
dialog where you can specify parameters of hatching the cut and parameters for designating 
the cut in disposition schemes.   
 
Specify view parameters (color, type of the first and/or second line, line thickness) using the 
options in the center of the dialog. Select a view type: 

• Real – a real view of each element  
• Rectangular box – a view of each element is represented as a rectangular contour  
• Line - a view of each element is represented as a single line  
• Double line  

  
 

• Column line  

  
 

• Truss scheme  

  
 

• Rectangular box - group - for all elements of a group (also for elements in subgroups), 
the view is represented as a rectangular contour circumscribed on elements of the 
group   

• Line - group - represented as the largest central (single) line of the rectangular contour 
circumscribed on elements of the group   

• Double line - group - represented as the largest central (double) line of the rectangular 
contour circumscribed on elements of the group   

• Column line - group - represented as the largest central line (column line) of the 
rectangular contour circumscribed on elements of the group 
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Specify when to show designations (for assemblies and marks): 
• For each element of a scheme  
• Only for the first and last elements 
• Do not show 

Moreover, you can select styles for assemblies and marks.  
 
You can specify a value of shortening (in percent) of an element length.  
 
Additional parameters: 

• Stick dimensions - distances of elements from axes in a scheme (if an element lies on 
the axis, then a 0 dimension is not shown)   

• Level marks - level symbols, separately for each subgroup of the scheme  
• Axial dimensions - dimensions from axis to axis of elements of a scheme  
• Level dimensions - additional dimension lines of elements (on the side of a scheme, 

near the level marks); a dimension chain from the lowest to the highest level in the 
scheme is created.   

 
If Comments is selected, a title (name) is added to the views of a dimensioned object. The title 
may be text (comprising one or several lines) containing variables or any user-defined 
character string. Below the text field are variables that you can add to the defined comment at 
the cursor position. The variable text is displayed with the comment in the edit field.  
 
Available comment variables:  

%%Pos - if this is selected, description of a position is added to the text    
%%Scale - if this is selected, a scale (for example, 1:20) is added to the text 
%%Vname - if this is selected, an automatic name of a view or section is added to the 
text   

 
You can determine the placement and appearance of a comment in a drawing: 

• Text placement in viewport 
• Text style 
• Alignment (align right, align left, center) 

 
Under Symbol and layer styles, select styles for the following descriptions and symbols 
(designations) presented in final drawings:  

• Elevation marks  
• Workframe axes 

 

14.4. Orientation of element views and dimensions in 
a drawing 

 
To define position projections, the following terms have been adopted:   

• Front view - XZ plane of the element local coordinate system   
• Top view - XY plane of the element local coordinate system   
• Side view - YZ plane of the element local coordinate system 
• 3D view – isometric view 

 
The element local coordinate system for a selected position type is defined as follows:   
Single parts  
 

• Profiles:  
o X axis - along the profile axis  
o Y axis - section horizontal axes - identically as in the case of profile saving in the 

database (for most profiles it is the axis of a larger moment of inertia)  
o Z axis - section vertical axes - identically as the case of profile saving in the database 

(for most profiles it is the axis of a smaller moment of inertia)  
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• Plates: 
o Rectangular  

X axis - along the plate length   
Y axis - along the plate width  
Z axis - perpendicularly to the plate plane  

o Circular 
X axis - along the radius (diameter) determined during plate definition    
Y axis - perpendicularly to X axis (in the plate plane)  
Z axis - perpendicularly to the plate plane 

o User-defined  
X axis - along the longest segment belonging to the plate contour  
Y axis - perpendicularly to X axis (in the plate plane) 
Z axis - perpendicularly to the plate plane 

 
 

14.5. General part 
At the top of the dialog, specify general parameters:  

• ACAD dimension style - select an AutoCAD® dimensioning style that will be applied in 
the dimensioning style currently selected. The list contains all the dimensioning styles 
defined in a DWG format file  

• Distance to the first dimension line – specify the distance between the edge of a 
dimensioned part and the first dimension line generated automatically 

• Distance between dimension lines – specify the distance between successive 
dimension lines (see drawing below)  

• Extension of axis beyond edge  - specify the length that lines extend outside the 
element edges on both sides of the element   

 

 
 

• Parts shortening - if this is selected, long elements (element segments that do not 
include any characteristic points) will be shortened in a final drawing. The element 
shortening is displayed as a gap in a shortened element.  
Element shortening will be performed if the element segment (not including any 
characteristic points) is longer than a value of the user-defined minimal distance 
without details. The drawing below illustrates the same element, shortened (top part of 
the drawing) and not shortened (bottom part of the drawing). 
You can define a type of break line to use during element shortening; the list contains 
all available line types in AutoCAD®, saved in a DWG format file. Thickness and color 
of the break line are identical to those of an element contour.  
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Additional parameters of shortening can be specified (see drawing below): gap value, 
and value of the distance to gap (distance between a characteristic point and a gap).   

  
• Invisible edges - if this is not selected, invisible edges of an element are hidden in a 

final drawing. If this is selected, invisible edges are displayed in a drawing (specify 
their line color, line type, and line thickness parameters at the right of the option) 

• Axes - if this is not selected, profile axes are hidden in a final drawing. If this is 
selected, profile axes are displayed  in a drawing (specify their line color, line type, 
and line thickness parameters at the right of the option). Profile axes are displayed in 
all projections; in final drawings, axes are extended by 5 mm outside an edge of a 
dimensioned object  

• User parts - if this is not selected, user parts are hidden in a final drawing. If this is 
selected, user parts are displayed in a drawing (specify their line color, line type, and 
line thickness parameters at the right of the option)  

• Cut parameters – click this to open another dialog, in which you can specify 
parameters of section hatching and parameters of designation of a part section.    

 
For styles of assemblies or groups, Distance to the first dimension line indicates the distance 
measured to the edge determined by a rectangle describing an assembly projection (rectangle 
sides are parallel to the axes of the element local coordinate system).  
 
When defining a modification of an assembly style, the Draw parts in actual location option is 
available.  If this is not selected, projections of an assembly are generated in the coordinate 
system determined by the main part of the assembly. If this is selected, projections of the 
assembly are generated in the WCS (the Global coordinate system).  
 

14.6. Geometrical dimensions 
Use this part of the dialog to define or modify a dimensioning style depending on the selected 
category:  

• single part  
• assembly  
• group  

 
See also: 
Geometrical dimensions (3D view)  
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14.7. Cut parameters 
The Cut parameters dialog displays when you click Cut parameters in the Definition / 
modification of dimensioning style dialog. 
 

  
 
If Cut hatching is selected, surfaces seen as cuts through element walls are hatched. 
Define hatching parameters:  

• Pattern – select an available pattern from AutoCAD®  
• Angle – select the value of the inclination angle of the hatching pattern   
• Scale – select a value that will elongate or shorten the hatching pattern 

 
In the lower part of the dialog, it is possible to determine parameters of a cut through 
elements: 

• Cut symbol 
• Style and color of text 
• Style and color of a break line 

 

14.8. Dimensioning of curved parts 
 
Specify how curved elements are displayed on the screen and dimensioned. 
Single parts:   

• When Orthogonal is selected, curved parts display as standard objects so that their 
actual shape is shown and dimensions are generated in the orthogonal system 
(compare example dimensions generated with the use of this option in the drawing 
below). 
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• When Aligned to curve is selected, curved parts display as curved objects so that their 
actual shape is shown and dimensions are generated in the system adjusted to the 
profile curvature (compare example dimensions generated with the use of this option 
in the drawing below). Total dimensions are displayed in the orthogonal system 
(coordinate system of the curved part), and the remaining dimensions are generated 
in the longitudinal / transversal system. Longitudinal dimensions are always parallel to 
the profile axis (dimension values are calculated along the length of arc axis, and a 
radius value is given in parentheses); transverse dimensions are segments 
perpendicular to the profile axis and passing through the dimension point.  

 

  
 

• When Developed is selected, object dimensions are displayed in the developed form 
in the orthogonal system. Click Options to open the Developed parts dialog.    

 
Assemblies 

• When Orthogonal is selected, assemblies display as standard elements so that their 
actual shape is shown and dimensions are generated in the orthogonal system. 

• When Aligned to curve is selected, assemblies are displayed as curved elements so 
that their actual shape is shown and dimensions are generated in the system adjusted 
to the profile curvature. Total dimensions are displayed in the orthogonal system 
(coordinate system of the curved part), and the remaining dimensions are generated 
in the longitudinal / transversal system. Longitudinal dimensions are always parallel to 
the main part axis (dimension values are calculated along the length of arc axis, and a 
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radius value is given in parentheses). Total transverse dimensions are determined by 
cutting planes (external transverse dimensions are parallel to total transverse 
dimensions); internal transverse dimensions are segments perpendicular to the profile 
axis and passing through the dimension point.  

 
Single parts  
For the Orthogonal and Aligned to curve options, projections of the actual element shape are 
obtained, and elements are projected onto planes of the coordinate system of a curved part. 
The coordinate system of a curved part is a coordinate system used only in drawings, defined 
as follows:   

• For profiles 
If a profile includes linear segments, the longest segment is selected and the 
coordinate system of a curved part coincides with the coordinate system of this 
segment (as if it were a single simple profile).  
If a profile does not contain linear segments, the coordinate system of a curved part 
may be defined as:   
o Method A – the X axis of the coordinate system of a curved part is positioned 

along the chord of the longest (among all parts) arc segment  
o Method B – the X axis of the coordinate system of a curved part is tangent to the 

chord of the longest (among all parts) arc segment at the beginning point 
The method of defining the coordinate system of a curved part is selected in the 
Dimensioning Style Settings dialog:  
o If Align arc profiles to the chord is not selected, the coordinate system is defined 

using method A. 
o If Align arc profiles to the chord is selected, the coordinate system is defined using 

method B. 
In both cases, the Y axis of the coordinate system of a curved part is positioned in the 
plane of part bending, irrespective of profile rotation.    

 
• For plates 

The coordinate system of a curved part is identical with the part UCS.   
 
 
Assemblies 
Assemblies are considered curved if the main part of an assembly is curved. For curved 
assemblies, projections of the actual element shape are obtained, and elements are projected 
onto planes of the coordinate system of a curved part (main part of an assembly). The 
coordinate system of a curved part is defined as for a single part.  
 
 

14.9. Developed parts - options 
The Bent parts dialog displays after you click Options in the Dimensioning style settings dialog 
(the option is available for curved parts presented in a developed form). 
 

 © 2010 Autodesk, Inc. All rights reserved          



AutoCAD Structural Detailing - Steel - User Guide  page: 111 

  
 
The dialog includes the following fields:   

• Line of bending – use these options to define parameters of bending edges  
• Machining presentation – use these options to determine how to display machining in 

a drawing; selection lists in the right part of the field are accessible only when Distinct 
is selected.   

 
The idea of element development consists in transforming the curve representing the element 
axis into a straight line in such a way so that the axis length and distances between points on 
the axis remain the same (see the drawing below).  
 

  
 
The line of bending is positioned in the middle of each arc-shaped segment. Color, type, and 
thickness of the line are defined in the bottom part of the Line of bending field.  
The line of bending is displayed in a drawing if you select Draw line for radius smaller than. A 
radius value may also be specified (the line is usually drawn for small radiuses).  

 © 2010 Autodesk, Inc. All rights reserved          



page: 112 AutoCAD Structural Detailing - Steel - User Guide 

 
For Extension beyond edge, define a value of distance (extension of the line beyond the 

lement edges on both sides of the element).  

tion, select a presentation type (NOTE: the options below are not 

l be displayed in a 

only the profile shape will be displayed in a drawing 

addition, use the selection lists to specify thickness, color, and line type parameters.  

 
 disregarded and 

 lines, angle of bending, 
dius (external or to axis), dimensions, and machinings of a plate.  

See also: Bending of plates 

tside an element in the following order starting from the 

side the dimensioned part   

of the dialog consists of 3 identical tabs on which the following parameters may be 

ns generated automatically in a view, the following 

enerates a complete dimension chain with 

ovides  real (relative) dimensions of segments 

on is positioned on a separate dimension line attached to 

d 
 

 the right 

d 
nt is placed (so that 

extension lines on the edges do not need to be lengthened). 

e
 
Under Machining presenta
available in version 5.0):  

• Normal - if this is selected, all openings, cuttings, and so on, wil
drawing consistently with the style adopted for standard parts  

• Do not draw – if this is selected, 
(machinings will not be shown)  

• Distinct - if this is selected, machinings will be displayed in a drawing; a shape of 
developed machinings will be defined identically as for normal presentation type. In 

 
Curved parts are dimensioned in the same manner as rectilinear parts. You can switch off 
dimensioning of machinings that may be shown in a drawing of a developed part. If you select
Do not dimension machinings, all dimension points defining machinings are
only total dimensions and dimenions to the line of bending are displayed.   
The options in the lower part of the dialog refer to drawings of developed bent plates.  These 
drawings display the original shape and dimensions of plates (without plastic deformations).  
Use these options to insert the following items in a drawing: bending
ra
 

14.10. Geometrical dimensions (single part) 
 
Dimension lines are positioned ou
edge of a dimensioned element:  

1. Elements located in
2. Drilled openings  
3. Chamfers and cuts  
4. Overall dimensions 

This part 
defined: 

• Dimension format – for all dimensio
dimension settings are available:  
o Relative - chain – the program g

standard (relative) dimensions  
o Absolute - chain – the program generates a dimension chain which begins in the 

reference point; dimensions are positioned on extension lines  - a dimension value 
indicates the coordinate of a dimensioned point with respect to the reference point  

o Relative + absolute - chain - the program generates an accumulative dimension 
chain and on the dimension line pr
between the dimensioned points  

o To base – each dimensi
the reference point    

Click Ref. point to open the Reference point dialog, where you can define an additional 
dimension point during generation of some dimensions (for example, absolute dimensions). 

• Overall - these are the linear dimensions that display an overall size of a dimensione
part. These dimensions are generated if the option is selected, and they are always
positioned along the horizontal or vertical axis (parallel to the plane of the element 
local coordinate system). Horizontal dimensions may be placed above or below the 
dimensioned element, and vertical dimensions are positioned to the left or to
of the dimensioned element. It is possible to exclude horizontal and vertical 
dimensions from presentation. If Optimal is selected, the dimension line is positione
on this side where the longest edge of the dimensioned eleme
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• Bevels and cuts - these dimensions concern all the discontinuances on element edges 
(corners, cuts, chamfers, and so on), but do not pertain to drilled openings. There are 
3 dimension options: 
o Chain 

 all dimensions are displayed on the common dimension line 
 lines are always positioned along the vertical and horizontal axes 
 dimension lines are presented on this element side where a discontinuance is 

found - dimension lines are drawn to reach the most distant corners (edges) of 
an element - identically as for overall dimensions  

o From edge 
 each dimension is presented on a separate dimension line 
 successive dimensions show distances from the common point to successive 

characteristic points of an element 
 dimension lines are presented on this element side where a discontinuance is 

found  
o Aligned 

 each segment of a dimensioned element’s edge is ascribed its own dimension 
line which is parallel to the dimensioned segment 

 in the case of arc segments, the chord is subjected to the dimensioning 
• Internal recess - these are the linear dimensions of recesses included inside the 

element contour:  
o Inside part 

 dimension lines are drawn inside the contour of a dimensioned element 
 all dimensions are presented on one dimension line (dimension chain) - 

vertical or horizontal 
 the dimension line is extended to the closest edge of a dimensioned element  

o Outside part - dimension lines are drawn outside the dimensioned element (the 
same rules are applicable as in the case of bevels and cuts) 

• Openings in view - these are the linear dimensions that indicate positions of drilled 
openings. Dimension points may be positioned at opening centers or at external points 
of the contour of a circle representing an opening; the Chain and From edge options 
are also available (as for bevels and cuts). 

• Perpendicular openings - these are the linear dimensions that indicate positions of 
drilled openings located in the plane perpendicular to the projection plane. The same 
rules apply here as for openings in view; the Chain and From edge options are 
available (as for bevels and cuts). 

• Angular - these are the dimensions displayed for the edges of a dimensioned element 
that are not parallel to the axes of the element local coordinate system 
o line with respect to which the dimension is to be determined (with respect to 

horizontal or vertical line)   
o value of the angular dimension expressed as: angle value or edge inclination 

 
Define arc dimensioning (these dimensions do not concern drilled openings and circles): 

• Diameters - for all circles (not arcs), a circle diameter is displayed. A dimension line 
coincides with the circle diameter positioned at an 45-degree angle to the horizontal 
axis. 

• Radial - for all arcs and circles, the radius is displayed. Circles are dimensioned in this 
manner if the Diameters option is not selected. A dimension line coincides with the 
radius set at an 30-degree angle starting from the beginning point of the arc.  

 

14.11. Reference point 
The reference point is an auxiliary point positioned at one of the 4 points of the main part, and 
may be shown in a drawing as .  
The reference point is used as an additional dimensioned point in generation of some 
dimensions (for example, absolute dimensions). It is positioned on one of the ends of the main 
part’s edge parallel to its axis (by default, the Bottom, Left point).   
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Position, size, and color of the reference point can be configured in the Reference point 
dialog,which opens when you click Ref. point in the New dimensioning style dialog. 
 

  
 

14.12. Geometrical dimensions (assembly) 
Use the tabs in this part of the dialog to define the following parameters: 

• Dimension format – as for single parts  
• Overall - the option operates identically as in the case of single parts   
• Part spacing - these dimensions display mutual position of the assembly component 

parts. The dimensions are shown on external dimension lines (vertical or horizontal), 
and are generated parallel to the overall dimension lines. The following options are 
available: 
o Contour  

 Dimensions along the main axis (horizontal dimensions) – beginning and end 
of a subpart is projected onto the direction parallel to the axis of the element’s 
main part  

 Dimensions transverse with respect to the axis (vertical dimensions) - 
beginning and end of a subpart is projected onto the direction parallel to the 
specified direction of dimensioning, and the reference point should also be 
projected on this line. If any of these dimension points is positioned on one of 
the edges of the main part, parallel to the axis of the main part, this point is 
not dimensioned; a given part is projected on the dimension chain positioned 
on this side where the edge closer to the dimensioned part is located. 

o Axes  
 Dimensions along the main axis (horizontal dimensions) – the point of 

intersection of the element axis and the main part’s edge, parallel to the axis 
and the closest to the geometrical center of the dimensioned subpart. 

 Dimensions transverse with respect to the axis (vertical dimensions) – 
significant only for elements whose axis is parallel to the axis of the main 
element  (the axis is projected onto the direction perpendicular to it). A 
dimension is placed on the vertical dimension line; if the axis of a dimensioned 
subpart coincides with the axis of the main part, then the dimension is not 
generated. 

o Point   
 Dimensions along the main axis (horizontal dimensions) – one of the edge 

points of a subpart is projected onto the direction parallel to the main part’s 
axis (a point positioned closer to the main part’s edge is selected). If both 
edge points of a subpart are located on the main part’s edge, the point closer 
to the reference point is dimensioned. 

 Dimensions transverse with respect to the axis (vertical dimensions) – the  
first (counting from the reference point) point met on the subpart’s edge is 
projected onto the direction parallel to the specified direction of dimensioning. 
The reference point should be projected onto this line, as well; if any of these 
dimension points is positioned on one of the edges of the main part, parallel to 
the main part’s axis, this point is not dimensioned. A given part is projected on 
the dimension chain positioned on this side where the edge closer to the 
dimensioned part is located. 
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o Optimal   
 Dimensions along the main axis (horizontal dimensions) – selection depends 

on a subpart type 
Plates perpendicular to the main part’s axis, set orthogonally – the axes option  
Plates perpendicular to the main part’s axis, set slanting - the point option  
Plates parallel to the main part’s axis – the contour option  
Profiles perpendicular to the main part’s axis – the point option  
Profiles parallel to the main part’s axis - the contour option  

 Dimensions transverse with respect to the axis (vertical dimensions) - 
selection depends on a subpart type: 
Plates perpendicular to the main part’s axis, set orthogonally - the point option  
Plates perpendicular to the main part’s axis, set slanting - the point option  
Plates parallel to the main part’s axis - the contour option  
Profiles perpendicular to the main part’s axis - the contour option  
Profiles parallel to the main part’s axis - the contour option  

 
Additionally, the following options are accessible (they parametrize the position of 
a dimension line): 
With overall – dimension lines are always placed on the same side as overall 
dimension lines. If the position of overall dimensions is not defined, lines are 
positioned according to the Optimal option. 
Optimal - dimension lines are placed on the element side that is closer to a 
greater number of dimension points. 

• Part dimensions – used to display only overall dimensions of subparts; dimensions are 
generated following the same rules as in case of the whole assembly. These lines are 
always generated as internal dimension lines, the orientation of which is determined in 
the local coordinate system of a dimensioned subpart or in the coordinate system of 
the main part of an assembly depending on the settings: part CS (Coordinate System) 
or assembly CS. If any of the dimensions generated by the algorithm is already shown 
on the external dimension line as an overall dimension, then it is not repeated. 

• Openings in view - used for dimensioning of opening positions with respect to the 
element’s main part. Dimensions in the direction parallel to the main axis are placed 
on the external dimension line, whereas transverse dimensions are positioned on 
external or internal dimension lines depending on an opening position in a part. The 
Axes and Contour options are taken into account for dimensions transverse with 
respect to the main element’s axis. 
Dimensions along the axis: all the dimensions are projected onto common external 
dimension line that is parallel to the main element’s axis. 
Dimensions transverse with respect to the axis: these dimensions are placed on 
external or internal dimension lines depending on opening positions. 
Dimensions on external dimension lines are generated for openings positioned on 
transverse edges of an assembly (in endplates). External dimension lines are 
positioned parallel to the direction specified for overall dimensions, and are always 
attached to the element’s overall dimension. 
Internal dimension lines are generated for openings positioned along the main 
element’s axis. They are always placed perpendicularly to the main element’s axis and 
as close as possible to dimensioned openings (in such a way so that they do not 
overlap with other elements in a drawing). Internal dimension lines are attached to the 
main element’s axis or to one of external edges of the main part that is parallel to the 
axis (an edge positioned closer to a greater number of dimensioned openings is 
selected). 

• Perpendicular openings –works the same as the Openings in view option, but if both 
options are selected, all points are projected onto a common dimension line. 

• Angular – the following parameters can be specified: 
o External – the dimensioning concerns external edges of the main part and of 

subparts placed outside the main part’s contour, positioned unorthogonally with 
respect to the coordinate system of the main part. An acute angle is always 
shown, the base of which is a vertical line. 
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o Internal - the dimensioning concerns edges of subparts placed within the main 
part’s contour, positioned unorthogonally with respect to the coordinate system of 
the main part. An acute angle is always shown, the base of which is an element’s 
edge parallel to the axis of the main part. 

o Both – dimensions are generated on the basis of both the internal and external 
options.  

 
The options of arc dimensioning operate identically as in the case of single parts.  
 

Define the Depth of a structure for which assemblies will be presented in drawings: 
• Relative – with respect to a value of the ‘depth’ of a whole structure (100% - total 

depth)  
• In absolute units – in current units 

 

14.13. Geometrical dimensions (group) 
Use the tabs in this part of the dialog to define the following parameters: 

• Overall - the option operates identically as in the case of single parts. 
• Axial dimensions - dimensions are generated as a dimension chain showing axial 

dimensions of a presented group. Dimension points are generated at points of axis 
intersection (for groups, axes of main assembly parts are displayed; therefore, axial 
dimensions are determined only for the visible axes). Available options:  
o Orthogonal - dimension chains are positioned along vertical or horizontal edges of 

the view. 
o Aligned - dimensions are positioned as parallel to the dimensioned segment, and 

are not extended to the most distant points of a group. Additional dimension points 
are generated at the beginning and end of the group where there are no axis 
intersections. 

o Both - both methods described above are applied. 
• Assembly dimensions - dimensions display the entire dimensions of assemblies 

included in a group, and are generated identically as overall dimensions for each 
assembly separately. Available options:  
o Chain - all dimensions are projected on a common external dimension line (chain) 

positioned vertically or horizontally. 
o From edge - each dimension is displayed on a separate dimension line, each of 

which is parallel to the axes of the local coordinate system. They are located on 
the side of a dimensioned element that is positioned closer to dimension points. 

o Aligned - dimensions are set in a parallel position with respect to the main 
assembly part (in the local coordinate system of the assembly), and are displayed 
on the external side of the assembly (in relation to the group center).  

• Angular - the option operates identically as in the case of single parts. 
 
The options of arc dimensioning operate identically as in the case of single parts.  
 

14.14. Geometrical dimensions (3D view) 
All dimensions generated automatically are positioned in one of the (orthogonal) planes 
belonging the local coordinate system of a part or group.   
For an object being dimensioned (part, assembly, or group) the software defines a rectangular 
prism circumscribed on the selected part (the prism is perpendicular to the local coordinate 
system of the object). Dimension lines are positioned in one of the planes of the prism, so that 
they do not conceal the object. In the upper left of the dialog are options that refer to these 
planes in which dimension lines are positioned: Distance to the first dimension line and 
Distance between dimension lines.  
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Single part or Assembly  
For a single part or an assembly, the Dimensions field includes options that let you select 
dimensions and direction to be generated automatically.  
 
Group  
Available options:   
Presentation - choose a method of displaying a part in the drawing:  

o Real – a full drawing of a part with all details is displayed   
o Simplified – profile fillets are ignored 
o Scheme – profiles are displayed as lines 
Specify settings for color, type, and thickness of a line displaying a profile.  

Dimensions 
For groups, the Dimensions field comprises options enabling selection of dimensions 
and direction to be generated automatically (for total dimensions, element axes, and 
workframe axes).  

14.15. Additional texts 
If the Comment option is selected, a title (name) is added to the views of a dimensioned 
object. The title may be text (comprising one or several lines) containing variables or any user-
defined character string. At the bottom of the Comments field are options that, when selected, 
add a variable to the defined comment at the cursor position. The complete text of the 
comment is displayed in the edit field.  
Available comment variables:  
%%Pos - if this is selected, a position description is added. 
%%Name - if this is selected, a profile or plate name (for example, IPE 100) is added.  
%%Scale - if this is selected, a scale (for example, 1:20) is added.  
%%Vname - if this is selected, an automatic name of a view or section is added. 
%%Length - if this is selected, profile or plate length expressed in the current project units is 
added.  
%%Mat - if this is selected, name of a part material is added. 
%%Quant - if this is selected, a number of elements of a presented position is added. 
%% Weight - if this is selected, a calculated part weight is added. 
%%Family - if this is selected, the name of a family to which the part belongs is added. 
%%Surf - if this is selected, a type of surface finishing of a structure element is added.  
 
You can specify a comment in a drawing that includes: 

• Text style 
• Position of a text in a view 
• Text aligning (align right, align left, center) 
• Color of the comment text 

14.16. Styles of descriptions and symbols 
In this part of the dialog, select styles for the following descriptions and symbols (designations) 
that display in final drawings: 

• Openings/bolts  
• Parts  
• Assemblies  
• Elevation marks  
• Weld symbols  
• Workframe axes 

 NOTE: 
The number of symbols depends on the selected category of dimensioning style (single part, 
assembly, or group).  
 
Clicking one of the (…) buttons to the right of the symbols opens the Styles of descriptions 
dialog with the symbol category selected.  
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15. DESCRIPTION STYLES 

15.1. Description styles 
Use the Styles of descriptions dialog to define description styles for elements. The dialog 
displays after you click a (…) button in the Dimensioning style settings dialog.  
 
To being defining a description, open the Styles of description dialog from:  

• Menu: Steel / Styles / Description styles 
• Ribbon: ASD - Drawings / Styles / Description styles 
• Command line: RBCS_DESCRIPTION. 

 

 
 
This dialog operates in a similar manner as the Dimensioning styles dialog. A set of 
description styles is saved to a DWG format file or in a template (a DWT file) .  
 
To display styles defined for a category type, select an option under Category. When you 
highlight an option for Style, all styles defined for the selected category are displayed. A 
preview of a selected style is shown in the Preview field.  
Available categories:  
• Openings/bolts  
• Parts / Assemblies  
• Elevation marks  
• Weld symbols  
• Workframe axes  

One style defined for each category is the default style, which will be applied during manual 
(not automatic) definition of symbols in a drawing.   
Use the buttons in the dialog:  
• New - click this to open a dialog where you can define a description style for a selected 

category. The name of thye new style and all its settings are inherited from the style 
currently selected. 

• Modify - click this to open a dialog where you can modify a description style of a 
selected category. 

• Delete - click this to delete the style currently selected from the list of available styles for 
a given category.   
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15.2. Styles of descriptions - Openings/Bolts 
Use the Openings/Bolts dialog to define a new style or modify an existing style of opening or 
bolt description.   
The dialog displays after you click New or Modify in the Styles of descriptions dialog when the 
Openings/Bolts category is selected.  
 

 
 
Define parameters:  

• Style name - use this edit field to specify a name for the style 
• Under Sight, select a method of opening generation in a drawing 

o Real - real opening edges are displayed (openings in view and perpendicular 
openings)  

o Real with axes - real opening edges are displayed (openings in view and 
perpendicular openings) with opening axes  

o Symbol - when this is selected, openings in view and perpendicular openings are 
displayed as symbols. Click the >> button to extend the dialog to include a library 
of symbols available  

o Fill holes – if this is selected, an opening for the Real or Real with axes option will 
be displayed as shown in the drawing below 

  
Use the buttons in the expanded dialog: 
 Edit - opens a dialog in which you can modify a selected symbol. 
 Add - opens a dialog where you can define a symbol (as an AutoCAD block). 

An insertion point for a defined block is treated as a center of a drilled opening 
(top view) or as an end of the opening axis (side view). 

 Delete - deletes a selected symbol  
Opening symbols must be defined as a pair: opening in view and perpendicular 
opening. For Size, specify the size of a symbol in a final drawing, expressed in the 
currently applied project units (for a symbol displayed in a top view). A symbol in a 
side view is scaled proportionally to obtain a specified size, but symbol length is 
adjusted to the thickness of a drilled part. 

• The Preview shows an opening.  
• Under Description, define a manner of opening description. Descriptions of openings 

are generated if Description is selected.  
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For Text style, select from the list of text styles defined in a DWG format file; the edit 
field below the list displays a description (text) syntax. Text may comprise any user-
defined character string. At the bottom of the Description field are options that, when 
selected, add a variable to the defined comment at  the cursor position:  
%%Holenum - if this option is selected, a number of openings in the opening group is 
added. 
%%Diasym - if this is selected, a ∅ symbol is added. 
%%Dia - if this is selected, a value of opening diameter is added. 
%%Boltsign - if this is selected, a bolt symbol is added. 
%%Bltlen - if this is selected, bolt length is added. 
%% Boltclass - if this is selected, a bolt grade is added. 
%%Desc - if this is selected, a bolt description is added. 

• If Groups on common leader is selected, one description (one leader) is generated for 
all openings in a group during dimensioning. If this is not selected, descriptions 
(leaders) are generated for each opening.  

 

15.3. Styles of descriptions - Parts/Assemblies 
Use the Part description style dialog to define a new style or modify an existing style of part or 
assembly description.   
The dialog displays after you click New or Modify in the Styles of descriptions dialog when the 
Parts or Assemblies category is selected.  
 

 
 
Define parameters:  

• Style name - use this edit field to specify a name for the style 
• Under Sight, select a method of opening generation in a drawing 

o Text on part - when this is selected, you can define a description in the Text field. 
Use the Frame shape field to specify a frame for the text. Text is placed within the 
contour of a dimensioned element (positioned to avoid overlapping of elements 
displayed in a drawing).  

o Leader – when this is selected, there are 3 edit fields available: Text over line, 
Text under line, Text in frame. Define each of them using any user-defined 
character string. 
There are options available under these fields that, when selected, add a variable 
to the defined comment at the cursor position:  
%%Pos - if this is selected, description of a position is added. 
%%Name - if this is selected, a profile or plate name is added. 
%%Length - if this is selected, profile or plate length is added. 
%%Mat - if this is selected, a name of a part material is added. 
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%% Weight - if this is selected, a calculated weight of a part is added. 
%%Quant - if this is selected, a number of parts is added. 
%%Surf - if this is selected, a type of surface finishing of a structure element is 
added (available in the Part description style dialog; it is not available in the dialog 
for the assembly description style). 
%%Family - if this is selected, the name of a family to which the part belongs to is 
added. 

• Text style - select a font to be applied in descriptions 
• Frame shape - select a frame shape for a leader: rectangular, rounded, or none 

(without frame) 
 

Text in leaders is positioned outside dimension lines in order to avoid overlapping of leaders 
with other drawing elements or leaders with other leaders.  
 

15.4. Styles of descriptions - Elevation marks  
Use the Elevation mark settings dialog to define a new style or modify an existing style of 
description of elevation marks; the elevation mark consists of a symbol and a coordinate.    
The dialog displays after you click New or Modify in the Styles of descriptions dialog when the 
Elevation marks category is selected.  
 

 
 
Define parameters :  

• Style name - use this edit field to specify a name for the style 
• Under Reference base, choose the coordinate system (global coordinate system of a 

model or local coordinate system of an element) that is the basis for defining elevation 
reference (coordinate) and direction. 

• If To main part is selected for assemblies and groups, limits are determined for a main 
part of the group and not for a group as a whole. 

• For Symbol, select an elevation symbol provided with the software.  
• For Mark, select a part of the element edge (upper limit, lower limit, or both) on which 

an elevation mark is to be generated. Symbols are generated automatically at the 
most distant point along the selected direction.  

• For Reach, define a point of connection between a symbol and an edge of a 
dimensioned element (from top, from bottom, or aligned). 

• Text style - select a font to be applied in descriptions.  
 
Symbols are located near edges of a dimensioned element (inside dimension lines).  
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15.5. Styles of descriptions - Weld symbols 
Use the Weld description style dialog to define a new style or modify an existing style of weld 
symbol description.    
The dialog displays after you click New or Modify in the Styles of descriptions dialog when the 
Weld symbols category is selected.   
 

 
 
Define parameters :  

• Style name - use this edit field to specify a name for the style 
• Arrow shape - select a shape from the list; a user-defined shape is available, as well   
• Text style - select a font to be applied in descriptions 

 
The weld symbol is composed of the following elements:   

• Leader ended with an arrow  
• Line  
• Weld symbol   
• Weld thickness and length (expressed in mm) – click the corresponding buttons to 

automatically place the dimension in  the active text field.  
• Additional designations 

The following rules apply to generation of weld descriptions:  
• All visible welds are given a description. 
• An arrowhead that indicates an edge is attached to the center of gravity. 
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• The arrow line may intersect an element edge or a dimension line. 
• Weld description and extension line may not overlap with the element edge or a 

dimension line. 
Under Description, configure a weld description: 

• Leader - the description may be positioned in the following locations (numbering 
corresponds to the drawing below):  
1. Above the extension line before the weld symbol  
2. Above the extension line behind the weld symbol  
3. Under the extension line  
4. Behind the extension line 

 

  
 

• Text over seam - a description specified in the edit field will be placed above the weld 
seam (any character string with the possibility to use variables, such as %%weldth-
%%weldlen) – see the drawing below.   

 

  
 
 

• No description (only a weld is drawn) 
 
In all locations, variables may be used (as in bolt descriptions). Two variables of weld 
description are available:    
%%weldth – weld thickness 
%%weldlen – weld length 
 
Descriptions are generated for all welds displayed in a selected projection of an assembly or 
group.  If there are several welds of the same parameters located close to each other, it is 
possible to generate one description on several leaders.   
If Draw invisible with dashed line is selected, invisible weld edges (concealed by other 
elements) are displayed in a drawing by means of a dashed line. If this option is not selected, 
invisible edges are not drawn.    
 
If a circumferential weld forms a closed contour in a model, the software automatically 
identifies such welds in all drawings. An additional symbol (a circle) is added to the weld 
symbol in the same place as the site weld symbol.   
You can use a line to identify a weld face in 2D drawings (when the Identity line option is 
selected). The identity line may be placed under or above an extension line, and  is denoted 
with a dashed line of the same thickness as the extension line.    
If Prefix for fillet welds is selected, it enables:   

• Selection of the a option – for a weld description, the software reads the thickness 
specified in the weld definition in a model, and enters a prefix before the weld 
thickness (a5).  

• Selection of the z option - for a weld description, the software calculates the value z= 
a√2 and enters e.g. z7 as the weld thickness. 

If Prefix for fillet welds is not selected, only the weld thickness (from a model definition) is 
provided.   
For 2D drawings, it is possible to display a graphical symbol of a weld using one of the lines 
shown below (the options are available for selection under Graphic symbol): 
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These lines can be configured separately for workshop welds and site welds. Line thickness 
and color are assumed to be the same as for the extension line.    
 
In the lower part of the dialog, you can specify description parameters for intermittent welds: 

• Leader  
A description may be positioned in the following locations (numbering of the 
description locations corresponds to the numbering in the drawing below):  
1. %%weldth 
2. Metric units: %%NumOfSeg x %%LengthOfSeg 
    Imperial units (USA) %%LengthOfSeg - %%DistBeetwAxis 
3. (%%LengthOfSpace) 
4. Any character string 
 

CHAIN WELD 

  
 

 STAGGERED WELD 

  
 

 STAGGERED WELD 

  
 

• Text over the weld seam 
A description (any character string) specified in the edit field will be positioned over the 
weld seam.     

 
• No text (only a weld is displayed) 

In all locations, variables may be used (as in bolt descriptions). Several variables of weld 
description are available:   
%%weldth – weld thickness 
%%lengthofseg – length of a weld segment 
%%lengthofspace – spacing between segments of a weld 
%%distbetwaxis – distance between axes of weld segments  
%%numofseg – number of segments 
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15.6. Styles of descriptions - Workframe axes 
Use the Workframe axis dialog to define a new style or modify an existing style of describing 
workframe axes.    
The dialog displays after you click New or Modify in the Styles of descriptions dialog when the 
Workframe axes category is selected.    
 

 
 
Define parameters:  

• Under Axes, specify color, style, and line thickness parameters for workframe axes. If 
Horizontal, Vertical, and Radial are selected, the corresponding workframe axes will 
be displayed in drawings. If any of the options are not selected, the corresponding axis 
type will not display in drawings. 

• Under Labels, specify description parameters for workframe axes: 
o Vertical - axes may be displayed with labels (above the axis, under the axis, or on 

both sides) or without labels. If Rotate is selected, axis labels are rotated by 90 
degrees (see the drawing below).  

o Horizontal - axes may be displayed with labels (on the left side of the axis, on the 
right side of the axis, or on both sides) or without labels. If Rotate is selected, axis 
labels are rotated by 90 degrees (see the drawing below). 

  
• Elongation beyond element - workframe axes are contained within a rectangular 

contour, in which a dimensioned group is inscribed. The size of this contour is 
determined by a rectangle circumscribed on the group contour increased by the value 
defined in this field (this value is added to each side). Rectangle sides are parallel to 
view edges, as shown below: 
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o Green represents an element scheme    
o Blue represents element borders with a margin added on each side (a value of 

elongation beyond element defined in the above dialog)  
o Black represents the entire workframe  
o Red indicates which part of the workframe will be shown and where labels will be 

placed 
 

  
 

• Text style – select a font to use for workframe description; the list displays all 
AutoCAD® text styles available in the current project   

• Frame shape –select the label shape (rounded, rectangular, or none) for a workframe 
axis description 

• Style name - use this edit field to specify a name for the style 
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16. STEEL SUMMARY TABLES 

16.1. Steel summary tables - style manager 
Use this option to define/modify tables used to prepare steel tables. 
 
To begin working with tables, open the Steel summary tables - style manager dialog from:  

• Menu: Steel / Tables / Styles 
• Ribbon: ASD - Drawings / Settings / Table styles 
• On the command line, enter RBCS_LISTTEMPL. 

 

  
 
Available steel summary tables, listed under Table:  

• Material summary  
• Plate summary  
• Profile summary  
• List of profiles by section type  
• User parts  
• Element list  
• Assembly list   
• Bolt (rivet) list 
• Cut list  
• Bolt list  
• Mark list. 

 
For each table type, the standard table style (displayed under Table style) has been defined in 
the software. After the table type and table style are selected, the current table view is 
displayed in the Preview field.  
Use the buttons on the right of the dialog: 

• Default - click this to restore the default (standard) table layout (description style). 
• New - click this to open the Definition of new steel summary table style dialog, where 

you can define a new style of a selected table type (based on the style that already 
exists). 

• Modify - click this to open the Modification of steel summary table style dialog, where 
you can make changes in a selected table type and table style. 

• Delete - click this to delete a highlighted table style from the list of styles available in 
the Table style field.  
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16.2. Definition/modification of steel summary table 
style 

Use the Definition of new steel summary table style dialog to define a new style or to modify 
an existing style of a table type.  
 
The dialog displays after you click New in the Steel summary tables dialog (the Modification 
dialog displays after you click Modify).   
 
The dialog consists of 4 tabs:  

• Components and table layout  
• Font, color, line  
• Options  
• Sorting and detailed options.   

 

 NOTE: 
If one of the steel summary table types (Assembly list) is selected, there is also a Syntax of 
summary line tab available.   
 

16.3. Components and table layout 
The image below displays the Components and table layout tab of the Definition/modification 
of steel summary table style dialog.   
 

  
 

 NOTE: 
The options on this tab depend on a table type selected in the Steel summary tables - style 
manager dialog. The example above displays the options available after selecting the element 
list.  
 
At the bottom of the dialog, for Style name, enter a name of the table style defined (when 
modifying the table style, the Style name field is inaccessible).  
To define/modify a table style: 

• Select a set of table components (in the example shown, they include Bars, Surface, 
Masses, Summaries, Element, and Forces).  

• In the next field, select the components to be included in the table  
• Click the >> button.  

The right part of the dialog displays the defined table layout.   
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Specify additional parameters:  
• Total table width - read-only field that displays the width of the defined table; 

determined in the software.  
• Zoom control buttons (Zoom in, Zoom out, 100%) that let you change the zoom factor 

of the table displayed.  
 
Using the tables, you can: 

• Add blank lines at the beginning and end of a table  
• Add blank columns in tables 
• Define table dimensions (column width and line height) – dimensions of the column 

width and the line height are displayed under the table and on the left of the table, 
respectively.    

 

16.4. Font, color, line 
The image below displays the Font, color, line tab of the Definition/modification of steel 
summary table style dialog.   
 

  
 
Use the available options to specify:  

• Font style, color, and alignment used in the table header and in all table cells  
• Line thickness and color  
• Font style, color, and alignment used in the table title (if Table with title is selected on 

the Options tab)   
 

16.5. Options 
The image below displays the Options tab of the Definition/modification of steel summary table 
style dialog.   
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Specify options: 

• Automatically adjust row height - if this is selected, the height of table rows will be 
automatically adjusted to the size of symbols of element shapes displayed in the table. 

• Table without heading - if you select this, the table will be generated without a header. 
• Hide horizontal table lines - if this is selected, horizontal lines will not be displayed in 

the table. 
• Hide vertical table lines - if this is selected, vertical lines will not be displayed in the 

table. 
• Table with title - if you select this, the edit field in the lower part of the dialog becomes 

available and you can enter a table title. Use the Font, color, line tab to define a table 
title font. 

 

16.6. Sorting and detailed options 
The image below displays the Sorting and detailed options tab of the Definition/modification of 
steel summary table style dialog.     
 

  
 
Specify parameters: 
 

• Sorting parameters 
o Key for table sorting – this is available when Steel Summary table is selected, and 

it lets you sorting the steel summary table by position, steel grade, or section (by 
default, it is sorted by position numbers). 
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o Print intermediate sums – if this is selected, the table displays individual masses 
of individual elements of a steel structure (the total mass of all elements is 
displayed at the end of a table).     

• Summary table parameters 
o Add weld mass - define a value (expressed in percentage) that will be added to 

the total mass (for example, if you specify 2%, the total mass will be multiplied by 
the coefficient 1.02).    

 
At the bottom of the dialog is the Gross weight - plates option. If this is selected, the weight of 
plates will be calculated as a weight of a plate sheet from which the plate is made (without 
considering machinings). If this is not selected, the weight of plates will be a net weight that 
includes all machinings of plates (chamfers, drilled openings, and so on). 
 

16.7. Syntax of summary line 
The image below displays the Syntax of summary line tab of the Definition/modification of 
steel summary table style dialog.   
 

 NOTE: 
The tab is available only for the Assembly list type of steel summary table.  
 

  
 
Use the options on this tab to define a syntax of the first line (heading) of the assembly list 
table that contains the summary of assemblies. You can access the mechanism of the 
arbitrary composition of syntax and contents of the summary line.  
What you select under Syntax elements is displayed in the Syntax field. The Preview displays 
the description of the summary line resulting from the defined syntax. This description is based 
on fixed numeric values and responds to changes in the preferences (modification of unit, 
precision).   
Available syntax element variables:  
 %pos  - position  
 %draw  - drawing number  
 %num  - number of items  
 %name  - element name  
 %len  - total length  
 %surf  - painting surface  
 %type  - surface type   
 %elem  - element mass  
 %tot  - total position mass 
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16.8. Example of generating and setting a table style  
Creating tables of the bill of materials will be illustrated using automatic positioning and 
generating printouts. After positioning and generating printouts for position b2, the drawing in 
the figure below displays.  

  
 
To generate a table of the bill of materials in the displayed drawing:  

1. Click the Bill of materials  option. 
2. In the drawing area, click to specify the insertion point of the table.    

 

  
 

3. Select the table, right-click, and click Object properties.  
4. In the Modification of selected table dialog: 

• On the Selection of table style tab, change the height of table rows. 
• On the Options tab, select Table with title. 
• In the edit field in the lower part of the dialog, enter a name (for example, Steel 

table – position b2).  
• Click OK to update the table. 
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17. PRINTOUT 

17.1. Table printout manager 
Use this option to define/modify the printout layout for tables used to prepare steel summary 
tables. 
 
To begin defining a printout layout, open the Table printout manager dialog from:  

• Menu: Steel /  Tables / Table Printout Manager (steel part) or Reinforcement  / 
Reinforcement table / Table Printout / Export / Edit  (reinforcement part) 

• Ribbon: ASD - Drawings / Tables / Table Printout Manager (steel part) or ASD - 
Reinforcement / Reinforcement table / Table Printout / Export / Edit (reinforcement 
part) 

• Toolbar: Table Printout Manager (steel part)  or Table Printout / Export / Edit 

(reinforcement part)  
• Command line: RBCS_LISTPRINT (steel part) or RBCR_LIST_EXP (reinforcement 

part). 
 

 NOTE: 
If you select Automatic table update on the Structural Detailing tab of the Options dialog, 
reinforcement tables in AutoCAD® Structural Detailing - Reinforcement will be updated 
automatically after changes are made in a drawing.  
 

 
 
 
The Table printout manager dialog has 2 primary parts:   

• On the left is the selection tree (see the drawing below) from which you can select one 
of the printout manager options   
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• To the right of the selection tree are the parameters that relate to the option you 
selected in the selection tree. The top part of the dialog shows the layout of a selected 
table type.   

• Use the icons at the top of the dialog: 

 Printout preview - click this to open a preview of a table printout; return to the 
dialog by clicking Close  

 Print table - click this to start printing a table   

 Save table - click this to open the dialog in which a table may be saved in  MS 
Excel®:  
o *.CSV (Comma Separated Values) format files which are text files  
o *.XLS format files – this saving method fully reflects table settings that can be 

seen in a preview window   

 Save table (MS Word) - click this to open the Save As dialog, where you can 
save a table in an MS Word file with the specified name  

 Save graphical settings  - click this to save current settings of the printout 
manager  

 Automatic adjust of column width to header text  - click this to adjust the width of 
table columns to the length of table column names 

 Help  - click this to open Help 
 

 NOTE: 

For AutoCAD® Structural Detailing – Reinforcement, an additional icon  lets you insert a 
table into an edited drawing.  
 

Although a table shape (cell height, column width) depends directly on a defined table style, 
you can determine the shape.  
In addition, there is a context menu with the following options: 

• Table cells – group (merges several table cells into one cell) or ungroup  
• Text orientation – vertical, horizontal  
• Adding or deleting a column in the table  
• Adding or deleting a row in the table 

 
The example below shows a table layout after adding a new column at the beginning of the 
table, merging several table cells, and changing text orientation to vertical. The table displays 
data for a few positions of structure element reinforcement.  
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17.2. Table composition 
After you select Table composition from the selection tree in the left part of the Table printout 
manager dialog, the options shown below display on the right.  
 

 
 
For steel structure elements, choose a table type:  

• Material summary 
• Plate summary 
• Profile summary 
• User parts 
• Element list  
• Assembly list 
• Bolt (rivet) list 
• Cut list 
• Bolt assign 

 
For RC structure elements, choose a table type:  

• Main (reinforcing bars) 
• Summary (reinforcing bars) 
• Detailed (reinforcing bars) - this requires graphically selecting the distribution varying 

linearly / surface bar distribution or entering a number of reinforcement position  
• Main (elements) – see the description of the Element manager dialog  
• Main (wire fabrics) 
• Summary (wire fabrics) 

For each table type, you can choose a table style defined previously for the selected table 
type.  
Click Create to generate a table of a given type based on the current element list (if the list is 
empty, a printout of a whole structure is made) in the format of the active table style (see: 
Styles applied in tables).   
 
The List of elements field displays numbers of the elements included in a table. Clicking 
Selection closes the dialogs and lets you graphically select elements to be included in the 
table.   

 © 2010 Autodesk, Inc. All rights reserved          



page: 136 AutoCAD Structural Detailing - Steel - User Guide 

Clicking Edit table lets you graphically indicate the table to be edited. Changes made in a table 
may be saved after you click Save changes.  
Use the options at the bottom of the dialog:  

• Number of first page - specify a number of the first page to be printed  
• Add header - if this is selected, a defined header will display on a printout  
• Add footer - if this is selected, a defined footer will display on a printout 

17.3. Page setup 
After you select Page setup from the selection tree in the left part of the Table printout 
manager dialog, the options shown below display on the right.  
 

 
 
Determine the manner of table presentation:   

• Under Titles and table lines: 
o Vertical lines – if this is not selected, no vertical lines are displayed in a table   
o  Horizontal lines – if this is not selected, no horizontal lines are displayed in a table  
o Print black and white – if this is not selected, a table is printed with the defined 

colors applied  
• Under Center table on a page, specify how a table is to be centered (horizontally, 

vertically, or both)    
• Under Orientation, define paper orientation (Portrait - the longer side of a paper sheet 

is vertical or Landscape - the longer side of a paper sheet is horizontal) 

17.4. Frames 
After you select Frames from the selection tree in the left part of the Table printout manager 
dialog, the options shown below display on the right.  
 

 
 
Determine the manner of table framing: 

• None - no separation between a header/footer and table   
• Border lines – includes lines that separate header and footer from the table   
• Frames for – select to include frames for the header, the table, the footer, or any 

combination of the three  
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17.5. Distances 
After you select Distances from the selection tree in the left part of the Table printout manager 
dialog, the options shown below display on the right.  
 

 
 
Under Margins, specify left, right, top, and bottom page margins. 
Under Distances, define distances between the table frame and the header or footer.   
The size of a header and footer is calculated automatically in the software; the parameters 
mentioned depend on a size of the applied font, size of a drawing with the company logo, and 
number of lines required in a header or footer. 
 

17.6. Colors and formats 
After you select Colors and formats from the selection tree in the left part of the Table printout 
manager dialog, the options shown below display on the right.  
 

 
 
Under Set colors, specify the color of: 

• Table lines 
• Separator 
• Tracking line 
• Dragging line 
• Table background 

 
Under Styles and formats, you can select formats and styles applied in the following table 
elements: table column headers, table row headers, and text contained within a table. 
ClickModify to open the dialog whereyou can format font, font color, and alignment method for 
the selected table elements.  
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17.7. Header 
After you select Header from the selection tree in the left part of the Table printout manager 
dialog, the options shown below display on the right.  
 

 
 
In order to change the layout of the printout header, select the table field you want to change, 
and then select a value from the list. To select a font for a particular field, position the cursor in 
the field, and click Font. In the dialog that opens, you can choose the font to be applied.     
 

17.8. Footer 
After you select Footer from the selection tree in the left part of the Table printout manager 
dialog, the options shown below display on the right.  
 

 
 
In order to change the layout of the printout footer, select the table field you want to change, 
and then select a value from the list. To select a font for a particular field, position the cursor in 
the field, and click Font. In the dialog that opens, you can choose the font to be applied.  
 

17.9. Parameters 
After you select Parameters from the selection tree in the left part of the Table printout 
manager dialog, the options shown below display on the right.  
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The dialog contains all the variables defined in the system and their names.  

 

 NOTE: 
In order to confirm a variable and its modifications, click Set.  
 
Variables used for formatting the header and footer of the printout:  
VAR_PAGE_NUMBER - lets you assign a current printout page. If VAR_PAGE_TOTAL is 
used, text assigned to the variable will precede the total number of pages (for example, Page 
1, Page 2, and so on)  
VAR_PAGE_TOTAL - value of this variable indicates the total number of printout pages. Text 
assigned to it may be preceded by a current page number, if the VAR_PAGE_NUMBER 
variable is used. 
VAR_DATE, VAR_TIME - these variables may be assigned any text and combination of the 
key words displayed below (prints the current date/time on a printout): 
%A - full week day name (Monday) 
%a - abbreviated week day name (Mon)  
%B - full month name (January)  
%b - abbreviated month name (Jan)  
%c - standard presentation of date and time  
%d - month day (01-31) 
%H - time (24-hour clock) (00-23) 
%I - time (12-hour clock) (01-12) 
%j - successive day of the year (001-366) 
%M - minute (00-59) 
%m - month (01-12) 
%p - local equivalent of the English abbreviations AM / PM 
%S - second (00-59) 
%U - successive week of the year (first day - Sunday) (00-53) 
%W - successive week of the year (first day - Monday) (00-53) 
%w - day of the week (0-6, Sunday is denoted by 0) 
%X - standard time representation  
%x - standard date representation  
%Y - year and century 
%y - year without the century specified (00-99) 
%Z - time zone name  
%% - percent mark 
Standard date representation is the following string of variables:   %a %b %d %Y 
Standard time representation is the following string of variables:  %H:%M:%S 
Standard date and time representation is the following string of variables:  %a %b %d 
%H:%M:%S %Y.  
 
The remaining variables listed below do not contain other values than user-defined text. Their 
names serve only for the purpose of convenient classification while formatting.   
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The following printout variables may be used in AutoCAD® Structural Detailing - Steel: 
VAR_POS - position name  
VAR_SCALE  - drawing scale 
VAR_PART  - part name 
VAR_MATERIAL - part material 
VAR_LENGTH - part length  
VAR_WEIGHT - part weight 
VAR_PAINTAREA - painting area 
VAR_QUANTITY - number of items of a given position in the project 

17.10. Templates 
After you select Templates from the selection tree located in the left part of the Table printout 
manager dialog, the options shown below display on the right.  
 

  
 
You can select templates for printing tables to the following programs: 

• MS Word®: DOT format files 
• MS Excel®: XLT format files 

In the edit fields, specify file names with a full access path. After you click Search, you can 
specify a template file from the computer hard disk.   
 
In AutoCAD® Structural Detailing - Reinforcement, there are additional options available for 
printouts to MS Word®. They let you insert an additional summary table that includes 
information about the reinforcement (if Attach summary table is selected). You can set the 
table either at the end of the entire printout or for several successive reinforcements on a 
page.  
Additional options: 

• Automatic column width - when this is selected, widths of table columns are 
automatically adjusted to fit the length of names of table columns. 

• Automatic row height - when this is selected, heights of table rows are automatically 
adjusted to contents of table rows.  

 

  
 

17.11. List of commands available in the printout 
module 

This module enables printouts. The following commands are available:  
 
RBCT_ACTDOC  
Available for a selected document located in the option tree; activates a selected document 
(for its edition) in the edition layout. There may be many documents created, but only one is 
active, i.e. may be edited.  
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RBCT_ADDTOPRINT  
Available for a selected view located in the position tree; composes a final printout. The layout, 
to which the view is to be added, must be active. The command adds a selected view to the 
current layout (printout); NOTE: a view may be contained only on one printout.  
 
RBCT_ADDALLTOPRINT 
Available for a selected document provided in the position tree; composes a final printout. The 
layout, to which the view is to be added, must be active. The command adds all the views 
belonging to a given document (not added to other printout, yet) to the current layout.   
 
RBCT_FITVIEWS 
Available for an active document – provides greater work convenience to the user. The edition 
layout must be active. The command results in adjusting dimensions of views included in the 
edition layout to the current size of the AutoCAD® program window.    
 
RBCT_DELPRINTOUT 
Available for a selected printout in the printout tree; the command is used to delete a printout. 
The command also deletes the corresponding layout. 
 
RBCT_REMFROMRINT 
Available for a selected view provided in the printout tree; the command removes a view from 
a printout; the command removes the view only from a printout - it remains in a document and 
may be reused (e.g. by adding it to other printout).  
 
RBCT_DELALLFROMPRINT 
Available for a selected document located in the printout tree; the command removes views 
belonging to a selected document from the printout. The views remain in a document and may 
be reused (e.g. by adding them to other printout).  
 
RBCT_DELDOC 
Available for a selected document located in the position tree; the command deletes a 
document from the list of documents created for a given position.   
 
RBCT_EDITVIEW 
Available for a selected view provided in the printout tree; the command switches to the edition 
mode for a selected view. The command enables you to switch from edition of a printout to 
edition of a view (drawing) included in it. The command activates the edition layout and a 
document whose component is the selected view.  
 
RBCT_EDITDOC 
Available for a selected document provided in the printout tree; the command used to switch to 
the edition mode of a selected document. The command enables you to switch from edition of 
a printout to edition of views (drawings) included in it. The command activates the edition 
layout and the selected document.  
 
RBCT_MEDIT_ON 
Available for an active document containing one view; the command allows editing a 
document in the model layout.  
 
RBCT_MEDIT_OFF 
The command restores the standard functionality of the model layout.  
 
RBCT_REG_LAYER 
Available for the active document and view; after adding a layer, you can change its name by 
means of the options available in the AutoCAD® program. The program manages layers 
within the available views and documents. A layer must be added using the AutoCAD® 
Structural Detailing options (the problem concerns only the layers used in the edition layout).  
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RBCT_DELETEPOS 
Available for a position selected in the position tree; the command is used to delete a position; 
NOTE: only positions that are defined may be deleted - positions created on the basis of 
model elements cannot be deleted.   
 
RBCT_RENAMEPOS 
Available for a position selected in the position tree; the command enables changing the name 
of a position.  
 
RBCT_RENAMEVIEW 
Available for a view selected in the position tree; the command enables changing the name of 
a view.  
 
RBCT_RENAMEDOC 
Available for a document selected in the position tree; the command enables changing the 
name of a document. 
 
RBCT_RENAMEPRINTOUT 
Available for a printout selected in the printout tree; the command enables changing the name 
of a printout; a printout name is always identical to the name of a layout (printout) 
corresponding to it.  
 
RBCT_ACTVIEW 
Available for a view selected in the position tree; the command makes the view of the 
AutoCAD® program which corresponds to the selected view, become active; NOTE: a view 
must be a component of the active document.  
 
RBCT_ADDTEMPLATE 
The command results in adding a new template in the dialog; which opens once this option is 
selected. You can specify the name of a new template and choose one of the registered 
template types.  
 
RBCT_DELTEMPLATE 
Available for a template selected in the template tree; the command deletes a selected 
template.  
 
RBCT_RENAMETEMPLATE 
Available for a template selected in the template tree; the command allows changing a name 
of a selected template.  
 
RBCT_ACTTEMPLATE 
Available for a template selected in the template tree; the command activates a selected 
template in the template layout (it enables its edition).  
 
RBCT_ADDVIEWPORT 
Accessible for an active template in the template layout; the command adds a view to the 
active template in the dialog box; which opens once this option is selected. You choose view 
name, scale and type; name and scale of the view may be changed at any time, as regards 
the type, it cannot be modified.  
 
RBCT_DELVIEWPORT 
Accessible for a view selected in the template tree; the command enables deleting a view.  
 
RBCT_APPENDDOC 
Available for a position selected in the position tree; the command adds a document to the 
selected position in the dialog; which opens once this option is selected. You can specify the 
name of a document and select a template based on which the document is to be created.  
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RBCT_CNGSCALE 
Accessible for the active view located in the edition layout; the command allows changing the 
view scale; the scale is expressed as the natural number n, which denotes the scale 1 : n.  
 
RBCT_SETVIEWRANGE 
Available for the active view located in the edition layout; the command allows setting the view 
area visible on the printout. You select (with a rectangle) a part of the view which is to be 
visible on the printout. Edit operations in the edition layout do not result in modification of a 
defined print area.  
 
RBCT_REFRESHDOC 
Accessible for a document selected in the position tree; the command enables refreshing a 
selected document. If the element of a structure model (for which the position has been 
defined), changes, then the documents created for this position are refreshed. A document 
that needs to be refreshed is marked with a red diagonal.  
 
RBCT_REFRESHALLDOC 
Available for a position selected in the position tree; the command enables refreshing all the 
documents belonging to a selected position. If the element of a structure model (for which the 
position has been defined), changes, then the documents created for this position are 
refreshed. A document that needs to be refreshed is marked with a red diagonal. 
 
RBCT_PRINTVFRAMEON 
Available for all defined, printout views.  
 
RBCT_PRINTVFRAMEOFF 
Available for all defined, printout views; areas marked with rectangles (they determine views of 
the AutoCAD® program) will not be printed.   
 
RBCT_ADDDETAILVIEW 
Accessible for the active view provided in the edition layout; the command enables adding a 
new view based on the active view. Once the command is selected, you select (with a 
rectangle) a part of the active view that is to become a new view. A view created in this 
manner is of the same type as the initial view and is positioned in the same place in the edition 
layout. A new view is added to the position tree; the new view contains copies of the elements 
included in the selected rectangle. The created view may be edited independently of the initial 
view. The command is useful when it is necessary to have another drawing (of the same part) 
to edit it independently or two drawings of different scales. 
 
RBCT_ADDVIEW 
Accessible for the active view provided in the edition layout; the command enables adding a 
new view based on the active view. Once the command is selected, you can select (with a 
rectangle) a part of the active view that is to become a new view. A view created in this 
manner is of the same type as the initial view and is positioned in the same place in the edition 
layout. A new view is added to the position tree; the new view contains the same elements as 
those included in the selected rectangle. If the created view is to be edited; it also makes 
changes in the initial view. The command is useful when several independent views are to be 
created out of one large view (drawing) which is not added to the printout; all the views 
created are assigned the same scale.  
 
RBCT_DELVIEW 
Available for a view selected in the position tree; the command enables deleting a view that 
has been added by means of the following commands: RBCT_ADDDETAILVIEW or 
RBCT_ADDVIEW. 
NOTE: The original view contained in a template, from which the document has originated, 
cannot be deleted.  
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RBCT_SHOWIEW 
Accessible for a view selected in the position tree; the command allows edition in the active 
view; if additional views have been added to the document during edition, then not all the 
views are visible in the edition template.   
 
RBCT_REGMODELLAYERS 
Available for the whole project; the command enables work optimization; once this command 
is selected, you can declare the layers intended for work in the model; while working in the 
edition layout. Layout (printout) or template layout, the layers are frozen. It brings about 
optimization of the REGENALL command operation.   
 
 

18. AUTOMATIC DRAWING GENERATION 

18.1. Automatic drawing generation 
After you define a steel structure model, use this option to generate workshop drawings for 
selected positions. After choosing a position, you can automatically generate drawings for 
single parts or assemblies.   
To begin generating drawings, open the Automatic drawing generation dialog from:  
• Menu: Steel / Automatic printouts 
• Ribbon: ASD - Drawings / Generate drawings / Automatic printouts 

• Toolbar: Printout / Automatic printouts  
• Command line: RBCS_AUTOPRINT. 

 
To generate final drawings:    

1. Select positions for which drawings are to be generated. 
2. Select templates for drawings of single parts. 
3. Select templates for drawings of assemblies.  
4. Select formats and scales. 
5. Determine rules of assigning names to files. 
6. Run automatic generation of final drawings. 
7. Generate a final table. 

 
After you select structure elements, use the tabs on the Automatic drawing generation dialog 
to specify parameters:  

• Templates  
• Formats and scales  
• Options  
• Bill of materials  

 
Click OK to start the operation of automatic drawing generation.    
 
See also: 
Example of positioning and automatic generation of printouts  
 

 © 2010 Autodesk, Inc. All rights reserved          



AutoCAD Structural Detailing - Steel - User Guide  page: 145 

18.2. Templates 
On the Templates tab of the Automatic drawing generation dialog, you can define the type of a 
part and the family to which it belongs.    
 

  
 
Assign a single part template or an assembly template to each family: 
• For profiles or bent profiles, assign a default single part template. 
• For plates, assign a default single part template. 
• Assign a default assembly template.  

AutoCAD®Structural Detailing templates define a set of parameters for each view and for a 
set of views and scales.  
For automatic generation of drawings, a scale for views is defined in the dialog rather than 
taken from a template.   

 

18.3. Formats and scales 
On the Formats and scales tab of the Automatic drawing generation dialog, you can define 
scales, formats, and views for an option (object) selected in the Part type field.    
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For Scales, you can define scale values between 0.1 and 500. To add a scale value, click the 
+ button. Click the – button to delete the currently selected scale value from the list. If you 
select Automatic scale, the Scales field is no longer available, and the scale is calculated by 
the software in such a way that it lays out the drawings on the printout optimally.        
For Formats, you can specify any number of template files. To add a template to the list, click 
the + button (an additional dialog opens, where you select a *.dwt format file). To delete the 
currently selected template from the list, click the – button. After you choose a template on the 
list, you can click the ↑ ↓ buttons to move the template up or down in the list. When you 
generate views of parts, templates are viewed from top to bottom of the list.           
 

 NOTE: 
For templates used for automatic printouts, it is necessary to specify the Layout option in the 
definition of the plot area in the plot settings.  

 
Under Arrange views, specify view parameters:  

• Distance between views – distance between views as they are displayed on the 
printout   

• Number of views (left) and number of views (right) – number of views (sections) 
located in the drawing to the left or to the right of the front view.   

• Mode 
o Single position –select this to place each position in a separate drawing. 
o Assembly and parts - select this to display all components of an assembly in one 

printout. 
o Many positions – after you select a format, positions are arranged in drawings so 

that each drawing contains many positions and all the positions are included in the 
drawings. 

o Templates of plate marking (T-line) – in this mode, plate drawings will be made in 
the scale 1:1 and will be arranged so that the maximum use of drawing space is 
ensured  (positions not corresponding to plates are ignored in this work mode). 
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After selecting the According to template option, the previous options become unavailable. 
Views are generated based on the template settings.  
 
If the Automatic cuts option is selected, cuts are created in views based on the user-specified 
parameters (standard view and maximum number of cuts).  
 

18.4. Options  
On the Options tab of the Automatic drawing generation dialog, you can specify various 
parameters, including printout naming and options for saving.    
 

  
 

Under Names of printouts, you can select a method of defining names of files and layouts. A 
printout name may be identical to the position name or you can specify a prefix for the 
printout name. Also, you can specify a page number from which the printout numbering will 
start.  
Under Create documents, If Delete existing documents is selected, all documents with the 
specified name included in the existing printouts will be deleted when drawings are 
generated.  
Under Saving options, specify parameters:  
• Selecting Generate files enables selection of a folder where DWG files containing single 

printouts will be located (if Overwrite existing files is selected, all existing files will be 
replaced when drawings are generated).   

• Select Print to output the file to a plotter. 
• Select an available style from the Table of printout styles. 

If Overwrite existing files without confirmation is selected, files located in a selected folder will 
be replaced with newly generated files.  
If you select Insert projection planes into printouts, viewports will be inserted into printouts. If 
the option is not selected, blocks will be inserted into printouts.  
Select Start distributed work in order to divide a project into several parts (distributed work on 
a document); it ensures reduction of size of a file containing project data (quicker loading of a 
*.dwg file).   
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If the Skip elements without machining option is selected, elements without machining are not 
presented on printouts.     
  

18.5. Bill of materials 
On the Bill of materials tab of the Automatic drawing generation dialog, you can specify 
parameters for a bill of materials table.  
 

  
 

If Add table is selected, a steel summary table will be added to the printout. 
Specify the corner of the printout in which to locate the table:  
• Top - Right  
• Top - Left  
• Bottom - Right  
• Bottom - Left  
Click the Browse (…) button to open an additional dialog where you can choose a template 
of a steel summary table.  

 

18.6. Printout templates 
Printouts in AutoCAD® Structural Detailing - Steel (printout layouts) can be created based 
on user-created DWT files which are adjusted to typical formats and include templates of 
borders and drawing data tables according to user standards.  Drawing info tables can be 
filled automatically with appropriate information specified in the project preferences on the 
Project Info tab. To do this, provide the following text variables on the Printout layout in 
appropriate places: 
var_office  - Office field 
var_investor  - Investor field 
var_proj_name  - Project name field 
var_address  - Address field 
var_designer  - Designer field 
var_verif - Verified field 
var_date     - Date field 
var_rev  - Revision field 
var_note - Note field.  
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For the ‘automatic printouts’ mode you can also use the following variables associated with the 
printout:  
var_pos - Position name  
var_scale - Drawing scale 
var_part - Name of a part 
var_material - Material of a part 
var_length – Length of a part  
var_weight - Weight of a part 
var_paintarea - Painting area 
var_quantity - Number of a given type of items in the project 
var_lengthnu - Length of a part without specified units 
var_prndate - Date of generating the printout  
var_prndate - Time of generating the printout  
var_namenu - Element name without specified units for plates 
var_family - Element family  
var_surf - Surface finishing 
var_piecexp - Specifies if a given part is included in an assembly. 
 
 

18.7. Example of creating drawings (printouts) 
The example below is for creating drawings of a simple truss.  
 

  
 
To create a drawing of structure elements:  

1. On the Model tab of the Object Inspector dialog, select all the truss profiles (the 
profiles will be highlighted). 

2. Right-click, and click Auto positioning. 
3. In the Automatic positioning dialog:   

• On the General tab  
o For Positioning level, select single part. 
o For Prefix, select By family. 
o For Number, specify numerical format, start from 1, step = 1. 

• On the Additional tab, select all options. 
• On the Numbering tab  

o For Sort by, select element shape. 
o For Sorting criteria, select family.  

4. Click Run; all the truss elements will be assigned positions according to the 
parameters defined in the Automatic positioning dialog. 

5. On the Positions tab of the Object inspector dialog, select the first position p1 (the 
position will be highlighted). 

6. Right-click, and click Attach document (see the drawing below). 
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7. In the Select template dialog, select the template Profile 1:10 that will be used to 
create documents (projections), and click OK. In the edition layout, the software has 
generated projections / views for the selected position. 

8. On the Printouts tab of the Object Inspector dialog, right-click A1 ASD, and click 
Activate.    

9. On the Positions tab, right-click the first position, and click Add to current Printout. 
10. In the drawing area, click to specify the location of the document (projections of 

elements) in the printout layout. The selected drawing of the position has been added 
to A1 ASD on the Printouts tab in the Object Inspector dialog (part of this drawing is 
shown below).    
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18.8. Engineering drawing 

18.8.1. Engineering drawing 
Use this option to define and modify structure schemes. Access the option using one of the 
following methods from: 
• Menu: Steel /  Engineering drawings / Engineering drawings    
• Ribbon: ASD - Model / Groups / Engineering drawings    

• Toolbar: Engineering drawings / Engineering drawings   
• Command line: RBCS_SCHEME. 

  
After selecting the option, select elements belonging to the scheme.  
After selecting the structure elements, the Engineering drawing dialog displays; it has the 
following tabs:  
• Scheme  
• Printout.  

 
Click Save changes to save changes in a defined scheme without closing this dialog.  
Click OK to save changes in a defined scheme and close this dialog.   
 
 

18.8.2. Scheme 
Select the Scheme tab in the Engineering drawing dialog to display the following options.   
 

  
 
The Scheme tab has the following options: 
• Scheme name - use it to specify a scheme name; after defining or changing the name, 

click Save changes   
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• Select objects - clicking this button defines or modifies a selection of elements for a 
scheme; click this button to display the whole structure where you can select elements of 
the scheme; selected elements are displayed in red  

• Pick plane - clicking this button defines or modifies the XY plane of the scheme; click 
this button, next select the main part (it aligns the coordinate system) using one of the 
options:   

 UCS - the XY plane is set with respect to the current UCS 
 WCS - the XY plane is set with respect to WCS 
 3 points - the XY plane is defined by selecting 3 points 
• Add elements - clicking this button adds elements to the current element selection; click 

this button to display the whole structure where you can select elements to be added to 
the scheme; selected elements are displayed in red 

• Detach elements - clicking this button removes elements from the current element 
selection; click this button to display only elements belonging to the scheme; then select 
elements to be removed from the scheme. 

 
Use the options in the Types field to define or modify subgroups in a selected scheme: 
• Add new - clicking this button defines new types; click Add new to define a new type 

with a default name (which can be changed)   
• Remove - clicking this button removes a selected type from the list    
• Select objects - clicking this button defines or modifies a set of elements that belong to 

a selected type; click this button to display only elements belonging to the scheme;  then 
select elements belonging to a type (available types are: selection, family, position or 
mark)   

• Add elements - clicking this button adds elements to a selected type; click this button to 
display only elements belonging to the scheme;  then select elements to be added to the 
type  

• Detach elements - clicking this button removes elements from a selected type; click this 
button to display only elements belonging to the scheme;  then select elements to be 
removed from the type. 

 
 

18.8.3. Printout 
S
 

elect the Printout tab in the Engineering drawing dialog to display the following options.   
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At the top of the dialog select a template; a printout is generated based on this template.   
You can define any number of values in the Scales field; the allowable scale values are those 
from the interval 0.1 and 500. Click + to define a new scale value; click – to remove a selected 
scale value from the list. Under this field is the Automatic scale options; if selected, the Scales 
1:n field is not available and the software calculates the scale as to ensure that the printout 
layout if optimally filled with drawings.  
You can define any number of template files in the Formats field. Click + to add a new 
template to the list (it opens an additional dialog where you can select a *.dwt file); click – to 
remove a selected template from the list. To move a template up or down on the list, select a 
template and click ↑ or ↓ , respectively. When views of parts are created, templates are 
viewed from top of the list to the bottom.  
 
If the Add table option is selected, a steel summary table is added to the printout; to specify 
the position of the table on the printout, select one of the following options:  
• Top - Right (corner of the printout)  
• Top - Left  
• Bottom - Right  
• Bottom - Left.   

Click (…) to open the Steel summary tables – style manager dialog where you can select a 
steel table template.  
Click Options to open a dialog with options used for generating a scheme drawing.  
Click Generate to start generating a scheme drawing.  
 

18.8.4. Generating a scheme drawing 
Click Options in the Engineering drawing dialog to display the following dialog.  
 

  
 
The Name of printout field allows you specify the way of defining names of files and tabs; you 
can define a printout name identical to the position name or specify a prefix for a printout 
name. Below specify a number from which to start numbering the printout pages.   
If the Delete existing documents option is selected, all documents with the specified name are 
deleted from the existing printouts when generating drawings.  
Specify the following parameters in the Saving options field: 
• Folder – select this option to select a folder where DWG files with single printouts are 

located (if Overwrite existing file is selected, all existing files are replaced when 
generating drawings) 

• Print – select this option to select a plotter file type  
• the selection list includes available printout styles.  

After selecting Insert viewports into printouts, viewports are inserted on printouts; if this option 
is cleared, blocks are inserted on printouts.  
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19. LINK WITH OTHER PROGRAMS 

19.1. AutoCAD Structural Detailing - Robot link 
The link between Autodesk Robot Structural Analysis (a calculation program) and AutoCAD® 
Structural Detailing (used to create drawings) has been designed in order to enable you to:    

• Perform calculations of a defined CAD 3D model using Autodesk Robot Structural 
Analysis at any work stage. Calculations may be performed both for a whole structure 
and for a selected structure part. 

• Apply a calculation model created in Autodesk Robot Structural Analysis as the basis 
for creation of a detailed CAD model and documentation of a designed structure. 

• Perform full synchronization (from Autodesk Robot Structural Analysis to AutoCAD® 
Structural Detailing and vice versa) of changes made in a structure calculation model 
as well as in its CAD model.    

 
Updating the CAD file and the file containing the structure calculation model is carried out in 
the Link Wizard dialog shown below. To open the Link wizard dialog from:    

• Menu: Steel / Analysis Interface – Robot 
• Ribbon: ASD - Model / Tools / Analysis Interface – Robot 

• Toolbar: General / Analysis Interface  
• Command line: RBCS_R2R. 

 

 
 
To begin updating data for a selected Autodesk Robot Structural Analysis - AutoCAD® 
Structural Detailing connection defined in the current CAD file, choose an available operation:  

• To create a new link (permanent or temporary), select one of the first three options. 
• To update an existing link, select one of the last two options (update of a structure 

calculation model based on changes made in AutoCAD® Structural Detailing or vice 
versa).   

The left pane of the Link wizard dialog displays a short description of the option selected on 
the right.   
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After you click Next, the Link wizard dialog changes as shown below, allowing you to:    
• Assign a name of the defined link or select a name of the existing link  
• Create or select a file with an RTD extension (a file of the Autodesk Robot Structural 

Analysis calculation program) in which calculation results will be saved  
• Select objects that will be considered while creating a link.  

 

 
 
To create a new link: 

• For Enter new link name, specify a link name. This field is available only when you’re 
creating a permanent link. The link is saved under a specified name in the current 
DWG file. Because the name identifies links, it must be unique in a given file.  

• For Set path to calculation data file, specify a calculation file with an RTD extension 
(an Autodesk Robot Structural Analysis file) to which calculation results for the created 
link will be saved. This field is available only when you’re creating a new permanent 
link. As data is updated, the path is displayed in the field, but is read-only. You can 
specify a file by clicking Browse, and then using one of the standard Windows dialogs 
that displays:  
o Open dialog – displays when you are importing data from an existing file that 

contains a calculation model (RTD file). 
o Save dialog – displays when you are exporting data to a new file that is being 

created at this stage.  
 

• The options provided at the bottom of the Link wizard dialog let you select objects that 
are to be link components (the options are available only when a new link is being 
created): 
o Create link for entire model – select this option in order to use the entire structure  
o Select objects -  select this option in order to specify individual structure objects. 

When you use this option, you can click the button that then lets you select 
objects in the drawing.   

 
To update an existing link: 

• For Choose link, select one of the permanent links available in the current DWG file. 
After a link is selected, it becomes active. The list of all permanent links defined in the 
current DWG file may be viewed (and configured, if needed) in the additional dialog 
that opens after you click See list.   

• Click Next to display a dialog (shown below) where you can specify parameters of 
data transfer. The options in this dialog depend on the option (direction of data 
update) chosen in the first dialog. 
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o For a new link, the default options are selected.  
o For an existing link, the options that are selected are those that were applied for 

the selected link during the last operation of data update. 
You can change any of the options. 
 

 
 

To create a link and begin data update based on the options selected in the above dialogs, 
clickStart data update. The current dialog is closed, and a data update report displays. Data 
update is an obligatory operation while creating a new link.   
 
This dialog displays the run of the data update process. A progress bar displays at the bottom 
of the dialog, reporting the progress of the data update operation. Messages related to the 
data update process display also: 

• Date of the update process 
• File names (source file and target file) 
• Direction of the data update process (from AutoCAD® Structural Detailing or to 

AutoCAD® Structural Detailing) 
• Warnings  

To save the contents of the data update report in a text file, click Save log file. A text file may 
be corrected manually by the user. 
The OK and Save log file buttons are available only after the data update process is 
completed.  
 

19.2. DSTV import/export  
Use this option to read or save a DSTV format file. 
To begin working with a DSTV file, open the DSTV Import/Export dialog from:  

• Menu: Steel / DSTV data export 
• Ribbon: ASD - Model / Tools / DSTV data export 

• Toolbar: General / DSTV data export  
• Command line: RBCS_DSTV. 
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Available methods of importing or exporting DSTV or CIS/2 format file:   
• A file containing description of a steel structure model (a file that is compliant with the 

ISO-10303-21 standard) can be both imported and exported. For File path, specify the 
file location on disk (file location can also be specified after clicking Browse). This 
import/export mode results in generation of one file with  *.stp extension including 
description of a structure model. 

• Files containing descriptions of steel structure parts to be applied when numeric 
commands are used (the files can only be exported). For Directory path, specify location 
of the folder in which files with description of structure parts will be saved (folder location 
can also be indicated after clicking Browse). In this mode (for each part of a steel 
structure that has been assigned a position), a separate file containing description of 
parts is created in the indicated folder. Click Parameters in order to open the DSTV NC 
Parameters dialog.   

 

19.3. DSTV NC Parameters 
Use the DSTV NC Parameters dialog to define additional parameters of pointing and marking. 
The dialog opens after you click Parameters in the DSTV Import / Export dialog.  
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In descriptions of steel structure parts, used in the numeric control of machine tools, you can 
provide the following parameters:  

• Header – a drawing will be identified by means of a specified text / number   
• Marking – if Export marking is selected, the marking block will be included in the 

exported file. Specify parameters of marking a steel element 
o Size of characters 
o Position of the point where a description will be inserted (X margin and Y margin) 

• Tracing - if this is selected, the pointing block will be included in the exported file.   
 

• Files extension (NC or NC1)  
• Method of arc definition: 

o Points - by means of points positioned on the arc. The arc will be approximated 
between the beginning point P1 and the end point P2 by segments between 
points on the arc. 

  
 

o Arc - by means of the arc radius. Between the beginning point P1 and the end 
point P2, the arc will be defined based on the radius value. 
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20. AUTOMATIC DRAWING GENERATION - SAVING 
TO PLOTTER 

Use this option to automatically generate workshop plotter drawings. To access the option, 
select from: 

• Ribbon: ASD - Drawings / Generate Drawings / Automatic plotting 

• Toolbar: Printouts / Automatic plotting   
• Command line: AUTOPLOT. 

 

  
 

Specify plotting parameters: 
• For Plotter, choose a type of plotter file. 
• For Table of printout styles, select from the list of available styles.   
Click Print to start generation of drawings by a selected plotter type.  
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